Make sure you check for updates to this manual at the Oracle Technology Network Website
COPYRIGHT AND TRADEMARKS

Copyright © 1995, 2007, Oracle. All rights reserved.

The Programs (which include both the software and documentation) contain proprietary information; they are provided under a license agreement containing restrictions on use and disclosure and are also protected by copyright, patent, and other intellectual and industrial property laws. Reverse engineering, disassembly, or decompilation of the Programs, except to the extent required to obtain interoperability with other independently created software or as specified by law, is prohibited.

The information contained in this document is subject to change without notice. If you find any problems in the documentation, please report them to us in writing. This document is not warranted to be error-free. Except as may be expressly permitted in your license agreement for these Programs, no part of these Programs may be reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose.

If the Programs are delivered to the United States Government or anyone licensing or using the Programs on behalf of the United States Government, the following notice is applicable:

U.S. GOVERNMENT RIGHTS Programs, software, databases, and related documentation and technical data delivered to U.S. Government customers are "commercial computer software" or "commercial technical data" pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation of the Programs, including documentation and technical data, shall be subject to the licensing restrictions set forth in the applicable Oracle license agreement, and, to the extent applicable, the additional rights set forth in FAR 52.227-19, Commercial Computer Software--Restricted Rights (June 1987). Oracle USA, Inc., 500 Oracle Parkway, Redwood City, CA 94065.

The Programs are not intended for use in any nuclear, aviation, mass transit, medical, or other inherently dangerous applications. It shall be the licensee's responsibility to take all appropriate fail-safe, backup, redundancy and other measures to ensure the safe use of such applications if the Programs are used for such purposes, and we disclaim liability for any damages caused by such use of the Programs.

Oracle and Agile are registered trademarks of Oracle Corporation and/or its affiliates. Other names may be trademarks of their respective owners.

The Programs may provide links to Web sites and access to content, products, and services from third parties. Oracle is not responsible for the availability of, or any content provided on, third-party Web sites. You bear all risks associated with the use of such content. If you choose to purchase any products or services from a third party, the relationship is directly between you and the third party. Oracle is not responsible for: (a) the quality of third-party products or services; or (b) fulfilling any of the terms of the agreement with the third party, including delivery of products or services and warranty obligations related to purchased products or services. Oracle is not responsible for any loss or damage of any sort that you may incur from dealing with any third party.

Wednesday, September 12, 2007
CONTENTS

Introduction to PG&C................................................................. 1
  About Agile Product Governance & Compliance .......................................................... 1
  Compliance Regulations ........................................................................... 1
  Cycle of Compliance Data–Gathering and Corrective Action ........................................... 2
  How PG&C Helps You Gather and Manage Compliance Data ............................................ 2
  Levels of Due Diligence Using PG&C .................................................................................. 3
PG&C Application Components .................................................................................. 4
  What’s New in the PG&C Solution ...................................................................................... 5
    New features in Agile PG&C Rel. 9.2.2 ............................................................................. 5
    New features in Agile PG&C Rel. 9.2.2.1 .......................................................................... 5
Agile PLM Documentation for PG&C .............................................................................. 6
  PG&C User Guide ............................................................................................................. 6
  PG&C Supplier Guide ...................................................................................................... 6
  Agile PLM Administrator Guide .......................................................................................... 6
  Other Important Documentation for Working in PG&C ..................................................... 6
RFI Process and PG&C Business Classes ................................................................. 9
  RFI Process in Brief ........................................................................................................... 9
  PG&C Business Classes .................................................................................................... 11
  Substances Classes .......................................................................................................... 11
  Introduction to Specifications ............................................................................................ 12
    Contents of Specifications ............................................................................................... 12
  Parts and Part Groups Overview ....................................................................................... 13
    Naming Conventions ........................................................................................................ 13
    Items and Manufacturer Parts ......................................................................................... 14
    Part Groups .................................................................................................................... 14
  Introduction to Declarations ............................................................................................... 15
  Suppliers ............................................................................................................................ 16
Compositions .................................................................................................................. 17
  Compositions as Collections of Specific Data ................................................................. 17
    Contents of a Composition ............................................................................................... 17
    Stages of Compositions .................................................................................................. 18
  Compositions in the Context of Parts ............................................................................... 18
    Role of Composition Type Field ..................................................................................... 19
Substances ........................................................................................................................................................... 23
Tabs and Attributes in Substances .......................................................................................................................... 23
General Info Tab .................................................................................................................................................... 23
Where Used Tab .................................................................................................................................................... 24
Substance Groups > Substances Tab > Conversion Factor ....................................................................................... 24
Materials and Subparts > Composition Tab ............................................................................................................ 25
More About Subparts ............................................................................................................................................... 25
Creating Substances ................................................................................................................................................ 25
Working with Substances ........................................................................................................................................ 26
Substance Aliasing .................................................................................................................................................... 26
Mass Disclosure ...................................................................................................................................................... 27
Mass Tolerance ....................................................................................................................................................... 28
Intentional and Non-intentional Substances and Related Attributes ......................................................................... 29
Unreported Substances in Partially Disclosed Compositions ..................................................................................... 30
Bill of Substances .................................................................................................................................................. 33
Bill of Substances Overview .................................................................................................................................... 33
The BOM is a List of Parts that become Products .................................................................................................... 33
The BOS is a List of Substances Contained in Parts, which Requires Compliance ................................................. 33
Rationale for the BOS ............................................................................................................................................... 34
Summary of BOS Structures .................................................................................................................................. 34
Specifications ............................................................................................................................................................. 37
Tabs and Attributes in Specifications ........................................................................................................................ 37
General Info Tab ...................................................................................................................................................... 37
Substances Tab ........................................................................................................................................................ 38
Creating Specifications .............................................................................................................................................. 38
Working with Specifications ...................................................................................................................................... 39
"All Spec" Use Case .................................................................................................................................................. 40
Rules for Selecting Compositions for Rollup on Part/Part Group .............................................................................. 41
Parts and Part Groups ............................................................................................................................................. 43
Tabs and Attributes in Parts and Part Groups .......................................................................................................... 44
Title Block and General Info Tabs .......................................................................................................................... 44
PageTwo ..................................................................................................................................................................... 46
A Difference with Part Groups .................................................................................................................. 76
Changes when doing a CSV/Excel Import of a Specification to an Item ...................................................... 76
Importing and Exporting Declaration Data .................................................................................................. 77
Declarations Actions (Process Extensions) ..................................................................................................... 77
Importing and Exporting IPC Declarations .................................................................................................. 78
Correcting Invalid Substances ....................................................................................................................... 78

Rolling Up Compliance Data ....................................................................................................................... 81
Overview to Compliance Validation ............................................................................................................ 81
Use Cases ..................................................................................................................................................... 81
Declaration Classes in Rollups ..................................................................................................................... 82
When and Why Rollups are Run .................................................................................................................. 82
Parts Qualifying for Scheduled Compliance Rollups .................................................................................. 83
Expected Time Required to Complete Systemwide Rollup .................................................................... 84
When Rollup was Last Run ......................................................................................................................... 85
Compliance States ......................................................................................................................................... 85
  Worst-Case Priority of Compliance States ............................................................................................. 85
  How Compliance States are Ranked ......................................................................................................... 86
Bill Of Substances (Composition) Rollup ..................................................................................................... 86
  Kinds of Composition ............................................................................................................................... 87
  BOS Hierarchy ......................................................................................................................................... 87
  Compliance Validation for BOS Tree.......................................................................................................... 87
  When Composition Rollups Occur ............................................................................................................ 87
Bill Of Materials (Compliance) Rollup ......................................................................................................... 89
  Some Rollup Fields .................................................................................................................................. 90
  BOM Rollup Evaluating Compliance States .......................................................................................... 91
  Part-Level Validation – Rollup from Compositions to the Part or Part Group ........................................ 91
  AML Validation – Rollup from AML to Item .......................................................................................... 92
  Validation Rollup from Item to Assembly .............................................................................................. 92
Substances and Weights Rollups using Excel Integration ......................................................................... 93
  Details of the Substances and Weights Use Case ................................................................................ 93
  Running a Substances and Weights Rollup ............................................................................................ 94

Managing Your Suppliers .......................................................................................................................... 97
Attributes in Suppliers .................................................................................................................................. 97
Buttons on the General Info tab .................................................................................................................. 98
Creating Compliance Suppliers .................................................................................................................. 98
  Supplier Types ......................................................................................................................................... 99
  Supplier Lifecycle Phases ....................................................................................................................... 99
  Creating a Compliance Supplier ............................................................................................................. 99
Creating and Adding Contact Users.................................................................................................100
Adding and Modifying Suppliers on a Part or Part Group .................................................................101

**Reports and Searches** ...................................................................................................................103
Using Searches in PG&C ...................................................................................................................103
   Accessing PG&C Saved Searches ...............................................................................................103
   Using the Search Options in Add Operations ...........................................................................103
   Searchable Attributes for PG&C ...............................................................................................104
Using PG&C Reports .........................................................................................................................105
   Creating the Standard Layout ....................................................................................................106
   Specifics to Compliance Report Layouts ....................................................................................107

**Internal Logic of Compliance Rollups** ..........................................................................................113
Internal Logic of BOS/Composition Rollups ..................................................................................113
   Rollup Logic for Substances ......................................................................................................113
   Rollup Logic for Substance Groups ..........................................................................................113
   Rollup Logic for Materials .........................................................................................................114
   Rollup Logic for Subparts ..........................................................................................................114
   Rollup Logic for Parts and Part Groups ....................................................................................114
   Special Cases that can Result in Missing Info Compliance State ............................................114
   Additional Information ..............................................................................................................115
Internal Logic of BOM/Compliance Rollups .................................................................................116
   Compliance Calculation ..........................................................................................................116
   Calculation and Publishing of Compositions .........................................................................116
Internal Logic of Substances and Weights Rollups ........................................................................117
   Hierarchy of BOM and BOS ......................................................................................................117
   Aggregate Rule .........................................................................................................................117
   Substance to Substance Group-level Rollup ...........................................................................118
   Substance Group to Composition ............................................................................................118
   Substance Group/Substance to Material-level Rollup ..............................................................119
   Material to Subpart-level Rollup ...............................................................................................119
   Subpart to Composition-level Rollup .......................................................................................120
   Composition to Part-level Rollup .............................................................................................120
   Composition to Manufacturer Part ..........................................................................................120
   Manufacturer Part to Part-level Rollup ....................................................................................121
   Part to Assembly .....................................................................................................................123
   Notes .......................................................................................................................................126
   Rollup Rules .............................................................................................................................126
Preface

The Agile documentation set includes Adobe® Acrobat™ PDF files. The Oracle Technology Network (OTN) Web site (http://www.oracle.com/technology/documentation/index.html) contains the latest versions of the Oracle|Agile PLM PDF files. You can view or download these manuals from the Web site, or you can ask your Agile administrator if there is an Oracle|Agile Documentation folder available on your network from which you can access the Oracle|Agile documentation (PDF) files.

Note To read the PDF files, you must use the free Adobe Acrobat Reader™ version 7.0 or later. This program can be downloaded from the Adobe Web site (http://www.adobe.com).


If you need additional assistance or information, please contact support@agile.com or phone (408) 284-3900 for assistance.

Note Before calling Agile Support about a problem with an Oracle|Agile PLM manual, please have ready the full part number, which is located on the title page.

Readme

Any last-minute information about Oracle|Agile PLM can be found in the Readme file on the Oracle Technology Network (OTN) Web site (http://www.oracle.com/technology/documentation/index.html).

Agile Training Aids

Go to the Agile Training Web page (http://training.agile.com) for more information on Agile Training offerings.
Chapter 1

Introduction to PG&C

This chapter includes the following:

- About Agile Product Governance & Compliance ................................................................. 1
- PG&C Application Components ............................................................................................ 4
- What's New in the PG&C Solution .......................................................................................... 5
- Agile PLM Documentation for PG&C ..................................................................................... 6

About Agile Product Governance & Compliance

Agile Product Governance & Compliance (PG&C) is designed to help manufacturers manage all kinds of product compliance, including the ability to audit the presence and amount of regulated substances used in their products, and to demonstrate that they responsibly dispose of, recycle, or re-use parts containing those substances.

Compliance Regulations

OEM manufacturers are required to take global responsibility to dispose of, recycle, or re-use electronics that contain hazardous substances. In addition to satisfying FDA regulations and ISO standards, any company that sells electronics equipment in an international market is subject to the OEM manufacturing regulations of their target markets. These may include one or more of the following:

- **United States:**
  - Good Manufacturing Practices
  - ISO Standards
  - U.S. Food & Drug Administration regulations

- **Europe:**
  - Good Manufacturing Practices
  - Restriction of Hazardous Substances (RoHS)
  - Waste of Electrical and Electronic Equipment (WEEE)

- **China:**
  - Restriction of Hazardous Substances (China RoHS)
  - Waste of Electrical and Electronic Equipment (China WEEE)

- **Japan:**
  - Japanese Green Procurement Survey Standardization Initiative (JGPSSI)

- **International:**
  - Joint Industry Guide (standards adopted by international companies, including IBM, Dell,
Cycle of Compliance Data–Gathering and Corrective Action

This figure depicts a process of due diligence concerning the compliance of existing products and new product designs. This is a “closed-loop” compliance corrective action process. Other Agile solutions – Product Collaboration, Product Quality Management, Product Cost Management, Product Portfolio Management – manage areas around the lower half of the circle. Product Governance & Compliance manages the compliance data-gathering area.

Figure 1-1: Closed-loop Compliance–Corrective action process

How PG&C Helps You Gather and Manage Compliance Data

People who manage the compliance process at the “buyer” site – compliance managers – must ensure that their company’s products adhere to government regulations and company policy. Agile PG&C helps you gather and analyze compliance data and to take appropriate corrective action.

PG&C is not only a communication vehicle between the compliance manager and information suppliers: it also manages the compliance of parts across multiple suppliers and multiple manufacturer parts.

Ultimately, PG&C rolls all this information up to provide a product-level view of compliance.

More specifically, compliance managers use PG&C to:
Collect data about materials used to manufacture a product

Review compliance across the Approved Manufacturers List (AML) of a part, across multiple suppliers (the Approved Suppliers List, or ASL), across BOMs, subassemblies, and of final products

Generate reports to show the level of compliance

Manage supporting documentation, such as descriptions of current regulations, recovery manifests, disposal certificates of destruction, supplier compliance surveys, and other customer-specific specifications.

At the supplier site, information suppliers use PG&C to complete and sign off material declarations:

- Declare compliance with specifications concerning hazardous materials that may originate from its customers and from government agencies
- Disclose which hazardous substances are contained in the components and subassemblies it provides.

This diagram represents the various activities and tasks in the compliance process.

Figure 1-2: Activities and tasks in the compliance process

<table>
<thead>
<tr>
<th>1. Configure (Compliance Data Management)</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Setting up and maintaining the infrastructure to support PG&amp;C</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>2. Gather (Data)</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Request compliance data for IPNs, MPNs, or part groups from a supplier</td>
</tr>
<tr>
<td>- Manual Data entry</td>
</tr>
<tr>
<td>- Import from Content Providers (PI)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>3. Analyze (Compliance Validation)</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Validate the compliance of a declaration, IPN, MPN, part group or BOM</td>
</tr>
<tr>
<td>- Weight and Substance Analysis</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>4. Act (Product Quality Management)</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Corrective action and change request</td>
</tr>
</tbody>
</table>

Levels of Due Diligence Using PG&C

The capabilities of the PG&C solution are not wholly defined by the PG&C-specific objects. Certain
situations of due diligence may require objects from other Agile business classes. Here are some simple examples of this:

**Specification Management**

In terms of substance-based environmental compliance, the simplest level of due diligence involves specifications.

- Define a specification, list exemptions, attach specifications to the product level.
- Let the system assign specifications to all parts within this BOM, and set declared compliance on the specification for a part.
- Let the system roll up the compliance information and review for compliance at the product level.

This use case illustrates the usage of PG&C for general product compliance such as compliance with an FCC specification or with a “MilSpec.”

**Declarations Gather Compliance Information**

A higher level of due diligence is achieved by using a declaration process including a supplier sign-off to gather compliance information. Use declarations to collect information about the compliance of a part or a supplier with a certain specification.

**Full Use of PG&C Business Objects**

The highest level of due diligence for substances-based environmental compliance is achieved by the full use of PG&C object types. – substances, specifications, declarations, part groups – as well as solution-oriented features of “non-PG&C” object types – items, manufacturer parts, suppliers – to produce comprehensive disclosure statements about compositions.

**Summary**

This simplified hierarchy demonstrates that you can tailor the use of the PG&C solution depending on the required type of compliance and the desired level of due diligence. Substances and even Declarations are not absolutely required to gather benefits from PG&C. Specifications are really the crucial object type; and Compositions – which are not an object type but an important concept – are the collection of compliance data that is unique to Agile PG&C (see [Compositions](#) (on page 17)).

**PG&C Application Components**

PG&C has been configured for your company at the installation phase of Agile PLM. Your Agile administrator has further refined the solution by creating users like yourself with assigned roles and privileges, and has configured the pertinent business classes so you can create PG&C-specific objects (see [PG&C Business Classes](#) (on page 11)).

- Compliance managers and other users at the “buyer” company work in Agile Web Client.
- Your information suppliers also log in to Web Client but their assigned role dictates that the user interface that they use – the Basic Supplier UI – is greatly simplified from the version that you use. It is documented in [PG&C Supplier Guide](#).
- **Microsoft Excel-based Client** uses predefined Excel templates to facilitate performing certain
tasks. A template is available for the information supplier to complete JGPSSI declarations (see *PG&C Supplier Guide*). A template is also available for the buyer to perform "substance and weights rollups" in Excel.

It is also possible to create custom templates in Microsoft Excel; you can create Excel templates for any of the declaration classes in Agile PG&C. For more information, contact your Agile Solutions Delivery representative.

The Microsoft Excel-based Client requires:

- Windows desktop,
- Internet Explorer 5.0 or higher, to log in to Web Client, and

**Note** Some companies do not permit their employees to download ActiveX controls to their desktop computers. Therefore, the Microsoft Excel-based Client may have to be implemented by the IT department of your company via a “push approach”: this automatically pushes the ActiveX control out to users’ desktops. Otherwise, your company can get the ActiveX or Plugin installer from the Agile Support website and install it on users’ desktops.

### What’s New in the PG&C Solution

#### New features in Agile PG&C Rel. 9.2.2

New features in Agile PG&C Release 9.2.2 include:

- Substance Aliasing for Substances and Substance Groups classes;
- Support for Intentionally Added flag on Substances data on Specifications, Declarations, Items, Manufacturer Parts, and Part Groups;
- Full Material Disclosure – in Substance and Homogeneous Material Compositions – is supported by:
  - Mass Disclosure types are Fully Disclosed, Partially Disclosed, and Undisclosed;
  - Unreported (System) substance in Partially Disclosed compositions;
  - Administrator: Compliance Rollup setting called Mass Tolerance Percentage;
- Import Compositions, Bill of Substances, Specifications, and Suppliers to Items based on Change Number;
- Import of “local substances” into Declaration;
- Support of the latest released version of IPC v. 1.02.

#### New features in Agile PG&C Rel. 9.2.2.1

New features in Agile PG&C Release 9.2.2.1 include:

- Mapping Result Compliance value from Item/Mfr.Part Specifications table to a selected attribute on PageTwo -- See a part's Result Compliance more readily in the object (supported by Administrator Specification Mapping); and,
• Bulk Specification Removal -- Remove a specification from the entire assembly in one procedure.

Agile PLM Documentation for PG&C

The Preface of this manual provides the URL to Agile documentation for current releases of Agile PLM. This manual assumes that Agile PLM has been installed and an Agile administrator has created Agile users with assigned roles that facilitate their work.

PG&C User Guide

This manual, PG&C User Guide, is a complete manual for working in the Agile PG&C solution. It describes how to work with the PG&C-specific business classes in Agile PLM 9.2.2 and the Request For Information (RFI) compliance process (see What’s New in the PG&C Solution (on page 5)). The final chapter contains information about managing your suppliers.

PG&C Supplier Guide

The PG&C Supplier Guide provides information for your supplier users to learn to work in Agile Web Client (and, if installed, the Microsoft Excel-based Client) to complete their end of your compliance process. They can access the Agile Documentation web site to download this guide, or you could send the PDF to them as an email attachment. Compliance managers should be familiar with the contents of the Supplier Guide.

Agile PLM Administrator Guide

Although Agile PLM end-users do not generally need to work with the Administrator Guide, that manual contains a chapter, “PG&C Settings,” that describes the steps for configuring PLM for PG&C users and the PG&C-related nodes in Administrator. A compliance manager – an PLM user who has been assigned the Compliance Manager role – may find useful information in that chapter and elsewhere in that manual.

Other Important Documentation for Working in PG&C

For a comprehensive introduction to Agile client interfaces, concepts, terms, and important cross-solution features, please refer to Getting Started with Agile PLM.

Chapters 3–5 of Getting Started with Agile PLM contain information that is preliminary to the information in this manual. (Please see the first three rows in the table below.)

Chapter 3 provides a thorough overview of Agile Web Client’s user interface and features. This guide does not cover that information.

Chapters 4 and 5 contain information about Agile PLM that is essential for all PG&C users.

This table lists Getting Started chapters and other Agile manuals that will help you master your tasks in Agile PG&C.
<table>
<thead>
<tr>
<th>Feature or concept</th>
<th>Contained in this document</th>
<th>How to find the document</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Web Client user interface and navigation</strong> — this is the only client in which to do PG&amp;C work</td>
<td><em>Getting Started with Agile PLM</em>, Chap. 3, “Navigating in Agile Web Client”</td>
<td>Choose Help &gt; Manuals in the Java Client or Web Client menu bar. On the documentation web page (after selecting Product &amp; Build &amp; Search), click <strong>Getting Started</strong> in the list of user manuals.</td>
</tr>
<tr>
<td>Introduction to <strong>Agile PLM concepts and terminology</strong></td>
<td><em>Getting Started with Agile PLM</em>, Chap. 4, “Concepts and Terms in Agile PLM Solutions”</td>
<td></td>
</tr>
<tr>
<td>Introduction to <strong>Agile business objects</strong>, including creating &amp; deleting objects, actions, tabs, sharing, subscriptions, relationships, and references between objects</td>
<td><em>Getting Started with Agile PLM</em>, Chap. 5, “Working with Objects”</td>
<td></td>
</tr>
<tr>
<td>Using <strong>reports</strong> to gather data</td>
<td><em>Getting Started with Agile PLM</em>, Chap. 6, “Working with Agile Reports”</td>
<td></td>
</tr>
<tr>
<td><strong>Searches</strong></td>
<td><em>Getting Started with Agile PLM</em>, Chap. 7, “Finding Agile Data with Searches”</td>
<td></td>
</tr>
<tr>
<td><strong>Workflows</strong></td>
<td><em>Getting Started with Agile PLM</em>, Chap. 8, “Routing Objects with Workflows”</td>
<td></td>
</tr>
<tr>
<td><strong>Attachments and file folders</strong></td>
<td><em>Getting Started with Agile PLM</em>, Chap. 9 &amp; 10, “Working with Attachments” and “Working with File Folders.”</td>
<td></td>
</tr>
<tr>
<td><strong>Importing and exporting files and data</strong></td>
<td><em>Agile PLM Import &amp; Export Guide</em></td>
<td>Choose Help &gt; Manuals in the Java Client or Web Client menu bar. On the documentation web page (after selecting Product &amp; Build &amp; Search), click <strong>Import &amp; Export</strong> in the list of user manuals.</td>
</tr>
</tbody>
</table>
Chapter 2

RFI Process and PG&C Business Classes

This chapter includes the following:

- RFI Process in Brief ............................................................................................................................................. 9
- PG&C Business Classes ..................................................................................................................................... 11
- Substances Classes .............................................................................................................................................. 11
- Introduction to Specifications ............................................................................................................................... 12
- Parts and Part Groups Overview .......................................................................................................................... 13
- Introduction to Declarations ................................................................................................................................. 15
- Suppliers .............................................................................................................................................................. 16

RFI Process in Brief

The declaration workflow is the vehicle to send Requests For Information (RFIs) to your suppliers, one supplier per declaration. A declaration is a routable object used to keep track of the compliance information about all the substances and materials that are contained in parts or part groups associated in the declaration.

The general sequence of the RFI process is:

1. Identify parts and part groups for which compliance data is required – see Parts and Part Groups (on page 43).
2. Identify people within your company (for parts) and suppliers (for manufacturer parts) who can provide compliance data. This may be an informal process – collecting names and verifying that internal and external (supplier) users with appropriate roles and privileges are available in the database – or involve more research and creation of an Approved Suppliers List, or ASL. Also, see Managing Your Suppliers (on page 97).
3. Create declarations for parts, manufacturer parts, and part groups – see Creating Declarations (on page 62).
4. Route a declaration to an information supplier – details about the Declarations workflow are provided in Routing Declarations (on page 67).
5. Supplier completes the declaration with data and a signoff – see Information Supplier Fills Out a Declaration (on page 68).
6. Compliance data is assessed for completeness and validated for correctness. This may include running inboard compliance rollups – see Rolling Up Compliance Data (on page 81).
7. Reviewed and approved declarations are released, which “publishes” the data across the product record in Agile PLM – see Completing the RFI Process (on page 68).
The RFI process is depicted in graphic and in schematic views below.
PG&C Business Classes

This is a summary of the Agile business objects used in the Product Governance and Compliance solution. Some of these objects, such as Parts and Manufacturer Parts, originated in other Agile solutions. All of the types of objects introduced here are discussed in succeeding chapters of this manual.

Note  It is possible that your Agile administrator has renamed existing classes and created new subclasses than those presented in this guide.

Substances Classes

Substances are basic building blocks in PG&C. A substance is any chemical element or compound
that is tracked within Agile PLM. Because of complexities in how parts (that may contain substances) are used in products, the Substances base class has four predefined classes, each with a child subclass, to cover a variety of circumstances: Substances, Substance Groups, Materials, and Subparts.

- **Substances** class – a substance is a single chemical element; for example, lead, chromium, or cadmium. Generally, these are the potentially hazardous substances that legislations are interested in, as described in specifications. To handle inconsistencies in how substances are named, the Alias attribute has been introduced in PLM 9.2.2.

- **Substance Groups** class – a group of multiple substances. A substance group must have a Base Substance, which is the substance that the legislation is interested in. A substance group called “Lead and Lead Compounds” would cite Lead as its base substance, and it could comprise chemicals like Lead-oxide, Lead-nitrate, and Lead-sulfate. See **Substance Groups > Substances Tab > Conversion Factor** (on page 24).

- **Materials** class – a material is a compound chemical, that is, a substance consisting of multiple substances. A good example of a material is a glue or a resin that can be bought in bulk. See **Materials and Subparts > Composition Tab** (on page 25).

- **Subparts** class – a subpart is a subunit of a component. Subparts are not numbered and do not expand the BOM. See **More About Subparts** (on page 25).

| Note | Substances are the “subject” of Substances and Weights rollups, which are documented in **Substances and Weights Rollups using Excel Integration** (on page 93) and also in **Internal Logic of Substances and Weights Rollups** (on page 117). |

From the four **Substances** (on page 23) classes, the **Bill of Substances** (on page 33) has been developed as a structure to determine compliance of products with legislation (specifications). Compliance rollups are discussed in **Rolling Up Compliance Data** (on page 81).

### Introduction to Specifications

Specifications track the different legislations, customer specifications, or internal specifications with which an assembly or part must comply. The Specifications object is used to create representations of specification documents, regulations, published compliance criteria. You will very likely hold the actual (electronic) document as an attachment to a specification object.

An example of a regulation issued by a government body is the European RoHS directive. Environmental specifications are substance-based, and contain a list of banned substances or substances of concern and their threshold values.

In Agile, specifications are used to validate declarations and assess the compliance of parts by evaluating whether a given restricted substance in the composition of a part surpasses its specified threshold value.

### Contents of Specifications

Objects created from the Specifications class may consist of:

- Specification-level attributes, for example, Threshold value (PPM) for each of the substances of concern, and Disallow Intentionally Adding flag (on specification **Substances** table)
Exemptions

Attachments carrying or clarifying the specification

A list of substances of concern (or, simply, Substances list)

Indication whether a supplier is required to report on a substance or not.

A specification either represents a customer-created specification or legislation adopted by a government. For more information about specifications, see Specifications (on page 37).

Parts and Part Groups Overview

Naming Conventions

Before looking at "parts and part groups," let's clarify this phrase. Keep in mind that Agile PLM allows for most objects to be renamed to suit your company’s needs, and your administrator may already have introduced different names than found herein.

Object types – base classes, classes, and subclasses – describe the structure of business objects found in Agile PLM. "Items" is a base class that contains the Parts and Documents classes and the Part and Document subclasses: these represent the building blocks of products made by your company. "Manufacturer Parts" base class contains the Manufacturer Parts class and Manufacturer Part subclass: this represents products made by other companies that your company purchases to assemble your products.

As a shorthand, this manual uses the word “part” to refer to all objects from the Parts, Documents, or Manufacturer Parts classes.

The Part Groups class is used to group similar parts. This manual uses "part group" for any object in the Part Groups class. The “out-of-the-box” names of the subclasses of the Part Groups class are Part Family (PG&C-specific) and Commodity (PCM-specific). If your company does not use the Product Cost Management solution, you will not likely see objects called Commodity. (Also see Part Groups > Make Available As Attribute (on page 45:))

Therefore, the phrase “parts and part groups” (or the notation <Part/PG>) comprises “any kind of part used in my company’s manufacturing process.”

This schematic illustrates the above statements.
**Base Classes that describe parts**

- **Items**
- **Manufacturer Parts**
- **Part Groups**

**Classes**

- **Parts**
- **Documents**
- **Manufacturer Parts**
- **Part Groups**

**Subclasses**

- **Part**
- **Document**
- **Manufacturer Part**
- **Part Family**
- **Commodity**

---

*Getting Started with Agile PLM* contains a table of all the object types that are found in Agile PLM. The object types you see in Web Client depends on the Product Licenses purchased by your company.

### Items and Manufacturer Parts

**Items** and **Manufacturer Parts** are two base classes in Agile PLM that are used to create objects that represent the things that your company and its suppliers assemble into the products your company sells. They are therefore the entities for which compliance data must be sought.

How items and manufacturer parts work “outside” the PG&C solution is fully documented in *Product Collaboration User Guide*. Non-PG&C tabs and functionality of items and manufacturer parts are not included in this guide. How items and manufacturer parts are used within PG&C is described in *Parts and Part Groups* (on page 43).

### Part Groups

A part group is a “container” that tracks the overall chemical composition for all parts of a particular type. If multiple parts share the same properties – for example, the same composition – you can define a part group with those characteristics. The parts that are associated with part groups are listed on the **Parts** tab of every part group.

If a part is already associated with a part group, it cannot be associated with a different part group. A part can only belong to one part group at a time.

Note, however, that suppliers on a part group are not copied over to the associated parts; said another way, parts do not inherit suppliers from part groups.

The Part Groups class is licensed by Agile through the Product Collaboration solution, but its specific objects pertain more to Product Cost Management, or PCM, and PG&C. (It was called Commodities class in Agile PLM 9.0.) The Part Family subclass is used by PG&C; the Commodity subclass is used by PCM. Depending on settings (see *Make Available As Attribute and the “Force/Identical” SmartRule* (on page 45)), this class can generate objects that work independently in PG&C and PCM, or concurrently in both solutions.
For more information about parts and part groups, see Parts and Part Groups (on page 43).

Introduction to Declarations

A declaration is the main object of record in the PG&C solution: it is a record of questions posed by a compliance manager to an information supplier about the supplier itself, its products, or how its products comply with given specifications. Upon completion, it contains the supplier’s responses to the questions. Also, declarations keep track of all the substances and materials that are contained in items, manufacturer parts, or part groups.

The Declarations base class has seven default classes of declarations, each with a single child subclass. The following table defines the kinds of declarations in PG&C.

<table>
<thead>
<tr>
<th>Declaration class</th>
<th>Definition</th>
<th>Specification type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Substance Declarations</td>
<td>The supplier is requested to provide compliance information for each substance within the specification.</td>
<td>must be part-level spec</td>
</tr>
<tr>
<td>Homogeneous Material Declarations</td>
<td>The supplier is requested to provide a complete BOS breakdown of the part and provide compliance information at the homogeneous material level.</td>
<td>must be homogeneous-material level spec</td>
</tr>
<tr>
<td>Part Declarations</td>
<td>Receive part-level compliance information as well as other composition header level information (manufacturing parameters).</td>
<td>can add any type of spec</td>
</tr>
</tbody>
</table>
| JGPSSI Declarations        | The supplier is requested to provide compliance information (weights) according to the JGP standard.  
Note: There is a fully supported Japanese version of the JGPSSI template for creating JGPSSI Declarations; see your administrator. | must be part-level spec             |
| Supplier Declarations of Conformance | A questionnaire to assess supplier compliance with specifications from customers and government agencies. The survey addresses compliance at a general company level. Can be used for CSR type declarations. | can add any type of spec            |
| IPC 1752-1 Declarations     | A Joint Industry Guide (JIG) substance declaration for electronic products. | must be part level                  |
| IPC 1752-2 Declarations     | A Joint Industry Guide (JIG) homogeneous-material declaration for electronic products. | must be homogeneous-material Level   |

Note: Substances and substance groups are pre-populated only in Substance Declarations. (In PLM 9.2, substances were also pre-populated in JGPSSI Declarations, but this has been removed.)

Declarations are the routable objects in PG&C, similar to change orders in Product Collaboration. As a routable object, each declaration advances through a workflow that implements the Request for Information (RFI) business process. When a declaration is released by the compliance manager, the information gathered from it is published to the product record, thereby updating the composition data contained within the parts and part groups listed by the declaration. This is just
how a change order works, when an ECO or MCO is approved and released by the change analyst, the “change” is published to the product record and the entire BOM and its constituent parts are updated.

Another comparison between Changes and Declarations: a change order has an Affected Items tab, so you can always see what parts or manufacturer parts are being addressed by the change; you can also click the link and go to each part object itself. Declarations have three “Affected Parts” tabs, for each kind of part in the PG&C solution: Items, Manufacturer Parts, and Part Groups, with similar connectivity. (See Affected Parts Tabs (on page 60).)

For more information about declarations, see Declarations (on page 57).

Suppliers

A supplier is a company that provides compliance information about parts that are used in your company’s manufacturing process. The supplier firm may or may not actually make or sell the parts about which they furnish compliance information. Besides creating objects to represent supplier firms, a compliance manager creates contact users (employees of the supplier) who will complete RFIs, may create Supplier Groups that can be leveraged by users with the appropriate roles, and submits declaration requests to the suppliers. Later the compliance manager evaluates the data received from the supplier and releases the declaration.

When you create a declaration, you assign it to an information supplier who is requested to provide compliance information. The supplier’s contact users access the PG&C Supplier Guide to learn to work in Agile Web Client and to complete their end of the compliance process.

Note There has been a relaxing of the original constraints to suppliers on declarations. These are detailed in the Note in Using the Create Wizard (on page 63).

For more information about suppliers, see Managing Your Suppliers (on page 97) and the PG&C Supplier Guide.
Chapter 3

Compositions

This chapter includes the following:

- Compositions as Collections of Specific Data ..................................................................................................... 17
- Compositions in the Context of Parts .................................................................................................................. 18
- Compositions in the Context of Declarations ....................................................................................................... 21

This chapter presents information about objects and processes that are documented later in this manual. It is good to become familiar with the basic idea of compositions, and to return to this chapter as you build your understanding of the PG&C solution.

Compositions as Collections of Specific Data

A crucial idea in PG&C is the composition; a composition is not a configurable “business object” in Agile PLM. A composition represents the total collection of information contained in a completed declaration.

Contents of a Composition

The information gathered and collected in a declaration is ...

1. ... provided by a single information supplier ...
2. ... in reference to a given specification (often called “spec”) and ...
3. ... for a given part, manufacturer part, or part group.

In the case of an Agile part (not manufacturer part), the revision—"rev"—is always significant; this fact is suggested by the phrase “part+rev”.

So, a composition is a “part+rev in reference to a spec and provided by a supplier” or a “manufacturer part in reference to a spec and provided by a supplier” — in shorthand, a “part with a spec, from a supplier.”

When a declaration is completed and released, the data it has collected is published or electronically distributed across the product record to the parts themselves and, therefore, to their associated Bills of Material. Through the idea of composition and its carrying agent, the declaration, compliance data is integrated into the product record in visible form as the Bill Of Substances (BOS), just as part data is integrated into the Bill Of Material (BOM).

Note

When compositions are directly imported into manufacturer parts, naming a supplier is optional. Even in the context of declaration compositions (compositions that will be published from a released declaration), naming a supplier on the declaration is optional (as of Rel. 9.2.1.3).
Stages of Compositions

The Agile system distinguishes between compositions that are published, are not yet published, or have been overwritten by new published data:

- **Pending composition** – a composition on an unreleased declaration
- **Active composition** – a composition that is currently active for the part; it can be from the latest released declaration, or it can be a directly imported composition for that part + spec + supplier combination (on the part’s Compliance tab > Compositions table).
- **Inactive or historical composition** – the old composition when it has been replaced by either a new declaration or by importing a new composition for the same supplier + spec combination. Note that Inactive compositions are never used to assess compliance.

You can archive compositions in items and manufacturer parts. See [Inactivating Compositions](on page 20).

Compositions in the Context of Parts

To add compositions to the part/PG Compliance tab > Compositions table, you can follow the original RFI process, that is, (1) create and send a declaration to a supplier, (2) receive and verify the completed declaration, and (3) publish (release) it. You can also manually import composition and substance data into items and manufacturer parts (but not part groups) – see [Importing Compositions into Items and Manufacturer Parts](on page 71).

Regarding modifying or removing compositions, when a composition with same supplier + same spec is released or imported, the previous composition is inactivated, but not deleted. There is no way to edit a composition: if you make some changes to the same Import file and import again, the system treats it as a new composition and archives the previous one. (See [Inactivating Compositions](on page 20).)

You can publish a composition from a declaration that does not have a specification, which results in the “All Spec” composition (see "All Spec" Use Case (on page 41)); it is now possible to publish a declaration with no supplier named at all (this is detailed in [Cover Page](on page 59)).

When importing compositions and substances into an item or manufacturer part, both specification and supplier are optional (Composition Type is required; see [Role of Composition Type Field](on page 19)).

**Note** When the specifications of a part group are modified or new declarations are made against this part group – for example, a supplier submits a declaration that includes information about the part group – then upon release of that declaration, the composition relating to that part group will not only be copied to the Compliance tab > Compositions table of that part group, but also to all parts belonging to that part group, while applying the Conversion Factor to convert part and substance weights, if applicable (see [Part Groups > Parts Tab](on page 51)).

**Note** When you perform a “Save As” operation of a part or part group, compositions are not copied to the new object. The system copies the specifications and suppliers over to the new object, but not Active compositions.
Role of Composition Type Field

For a composition to be imported in a part or part group, the only required field is Composition Type. The available values for Composition Type are:

- Substance Composition
- Homogeneous Material Composition
- Part Composition.

It is not necessary for a composition to have a supplier or a name – remember that a composition is an important ‘concept’ in PG&C but there is no business object itself.

As there are more kinds of declarations than composition types, it can be helpful to group the Declarations classes as shown in the table. Supplier Declarations of Conformance do not have compositions.

<table>
<thead>
<tr>
<th>This declaration class...</th>
<th>...releases to this value in Composition Type</th>
<th>Validation Type of Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Substance Declaration, JGPSSI Declaration, IPC 1752-1 (Substance) Declaration</td>
<td>Substance Composition</td>
<td>Part Level</td>
</tr>
<tr>
<td>Homogeneous Material Declaration, IPC 1752-2 (Homog’s. Material) Declaration</td>
<td>Homogeneous Material Composition</td>
<td>Homogeneous Material Level</td>
</tr>
<tr>
<td>Part Declaration</td>
<td>Part Composition</td>
<td>Homogeneous Material Level or Part Level</td>
</tr>
</tbody>
</table>

When a composition is imported to an item or manufacturer part, it appears in the part’s Compliance tab > Composition table. Before it begins the import, the system looks for an existing active composition with the same parameters (supplier and specification name); if it finds an active, matching composition, the active one is inactivated, the importing of the new composition begins and this one is made active.

If the import does not succeed, the original active composition remains active.

The subject of importing compositions as well as entire declarations is covered in Importing and Exporting Data in PG&C (on page 71).

Validation Type in Conjunction with Composition Type

Another wrinkle is this with the introduction of importing compositions to manufacturer parts (Rel. 9.2.1) and items (Rel. 9.2.2; this is discussed in Importing Compositions into Items and Manufacturer Parts (on page 71)). A relationship exists between a specification’s Validation Type – Part Level or Homogeneous Material Level – and a manufacturer part’s or item’s Composition Type – Part Composition, Substance Composition, or Homogeneous Material Composition.

This section describes the interaction of these two attributes. Validation Type is discussed more fully in General Info Tab (on page 37).
The Composition Type attribute of a manufacturer part provides a way to track what type of composition is being imported to manufacturer parts or items.

Supplier Declarations of Conformance do not apply to the Composition Type attribute.

- For compositions published from declarations, the system selects the correct Composition Type based on the Declaration class (as shown above in Table 3-1).
- When the system assesses compliance for a specification, it looks for all matching specification compositions that correspond to the validation type of the specification.

So, for a Part Level validation specification, the system looks at all Substance compositions and Part Compositions, therefore, it looks for compositions with same spec that are published from Substance Declarations, JGPSSI Declarations, IPC 1752-1 Declarations. or Part Declarations.

For a Homogeneous Material Level validation specification, the system looks at all Homogeneous Material compositions and Part Compositions; therefore, it looks for compositions with same spec that are published from Homogeneous Material Declarations, IPC 1752-2 Declarations, or Part Declarations.

For a given specification, if there is a composition published that has the same specification, the system uses that composition only. If multiple suppliers have provided compositions for that spec, then the system uses compositions from all the suppliers and applies the Composition Rollup Rule (which is an Administrator setting) to determine the compliance of that specification.

For a given specification, when there is no composition with the same spec, the system looks for (latest released or imported) Full Disclosure composition (for each supplier) that corresponds to the same validation level of the specification. If it is not able to find any Full Disclosure compositions, the system looks for Partial- or Un-disclosed compositions that have no specification (which we call “All Spec,” as described in "All Spec" Use Case (on page 41)).

For example, with a part level specification, when there is no composition found with that spec, the system uses all active “All Spec” compositions published from Substance, JGPSSI, or IPC1752-1 declarations or directly imported substance compositions without any spec.

Note that a part composition without a spec is not considered to be an “All Spec” composition, since it contains no substance-level information and is therefore not useful.

**Inactivating Compositions**

The Archive button is on the Compliance tab’s Compositions table of items and manufacturer parts (but not part groups). This button is enabled, however, only if the user has the Modify privilege for the Declared Compliance attribute on the Compositions table for that part.

This is the use case for the Archive button: suppose you have inquired about a substance in a part from multiple suppliers. You submit declarations, and they are returned, some reporting the part–substance to be in compliance and some reporting non-compliance. When these declarations are published, the top-level assembly at your firm could emerge with a Non-Compliant state.

Assuming you can decide not to buy non-compliant parts, you can remove offending compositions from the product record: on the part’s Compliance tab > Compositions table, select the composition you want to remove and click the Archive button. The composition is removed from active status. Any assemblies that part is on should now be in compliance (or at least not prevented).
An inactivated composition cannot be re-activated.

**Compositions in the Context of Declarations**

A composition describes the aggregate data collected in a (published) declaration. A composition represents the sum of (1) a supplier for (2) a given specification and for (3) a given part (plus revision) or part group.

**Declarations Gather and Store Information about Compositions**

Declarations are a structured way of bringing information concerning the environmental compliance of parts into Agile PLM. Each declaration is for a single supplier. Every declaration contains associations to parts or part groups, which, combined with one or more specifications, is the composition. Information in a declaration can be stored at these levels:

1. At the General Info ("cover page"), Page Two (fields from the class), and Page Three (fields from the subclass) levels of the declaration – these represent entered data about the declaration and describes what information is being sought;
2. At the part level within the declaration – that is, in reference to associated parts or part groups in the context of a specification – and at each of the Bill of Substances (BOS) levels if the declaration type requires the supplier to create a BOS for each affected part;
3. At the subpart level – in reference to associated Subparts;
4. At the material level – in reference to associated Materials;
5. At the substance group level – in reference to associated Substance Groups;
6. At the substance level – in reference to associated Substances.

**Information on Declarations also found on the Parts**

Introduction to Declarations (on page 15) mentioned several similarities between the PG&C routable object and change orders in the Product Collaboration solution. A core idea in Agile PLM is the inter-linked quality of data found in the “things” – parts, manufacturer parts, part groups (which are non-routable) – and the “changes” that modify those things – changes in PC and declarations in PG&C (which are routable via workflows). You can go back and forth from the “change” objects that are seeking to modify parts or assemblies, and the parts themselves. Many attributes about the parts are duplicated in the corresponding routable and non-routable objects.

So, in the PG&C solution, specific composition information is found in two places, on the part/part group and on declarations that list the part. For example, for Part/PG P033, composition data is found as follows:

<table>
<thead>
<tr>
<th>Part/Part Group P033</th>
<th>Declaration MD211</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Compliance tab</strong></td>
<td>Items tab &gt; Items table &gt; click P033</td>
</tr>
<tr>
<td></td>
<td>Manufacturer Parts tab &gt; Manufacturer Parts table &gt; click link</td>
</tr>
<tr>
<td></td>
<td>Part Groups tab &gt; Part Groups table &gt; click link</td>
</tr>
</tbody>
</table>
A compliance manager adds parts/part groups to a declaration. Parts in a BOM that are listed in a change order as **affected items** indicates that the change affects the item by modifying it in some way, thus altering the product record. Parts in a BOS that are listed in a declaration can be called **affected parts**, indicating that the declaration seeks to affect the part or part group by collecting its compliance data, thus altering the product record. Taking the specification(s) into account, the system merges the affected parts and specifications to create a unique "Affected Part/Part Group–Specification" line item for that one supplier – each line is a composition.

So, compositions are found under the various “affected parts” tabs contained in published declarations and under the **Compliance** tab of associated parts and part groups. Although each declaration goes to only one information supplier, declarations can contain multiple parts, manufacturer parts, and part groups simultaneously. In this way, a declaration can contain the data for multiple compositions.

---

**Note**
A field called Composition on the **Compliance** tab of parts and part groups displays links to declarations: this heading simply indicates “the declarations below provide information about compositions.” The declaration is the container of compositions.

**Types of compositions in a declaration:**

- “Yes / No / Exempt” declaration at the part or part group level
- “Yes / No / Exempt” declaration at subpart, material, substance group, and substances level of part or part group
- “PPM / Mass” declaration at the material and substances level of a part or part group
- Combination of the previous types.

As stated at the beginning of this chapter, much of its information will become more clear as you work with the material in the rest of the manual – especially those about parts/part groups, declarations, and compliance rollups.
Chapter 4
Substances

This chapter includes the following:

- Tabs and Attributes in Substances ................................................................................................................ 23
- Creating Substances ........................................................................................................................................... 25
- Working with Substances .................................................................................................................................... 26

Definitions of the Substances classes were introduced in Substances Classes (on page 11).

Tabs and Attributes in Substances

Many attributes in PG&C appear in several or all of the PG&C business objects, as well as items and manufacturer parts. Because any given attribute may be defined only once in this manual but may not be defined in this chapter, simply search the PDF for the attribute you want to see.

General Info Tab

The General Info tab provides general information about the substance, material, subpart, or substance group. The Alias attribute is new in PLM 9.2.2.

- Lifecycle Phase – When you create a substance, the default lifecycle phase is Active. To make the substance obsolete, change its lifecycle phase to Obsolete.

- CAS Number – Chemical Abstracts Service registry number, which identifies a chemical substance or molecular structure. (Agile does not enforce a unique CAS number, they are a reference tool.) This is especially helpful when there are multiple generic or proprietary names for a substance.

For more information about CAS numbers, see http://www.cas.org/faq.html (http://www.cas.org/faq.html).

Note
A new attribute called User-entered CAS Number can be entered by the information supplier on a declaration or by a regular user on a part or part group. These are used by the compliance manager to ascertain precisely what substance is being referred to by the supplier.

Substances > Alias attribute

- Alias – This attribute is provided to inform the PG&C system of “substitute names” of substances. Your company has decided how to name your “global substances” (substances of concern to your company and, by extension, substance groups), but there are bound to be discrepancies when substances-in-parts are reported by your information suppliers or part information is imported or downloaded from other sources of data.

For example, an alias for Lead could be the chemical notation “Pb”. The system can then resolve any confusion if a supplier submits information for a substance that they call Pb.
You can add and remove one or more alias from this attribute for any substance or substance group.

The maximum number of characters per alias is 300; the maximum number of characters for the Alias field is 4000.

For more information, see **Substance Aliasing** (on page 27).

**Where Used Tab**

The **Where Used** tab lists all top-level assemblies (TLA, the products) that contain, somewhere within their BOM, a composition using the particular substance, substance group, material, or subpart. Note that the system displays the latest Released rev and all Pending or previously Released revs of the TLAs that contain the substance.

**Where Used** tab information is filled in automatically.

**Substance Groups > Substances Tab > Conversion Factor**

Since a substance group is an object that collects similarly-based substances, it is natural to have a **Substances** tab that lists them, just like a user group has a **Users** tab that lists its member users.

- **Conversion Factor** – Default conversion factor is 1. The value can be any non-negative number.

**Note** Conversion Factor in substance groups is a different idea than Conversion Factor in part groups. See **Part Groups > Parts Tab** (on page 51).

**Substance Groups and Conversion Factor**

A substance group relates to a base substance. The base substance must be defined as a substance in Agile. The base substance is stored in the Base Substance field (a list field) that contains a list of all substances in your system.

Substance groups also contain a list of substances that relate to the base substance through a Conversion Factor. Substance groups can only contain substances, not other substance groups. Note that the base substance of a substance group cannot be changed.

The substances that belong to a substance group have a conversion factor that calculates (by weight) the amount of the base substance that is within one of the members of the substance group. For example, 1 gram of lead-oxide contains 0.78 grams of lead. The resulting conversion factor is “0.78”.

Here is another example: let there be a substance group called “Lead-based Compounds,” with a base substance Lead, and with lead-based compounds such as Lead Oxide, Lead Phosphate, and Lead Sulfate (among others). You enter conversion factors for these compounds of 0.866, 0.766, and 0.683, respectively. Now consider that you have a part that contains 1 gram of Lead Oxide, 2 grams of Lead Phosphate, and 3 grams of Lead Sulfate. The system takes these amounts against the conversion factors, and so calculates this equation: 

\[(1 \times 0.866) + (2 \times 0.766) + (3 \times 0.683)\]

which yields a total of 4.447 grams of Lead embedded in “Lead-based Compounds” in the part.

Therefore, substance groups calculate the total amount of their base substance, then behave as if they are their base substance. Note that the **Substances** table of the substance group cannot be edited once the substance group is used.
Note When you import a substance under a substance group to a declaration without a specification, or import a composition directly into a mfr. part (Substances table), if you do not specify the conversion factor for the substance, the conversion factor is copied from the global substance group, assuming the same substance exists there (previously it would leave the conversion factor unpopulated). The system does leave Conversion Factor blank if it is not entered and the substance does not exist in the global substance group.

The conversion factor is pertinent to substances and weights rollups, which are documented in Substances and Weights Rollups using Excel Integration (on page 93) and also in Internal Logic of Substances and Weights Rollups (on page 117).

Materials and Subparts > Composition Tab

The Composition tab exists in the Materials and Subparts classes, not in the Substances and Substance Groups classes. However, this tab is disabled (not visible) out-of-the-box, so you may not see it.

The Composition tab on a material or subpart object is used to manage the substances that belong to that material or subpart. In the context of materials and subparts, a “composition” is a simple term. The Composition tab of materials and subparts is used for “recipe management,” which is keeping track of the intended composition. This data has no impact on the compliance validation process.

Note Simple compositions that are listed in the Composition tab of materials and subparts are not the same thing as the aggregate compositions that combine compliance information of part–spec–supplier (discussed in Compositions (on page 17)).

More About Subparts

A subpart is a subunit of a component manufacturer part. Subparts are not numbered and do not expand the BOM. For example, when your company uses a power supply made by a supplier, a BOM may just list “power supply,” which is sufficient for manufacturing purposes. For compliance purposes, however, you may need information about substances in all the parts of the power supply – the switch, plate, coil, cord, plug, and so forth: for these you or your supplier would create subparts for the supplier to furnish information. There is no limit to the number of subparts in any assembly.

Therefore, a subpart may be thought of as the first level of the Bill of Material of the manufacturer part, that is, the supplier’s BOM. Subparts and the other Substances classes have their own listing, the Bill of Substances (see “Bill of Substances Overview” on page 33).

Creating Substances

When you create most substances, the only required attribute you must specify is Name. The name must be unique. The name is case-insensitive, which means “ARSENIC” is treated the same as “Arsenic”.

Both the Name and Base Substance attributes are required when you create a substance group.
Note: Although all characters are supported within Agile PLM, and should not create issues within Agile's clients, it is recommended that you avoid using the following characters when creating objects, particularly substances and substance groups.

, comma . period (dot) : colon ; semicolon = equal sign

To create a substance:

1. Choose Create > Substances and choose a class from Substances, Subparts, Materials, or Substance Groups. It is possible your administrator has renamed these or created additional substances classes.

2. The Create Substances wizard opens. The Substance Type field is filled in. The “Number” field should be filled in with the name of the substance, and the field will convert to “Name” in the next page of the wizard. Click Continue.

   If you click the Continue Creation in Wizard checkbox, you will be able to Continue through all aspects of a substance object. If you leave this checkbox blank, you will Finish the object creation process, and then you can add to the object by modifying it.

3. Enter values for attributes such as Description, CAS Number, and Lifecycle Phase, then click Next.
   - If your PG&C solution has been configured for the JGPSSI class, your administrator has set up a Page Two field called Classification Number (Classification No) in substances and substance groups, and also a field called Level in substance groups: they are required when you create JGPSSI objects.
   - Remember that substance groups also require a Base Substance to be specified.
   - Enter values for the Alias attribute that are alternate names for the substance that may be used by suppliers.

4. If you want to add attachments to this substance, choose from the Add menu Files, URLs, or By Search, and navigate to the desired file or URL. When you are finished adding attachments, click Finish.

   Note: See Using the Search Options in Add Operations (on page 103).

5. When your substance is complete, click Finish. The new substance appears with the General Info tab selected.

   After the substance object is created, it can be modified at any time.

Working with Substances

Many of the features added to PG&C for Release 9.2.2 have to do with substances, and so are introduced in this section of the manual. However, the new features have to do with validating the data in parts/part groups and refining the RFI process – that is, removing potential blocks to declarations and compliance rollups. The PG&C solution is robust and multi-tiered, and this discussion proceeds as if you were already very familiar with the other PG&C objects. You may want to glance through the remainder of this chapter, and then return to it after becoming more
familiar with other PG&C business objects.

Topics covered include Substance Aliasing, Mass Disclosure, Mass Tolerance, Intentional and Non-intentional Substances (and related properties), and Unreported Substances feature.

Tasks that describe how to add substances to specifications are provided in Working with Specifications (on page 40).

Substance Aliasing

The Alias attribute (introduced in Substances > Alias attribute (on page 23)) provides the solution to this problem: whenever a supplier provides information about substances for a part, there is no guarantee that a substance with the exact same name exists in the buyer’s system.

When an invalid substance is corrected or mapped to a substance in the system, the system adds the invalid substance as an alias to the substance. Whenever the same invalid substance is imported, it automatically maps to the objects. The system captures those invalid substances mapped to specific existing substances.

Note You can remove an “alias” value any time from any substance; you cannot prevent an alias being added if you are correcting in a declaration. So, if you have performed a substance correction in a declaration that, for any reason, you consider a “one-time” correction, once you advance the declaration, you can open that substance object and remove the newly added alias value; the declaration you corrected would not need to be corrected again.

If you decide to create a new substance, you can do one of two things:

- Create a new substance and map the invalid substance to the new substance;

OR

- Create a substance with the same name as the invalid substance; in this case, the “invalid substance” does not exist anymore, as it has become a “global substance”.

Mass Disclosure

The Mass Disclosure attribute is found on the Composition tab of parts and part groups, and on the Part/PG tabs of declarations. It has three values: Fully Disclosed, Partially Disclosed, and Undisclosed. The correct value is generated by the system during composition rollups.

Full Disclosure, Partial Disclosure, and No Disclosure

These are the three types of disclosure, and how they are qualified by substance compositions and homogeneous material compositions.

- **Fully Disclosed** composition (Full Disclosure):
  - A Substance composition is considered to be Fully Disclosed if the difference between the part’s mass and the sum of the masses of all the substances is less than or equal to the Mass Tolerance Percentage setting.
  - A Homogeneous Material composition is Fully Disclosed if this two-step process is satisfied: (1) The difference between a material’s mass (that is, the immediate parent of the substances) and the sum of mass of the substances under that material is less than or equal to the Mass Tolerance Percentage setting; and, (2) The difference between the part’s


mass and the sum of mass of the parents of the substances should be within the Mass Tolerance Percentage.

- **Partially Disclosed** composition (Partial Disclosure):
  - A Substance composition is Partially Disclosed if the difference is more than the Mass Tolerance Percentage, in which case an "Unreported" substance is added by the system to fill in the missing mass.
  - A Homogeneous Material composition is Partially Disclosed if one of the following is true:
    1. The difference between a material’s mass (that is, the immediate parent of the substances) and the sum of mass of all the substances under that material is greater than the Mass Tolerance Percentage setting; and,
    2. The difference between the part’s mass and the sum of mass of the parents of the substances is greater than the Mass Tolerance Percentage setting; or
   
   The part’s weight is missing, but none of the information is missing in the BOS tree. That is, the Mass and PPM should not be “null” anywhere in the entire BOS tree, including subparts, materials, or substances.

- **Undisclosed** composition (Non-disclosure):
  - If the mass is missing for the part, substance, or the immediate parent of the substances, it is considered an Undisclosed composition.
  - Furthermore, a Homogeneous Material composition is Undisclosed if any of these cases are true:
    - One of the substances in a material does not have Declared Mass and Declared PPM; or,
    - One of the materials does not have a Declared Mass; or,
    - One of the materials does not have any substance; or,
    - One of the subparts does not have any child.

Mass Tolerance

A part/part group or assembly has mass (weight) and all its substances/materials have individual masses: if the sum of their masses does not match exactly, the system checks whether the sum of the material masses falls within the tolerance (%) of the part's mass. This tolerance – between 0–5% – has been set by the administrator as a systemwide setting, so it applies across all objects analyzed by PG&C (the end-user does not see this value in the user interface).

To describe the effect with an example: let Mass Tolerance Percentage be 1% and part P1’s mass is 90 g. The composition will be identified as Fully Disclosed as long as the sum of its materials (the Bill Of Substances mass) is at least 89.1 (because 1% of 90 is 0.9). With the tolerance factored in, the mere fact of “missing substances” are not enough to throw off compliance, and the rollup can effectively interpret the composition as Compliant.

Mass Tolerance Percentage facilitates error correction, so it is likely that the value will be even smaller than the 1% in this example, perhaps closer to 0.1%.

Now, if the sum of BoS mass is any smaller than 89.1, let’s say (89.099) our system will add Unreported substance for 0.901 grams that is “missing” (this topic is in Unreported Substances in Partially Disclosed Compositions (on page 30)).

Note that the system stores both mass and normalized mass; when it compares masses, only the
normalized masses are compared.

Higher tolerance can have negative impact on partially disclosed compositions. (It may be said, however, that a Result Compliance in Rel. 9.2.2 will never be a worse than it would have been in Rel. 9.2.1.)

**Intentional and Non-intentional Substances and Related Attributes**

Homogeneous materials can contain two types of substances, *intentional substances* and *non-intentional substances* (contaminations).

Intentional substances are intentionally part of a material. For example, stainless steel contains 9% Nickel. Nickel is an intentional substance in stainless steel that makes it corrosion-free. However, during production of steel, certain contaminations can be introduced as the result of impurities in the base steel or because of the manufacturing process. These contaminations are non-intentional – but they are still part of the final product.

Certain legislations don’t allow for “intentional adding” of certain substances – such as lead – but allow a certain percentage of lead in the product through contaminations, that is, “unintentional adding” of substances. Other legislations add the total amount of a substance – both intentional and non-intentional – and prescribe a maximum threshold value.

**Intentionally Added**

Agile PLM 9.2.2 introduces the “Intentionally Added” property to act as the constraint defined in the Joint Industry Guide and the IPC 1752 forms. The Intentionally Added attribute is a “Yes/No” attribute in all the Part/part group business objects > Compliance tab > Substances tables and Declarations > Parts/Part Groups tabs > Substances tables.

If, for a substance in the specification, Disallow Intentionally Adding is Yes, when a supplier or other user enters Yes in Intentionally Added, the substance’s Calculated Compliance value is Non-compliant. If that substance was not intentionally added (= No), the system can go ahead and check the Threshold PPM of the substance-for-the-spec; also see Disallow Intentionally Adding (on page 29).

The compliance manager can modify Int.Added in the Pending status of the Default Declarations Workflow. The supplier can modify it in the Open to Supplier status of the same workflow. It cannot be modified in any other status (without administrator impact). If there is no value in Intentionally Added field, the system assumes No when performing rollup calculations.

This is a special use case for Intentionally Added: If the Result PPM for the substance is 0, and both Intentionally Added flags in specification and composition are Yes, the Calculated Compliance for this substance will be Non-compliant: because the user indicated that the substance in the composition was added intentionally, it composition should be Non-compliant even though the PPM is 0.

**Note**

The Intentionally Added flag on Substances table applies to the Compliance Rollup feature, and does not apply to the Substances and Weights Rollup feature (that uses the Microsoft Excel-based Client).

**Disallow Intentionally Adding**

Found on Specifications > Substances table, the default value of Disallow Intentionally Adding is No, so that it allows the Intentionally Added property to be in effect. If this were set to Yes, Intentionally
Added does not take effect. No “blank” value is allowed for this property.

**Specification Intentionally Added**

In parts/part groups and declarations, the Substance tables also have an attribute called Spec Intentionally Added. This property points to, on the substance’s Specifications > Substances tab, the value of attribute Disallow Intentionally Adding. This read-through attribute is readable and searchable but cannot be modified. For existing customers who do not have an Intentionally Added flag in the Specifications > Substances tab, the system assumes that it is set to No.

**Unreported Substances in Partially Disclosed Compositions**

PLM Release 9.2.2 also adds a system-generated entity or object that “fills in” the unaccounted difference between the total mass of the part or assembly and the sum of all its constituent substances. The name in the application is “Unreported (System)” and it can simply be referred to as “unreported substance.” The unreported substance is searchable in the application; the user can edit any field in the PageOne or PageTwo of unreported substance, excluding the name. But you cannot delete the unreported substance. Its presence in a composition is inferred when compliance rollups mark a composition as Compliant but the weights of the part and its substances do not match.

---

**Note**  
An unreported substance cannot be added manually by a user; that is, the purpose of the unreported substance is circumvented if an object called “Unreported Substance” or the like is created and used as a “filler” – the system should be allowed to work its calculations and create the entity as needed.

**Caution**  
The Mass Tolerance Pct. setting and the Unreported (System) substance is used expressly to account for small discrepancies between part mass and substance mass. It is not to be used to “hide” a portion of substances in a declaration that could be thought of as a proprietary formula (or “recipe”) in a manufacturer’s product. This will be a part of a future release of PG&C, but proprietary hiding is not supported in Rel. 9.2.2.

**Conditions When the System Adds the Unreported Substance**

The following lists conditions that must be satisfied for the system to add an unreported substance to a composition.

- **In Declarations**
  The “Unreported (System)” substance is added when the declaration is moved to the next status, except when moving from Pending to any non-Released status; also, when the user chooses Actions > Calculate Compliance.

- **For Substance Composition**
  If the mass of each substance/substance group in the part and the mass of the part are available, the system adds up the masses of the substances and compares the total sum with the mass of the part.
  - If the part’s mass is greater than the sum of substances masses, the system adds the Unreported (System) substance to the part and set the weight difference in that substance’s Calculated Mass attribute.
If Mass Tolerance Percentage is set (in Administrator) and the mismatch of “total masses” falls within the tolerance range, the system does not add the unreported substance.

- If the part’s mass is less than the sum of the masses of the substances, the system does not add the unreported substance and does not set the negative weight.

- If the mass of the part is missing, or the mass (or Declared PPM) of any one of the substances is missing, the system does not add the unreported substance.

Homogeneous Material Composition

If the mass of each homogeneous material is available, the mass (declared or calculated) of each substance in that material is available, and the mass of the part is available, the system compares the material-mass with the sum of the substances mass and it compares the part-mass with the sum of the materials mass.

- The unreported substance is added to a homogeneous material declaration only if it is Partially Disclosed.

- If the composition is Partially Disclosed and the material-mass is greater than the sum of substances-mass, the unreported substance is added under the material.

- If one of the substances in the material does not have a mass and declared PPM, or if the material does not have a mass, the system does not add the unreported substance.

- If there are two materials, one Undisclosed and the other Partially Disclosed, the system does not add the unreported substance to the Partially Disclosed material, since the entire composition becomes Undisclosed.

Unreported Substance when Importing Substances to Items and Manufacturer Parts

- The unreported substance is added after the import process is complete.

- If the composition’s mass is blank, the system uses the value in Mass attribute (found on General Info of items and Title Block of mfr. parts) in doing a composition rollup, and it copies the mass to the Composition table of the part.

- After the rollup is done, if the value of Mass in PageOne of the part is changed, the system does not recalculate the composition.
Bill of Substances Overview

The Bill Of Substances (BOS) is a way to manage compliance information-gathering with regard to the parts and materials used in the manufacturing process.

To understand the BOS and how it is “derived” from the BOM in Agile PLM, let’s first look at what a Bill Of Material is.

The BOM is a List of Parts that become Products

The Bill Of Material (BOM) is the list of all parts and subassemblies that are assembled into the manufactured product. The BOM is central in Agile PLM’s Product Collaboration solution, and is fully documented in Product Collaboration User Guide.

This is a simple list of BOM levels from the top-level assembly down.

Levels of the BOM

- First or top level: Top-Level Assembly (TLA), the ultimate product being manufactured
- Second level: Assemblies and sub-assemblies
- Third level: Items (parts and documents; these are manufactured at your company)
- Fourth level: Manufacturer Parts (these are parts from companies on the Approved Manufacturer List, or AML)

Although we are introducing the Bill of Substances by reviewing the Bill of Materials, it is important to understand that the BOM and the BOS list different kinds of entities. Therefore, the “levels” in the BOM and the “levels” in the BOS do not correspond with each other: both lists are, however, organized as a hierarchy.

There is a relationship between the BOM and the BOS: anything on the first four levels of a BOM – any kind of part or assembly – can be the origin of a Bill Of Substances.

The BOS is a List of Substances Contained in Parts, which Requires Compliance

The Bill Of Substances is a hierarchical list of substances that are contained in the parts and assemblies that make up a BOM. This is a list of BOS hierarchical levels from any composition of a part or part group or subassembly or TLA:
Levels of the BOS

- First or top level: the Composition of a part or assembly
- Second level: Subpart
- Third level: Homogeneous Material
- Fourth level: Substance Group
- Fifth level: Substance

You may recognize the 2nd–5th levels are the Substances classes. This order of this hierarchy is particularly important in compliance rollups (documented in Rolling Up Compliance Data (on page 81)). Note that the top level of a BOS is the composition. While the purpose of the BOM is to assemble parts into a sensible sequence so that the product works, the purpose of the BOS is to assemble data about substances contained in products so that the substances can be analyzed and evaluated and your company's products can be in compliance. An example follows.

Rationale for the BOS

Depending on the type of specification with which you need to be compliant, you will need more or less information from your suppliers. For example, the RoHS legislation wants parts to be compliant at the homogeneous material level. This means that you might require your component manufacturer to specify how much lead it contains per homogeneous material within the component.

Unfortunately the sub-units (subparts) of a component (say, the packaging around a chip) are not always homogeneous, but they may consist of a coated material. For the RoHS legislation, this means that such a subpart consists of two homogeneous materials, each of which has to be compliant.

This creates a tree structure called the Bill of Substances. Suppliers can be required to provide information at each of the levels of the BOS.

Depending on the type of specification involved, levels in the above list may be omitted.

Summary of BOS Structures

The rules relating to the type of substances that can be added to the Composition tab are:

1. A subpart can contain a material and a subpart at the same level. A subpart cannot contain all four types of substances at the same time.
2. A material can contain only substances and substance groups. A material cannot contain a subpart or a material.

Here are the valid structures of the Substances classes:

For Subparts:
Subpart > Substances AND/OR
Subpart > Substance Groups AND/OR
Subpart > Substance Groups >Substances
OR
Subpart > Homogeneous Materials AND/OR
Subpart > Subpart AND/OR
Subpart > Subpart > Homogeneous Material

For Homogeneous Materials:
Homogeneous Material > Substances AND/OR
Homogeneous Material > Substance Groups AND/OR
Homogeneous Material > Substance Groups >Substances
Chapter 6
Specifications

This chapter includes the following:

- Tabs and Attributes in Specifications.............................................................. 37
- Creating Specifications.................................................................................... 39
- Working with Specifications............................................................................. 40
- "All Spec" Use Case......................................................................................... 41

Some important aspects of the Specifications class were introduced in the Specifications (see “Introduction to Specifications” on page 12) section.

Tabs and Attributes in Specifications

Many attributes in PG&C appear in several or all of the PG&C business objects, as well as items and manufacturer parts. Because any given attribute may be defined only once in this manual but may not be defined in this chapter, simply search the PDF for the attribute you want to see.

General Info Tab

The General Info tab provides general information about this object. Name, Description, Jurisdiction, Lifecycle Phase, and Specification Type are entered when the specification is created. You can edit this information by clicking the Edit button in the General Info tab.

- **Validation Type** – drop-down field, choose Part Level or Homogeneous Material Level. This field is required, but the field is populated with the default Part Level in the Create wizard. Note that once the specification is created, its Validation Type cannot be changed.
  - **Part Level** – enforces simple BOS, e.g., weight of part to validate PPM; compliance with this type of specification has to be validated at the part level; or,
  - **Homogeneous Material Level** – enforces BOS that is more complex; compliance with this type of specification has to be validated at the homogeneous material level

When a specification is added to a part or declaration, this field is useful in tracking whether the part (or all the parts contained in the declaration) should be compliant at the part level or at the homogeneous material level.

Also, when importing compositions or substances into items or manufacturer parts, the part’s Composition Type and the specification’s Validation Type must match.

For more information about this attribute, see Validation Type in Conjunction with Composition Type (on page 19) and Importing Compositions into Items and Manufacturer Parts (on page 71).

- **Exemptions** – a multi-list field derived from the Exemptions list (set up by the administrator). When you create a specification, you populate the Exemptions attribute by selecting relevant exemptions that should be present in the drop-down list.
When a specification is associated with a declaration, exemptions named in the spec “read through” to the declaration’s Exemptions fields. Exemptions in declarations are discussed in Affected Parts Tabs (on page 60).

Also see more information about exemptions (and the Exempt compliance state) in Compliance States (on page 85).

---

**Note**

The system currently allows you to remove exemptions from a specification if the exemption has been assigned to a declaration, part, manufacturer part, or part group; in the future this will not be allowed.

---

### Substances Tab

You can edit, remove, or add substances and substance groups to the Substances tab of a specification; you cannot do the same with materials or subparts. When the specification is being used, the Substances table cannot be changed.

You cannot add both a substance group and its base substance to the specification’s Substances tab.

---

**Note**

When the specification is being used (in a part or part group or in a declaration), the Substances tab in the specification cannot be edited (including add / remove). If the spec is removed from part Specifications table or from declaration Specifications table, the Substances tab on the specification reverts to being editable.

- **Reporting** – Mandatory or Optional: if set to Mandatory, where this specification is on a declaration, that is a message to the supplier that they must report compliance information for that substance. If it is set to Optional, the supplier does not need to provide data for that substance, and the system will not check that substance for compliance. The rollup logic considers only “mandatory” substances, and the compliance states of only “mandatory” substances are rolled up to the part.

Even though a supplier is expected to provide information for substances marked Mandatory, currently the system does not “enforce” this setting (via, for example, a flag or notification).

**Note**

The Reporting flag on Specifications > Substances table applies to the Compliance Rollup feature, and does not apply to the Substances and Weights Rollup feature (that uses the Microsoft Excel-based Client).

- **Threshold Mass PPM** – When adding a substance group, the Threshold PPM value is given at the substance group level. The “threshold mass PPM” describes the maximum quantity in parts-per-million of a substance allowed in order to be within compliance.

The Substances table of a specification identifies which substances are restricted and their threshold mass PPM.

During compliance rollups (discussed in Rolling Up Compliance Data (on page 81)), the system marks a substance as Compliant if the Declared or Calculated PPM is less than or equal to the Threshold Mass PPM.

- **Disallow Intentional Adding** is discussed in Intentional and Non-intentional Substances and Related Attributes (on page 29).
Chapter 6

Creating Specifications

The only required attribute that you must specify when you create a specification is General Info.Name. The name must be unique. The name is case-insensitive, which means “ROHS” is treated the same as “Rohs”.

An optional attribute is General Info.Lifecycle Phase. When you create a specification, the default lifecycle phase is Active. To make the specification obsolete, change the value of its lifecycle phase attribute to Inactive.

To create a specification:

   - The Type field should already read Specification. If the administrator has created additional subclasses of specifications, these are available in the drop-down list.

2. In the Number field, enter a name for the specification. Click Continue.
   - If you click the Continue Creation in Wizard checkbox, you will be able to Continue through all aspects of a specification object. If you leave this checkbox blank, you will Finish the object creation process, and then you can add to the object by modifying it.

3. On the Enter General Information page, enter a Description of the new specification. In the Jurisdictions field, use to select appropriate locations where this specification is valid.
   - In the Exemptions field, use to select appropriate exemptions.

Note
In the Exemptions field, use to select appropriate exemptions.

Note
As mentioned above, when a specification is associated with a declaration, exemptions named in the spec “read through” to the declaration’s Exemptions fields. It is a best practice to be familiar with the use of exemptions in specifications and how they work in declarations. Exemptions in declarations are discussed in Affected Parts Tabs (on page 60).

In the Lifecycle Phase field, use the drop-down list to select Active.

In the Validation Type field, use the drop-down list to select Part Level or Homogeneous Material Level.

4. When finished with these fields, click Next. The Add Substances page appears.
   - At any point you can click Finish, which will close the wizard, and you can add to the object by modifying it.

5. To add substances to the specification, click the Add button. Use the drop-down arrow to select Search to add existing substances or Create New to create a new substance object that will be added to the specification.
   - See Using the Search Options in Add Operations (on page 103).

6. When you want to add substances in the Selected table, click OK. You may run additional searches after this, too.
   - If the Edit rows after adding checkbox is not checked, the substances are added. If you click the Edit rows after adding checkbox, you have the opportunity to modify each substance in the Reporting field (Mandatory or Optional) or Threshold Mass PPM field. Click Save when you are done.
When you are finished adding substances to the specification, click **Next**. The Add Attachments page appears.

7. If you want to add attachments, choose from the **Add** menu Files, URLs, or By Search, and navigate to the desired file or URL. When you are finished adding attachments, click **Finish**.

   **Note**  
   Best practices dictate that a copy of the legislation that covers the substances (in a format such as an Adobe PDF) should be added to the **Attachments** tab.

8. When your specification is complete, click **Finish**. The new specification appears with the **General Info** tab selected.

**Working with Specifications**

These tasks describe how to add, edit, and remove substances and substance groups on a specification.

**To add an existing substance or substance group to the Substances tab of a specification:**

1. Open a specification, click the **Substances** tab.
2. Click the **Add** drop-down button and select **Search**. The Add Substance wizard opens in a separate window.

   **Note**  
   See [Using the Search Options in Add Operations](#) (on page 103).

3. From the returned rows, select and move one or more substances that you want to add to the **Selected** list.
4. Click **OK**, then click **Save**. The selected substances are added to the specification.

**To add a new substance or substance group to the Substances tab of a specification:**

1. Open a specification, click the **Substances** tab.
2. Click the **Add** drop-down button and select **Create New**. The New wizard opens in a separate window.
3. Choose **Type** of substance object to create (Substance or Substance Group), fill in a name for the new substance, then click **OK**.
4. Follow the wizard, referring to the “create” task in previous section. When you are done, click **Finish**.

**To edit a substance or substance group on the Substances tab of a specification:**

1. Open a specification, click the **Substances** tab.
2. Select the substance you want to edit, then click **Edit**.
3. Make the desired changes to the substance, then click **Save**.

**To remove a substance or substance group from the Substances tab of a specification:**

1. Open a specification, click the **Substances** tab.
2. Select the substance you want to remove, then click **Remove**.
3. Click **OK** on the prompt to complete the removal or **Cancel** to cancel the removal.
"All Spec" Use Case

There is a special situation regarding declarations with no associated specifications, called the "All Spec" (All Specification) use case. Basically, if you intend to collect raw data (mass or PPM) at a substance level, create a declaration with no specification attached. The supplier must provide information on all materials and substances. You then use the information to calculate compliance in relation to any specification. The same is true when directly importing compositions into items or manufacturer parts.

Note that the All Spec use case is less important with the introduction of Fully Disclosed compositions, but there is still room for All Spec to be useful, as the following case describes.

Let's start with the "normal" use case: when there is a specification in the declaration, the information that the supplier provides is attached to that specification and cannot be used to assess compliance against other specifications using the data that the supplier provided.

For example, a supplier receives a declaration with Part 101 and the RoHS specification. The supplier responds to this declaration at the part level using the Declared Compliance field in the declaration's `<parts/PG>` tables. Regardless what the supplier declares (compliant or non-compliant), that information is associated to the RoHS specification, and we cannot use this information to assess compliance against other specifications.

On the other hand, if the supplier provides either the Mass or PPM values at the substance level, the system calculates the compliance and determines whether Part 101 is compliant for RoHS or not.

The difference between these two cases is that, in the second case, even though the supplier provided the raw data (Mass, PPM) at the substance level, since the declaration had a specification (RoHS), all the information from the supplier is associated with the RoHS spec. If the user adds a different specification to Part A, let’s say the WEEE specification, the system is not able to re-use the Mass or PPM information to calculate compliance against WEEE because all that information is associated with RoHS specification, unless the composition is Fully Disclosed, in which case it can be reused to calculate the compliance from any specification with matching Validation Type.

Therefore, if the buyer intends to collect raw data (Mass or PPM) information at the substance level, they should attach no specification to the declaration. The supplier then provides information on all materials and substances in Part 101 with either Mass or PPM information. The buyer can use this information to calculate compliance against any specification. This is what is referred to as the All Spec case.

Rules for Selecting Compositions for Rollup on Part/Part Group

Although the following information regards the All Spec composition and is therefore presented here, you will see it again when you read about Compliance Rollups.

1. For a given spec, the system looks for matching spec composition (the composition that has the same spec as the given specification).

2. If not found, it looks for Fully Disclosed composition – the latest active one for each supplier, regardless of the spec on the composition. As soon as there is a Fully Disclosed composition, they are used to calculate compliance. This means that all existing Partially Disclosed or Undisclosed All-Spec compositions that match the composition type of the Fully Disclosed composition are ignored.

3. But if a Fully Disclosed composition is not found, the system looks for "All Spec" compositions
with the same validation level as that specification's validation level for that part or part group. The All Spec composition is a composition without any specification attached.
Chapter 7

Parts and Part Groups

This chapter includes the following:

- Tabs and Attributes in Parts and Part Groups .......................................................... 44
- Creating Part Groups in PG&C .................................................................................. 52
- Working with Part Groups ......................................................................................... 53
- Mapping Feature in Parts and Part Groups ............................................................... 54

Some important aspects of the Items, Manufacturer Parts, and Part Groups classes were introduced in Parts and Part Groups (on page 43).

PG&C-related tabs on items and manufacturer parts, as well as part groups, are the Compliance tab and the Suppliers tab. These tabs work the same way in all these objects, and they are discussed in the next section.

Items and manufacturer parts that belong to a part group "give up" their independence in terms of declarations. That is to say, from the moment parts are associated with a part group until the moment they are disassociated from it, it is not possible to add those parts to a declaration separately. Nor is it possible to import compliance data into the parts separately. Specifications are forwarded from the part group as well but it is still possible to add specifications directly to the item or manufacturer part, regardless of part group associations.

When a part group is added to an item (that is, part but not manufacturer part), the active compositions of the part group are copied to the latest released revision ("rev") of the part, as well as all Pending revs of the item. (Revisions in Agile PLM are thoroughly documented in Product Collaboration User Guide.)

When a new composition is added to a part group – through publishing a declaration – the system looks for other compositions for the same supplier, same specification, and same composition type (declaration type). If there exists an older active composition, then the older composition becomes inactive, and the new composition becomes active.

Also, when a new composition is added to a part group through a published (completed and released) declaration, that composition data is published to all manufacturer parts and items (latest Released rev and all Pending revs). The composition replacement logic runs through all manufacturer parts and items (by revs).

A part group can contain a combination of multiple items and manufacturer parts at the same time. The normal use case is that a part grouping either contains items or manufacturer parts.

- For items, belonging to a part group is rev-independent.
- For items, belonging to a part group is site-independent. (PG&C currently does not support Agile sites.)
Tabs and Attributes in Parts and Part Groups

Many attributes in PG&C appear in multiple PG&C business objects, as well as items and manufacturer parts. Because any given attribute may be defined only once in this manual but may not be defined in this chapter, simply search the PDF for the attribute you want to see.

For information about associating substances with an item, manufacturer part, or part group on a declaration, see Working with the Part Substances Tables (on page 66).

Title Block and General Info Tabs

The General Info tab is the “Page One” on part groups or manufacturer parts. Page One is called Title Block on items. Page One provides general information about this part or part group, including Name, Description, Lifecycle Phase, and Mass.

Changes you make to the weight information (Mass) on a part group’s General Info tab will affect the mass of parts and manufacturer parts associated with the part group.

**Items > Title Block or Manufacturer Parts/Part Groups > General Info Attributes**

The following fields appear on the Page One of items, manufacturer parts, and part groups:

- **Overall Compliance** – indicates the compliance state of the part using the worst-case scenario and matched across all specifications associated with the part. This attribute is found on these objects:
  - Items > Title Block tab > Overall Compliance
  - Manufacturer Parts and Part Groups > General Info tab > Overall Compliance

  On items, Overall Compliance is revision-controlled, that is, specific to the item’s rev.

  **Note** In 9.2.2, the Overall Compliance attribute also reads through to the objects below, although in these cases it is named “Summary Compliance”:
  - Items base class (Parts and Documents) > BOM tab and Manufacturers tab > Summary Compliance
  - Changes base class (ECOs, MCOs, etc.) > Affected Items tab > Summary Compliance

  On items, Summary Compliance is always from the Latest Released rev of the item; if there is no released rev, it is from the Introductory revision of the item.

- **Compliance Calculated Date** – date and time stamp when the last rollup (scheduled or manual) was run

- **Mass** – the weight of a part (item or manufacturer part) or assembly, expressed in systemwide UOM (unit of measure). Mass in Item Title Block is a “rev-controlled” attribute:
  - You can update the mass of an Introductory item through Item Title Block, if there are Pending or Released revs;
  - You can update the mass of a Latest Released Rev through the Title Block, as long as you have the right privilege;
  - You cannot modify the mass through the Title Block of a Previously Released rev, you can only “update” it through importing compositions with mass, or by publishing a declaration
for that item with the mass set through the declaration.

---

**Note** In a slightly different context, please note that the Mass field in ECO > Affected Items tab cannot be modified if you are working in Java Client; it can, however, be modified if you address it through Web Client.

- **Part Family** and **Commodity** – On an item, the Part Family and Commodity attributes on the Title Block indicate which part group the part is associated with. Either of these attributes can be enabled, and both are editable. Both Commodity and Part Family attributes can be edited from an item’s Title Block.

  On a manufacturer part, only the Part Family attribute is available. The Part Family attribute can be edited from a manufacturer part’s General Info page.

When you assign a part group to a part, the part is added to the part group’s Parts table, and the General Info mass, specifications, active compositions, and corresponding substances are copied over to the part. In order to assign a different part group, you must remove the current value on Part Family attribute, save the changes, and then associate it with a new part group.

**Items > Title Block Attributes**

The following fields appear on the Title Block of items only:

- **Shippable Item** – Yes or No: when an item is ready to go to market (presumably a top-level assembly), setting this field to Yes sets a “flag” that the system looks for in the scheduled rollups. (See Rolling Up Compliance Data (on page 81).)

- **Exclude from Rollup** – Items only, setting is Yes or No (default for Parts class is No): setting to No means that the item will always be included in compliance rollups. When the value is Yes, it sets a flag that prevents the system from considering the compliance of the item (which it determines anyway) when determining the compliance of its parent. There can be items, for example, a document, whose compliance you are not concerned about, set to Yes.

  **Note** Exclude From Rollup flag on item is supported by Compliance Rollup as well as Substances and Weights Rollup features.

**Part Groups > Make Available As Attribute**

Another General Info field on part groups, the Make Available As field, plays a part in these settings.

Make Available As Attribute and the “Force/Identical” SmartRule

An attribute on General Info of part groups called Make Available As is not visible out-of-the-box. The Make Available As field exists for two reasons: it can be used by Agile customers who are upgrading from a previous release of PG&C, when Part Groups class was called Commodities class. It also provide a way for companies with both the PCM and PG&C solutions to keep their PCM commodities separate from PG&C part groups. If your company does not own Agile PCM, the Make Available As setting is not needed and is not enabled.

This setting can be set by the user who creates a PG&C object, but it cannot override the administrator’s SmartRule called “Force Commodity and Part Family to be Identical.” The Make Available As attribute may be visible if the “Force/Identical” SmartRule is set to No, as there may be reasons to create your object as a “Part Family-only” object.

These are some business rules around the settings of “Force/Identical” SmartRule and Make Available As attribute:
If the SmartRule is set to Yes, a part can belong to only one part group. If the SmartRule is set to No, an item can belong to one “Commodity Only” part group (in PCM) and one “Part Family Only” part group (in PG&C).

If the SmartRule is set to No and Make Available As is set to “Part Family Only” or “Commodity and Part Family,” you can add manufacturer parts to a part group, while if Make Available As is set to “Commodity Only,” you cannot add manufacturer parts to a part group. If the SmartRule is set to Yes, regardless of Make Available As value, you can add manufacturer parts to a part group.

Also note that when this SmartRule is set to No, when assigning different values for the Part Family and Commodity attributes, the mass, specification, active compositions, and corresponding substances will be copied from the part group object. When this SmartRule is set to Yes and both attributes are enabled, setting the value on one will automatically assign it to the other attribute.

**PageTwo**

Release 9.2.2.1 offers a feature called "specification mapping" in which you can view the Result Compliance value that has been mapped (by the administrator) from Item/Mfr.Part Specifications table to a selected attribute on PageTwo (see below for details).

**Specification Mapping: Result Compliance from Parts’ Specification Table Mapped to PageTwo Attribute**

The administrator now has the capability of mapping a specification to a selected attribute on PageTwo. The mapping is done per specification and per class: Parts, Documents, or Manufacturer Parts. This mapping simply allows you to see the Result Compliance for a specification on the PageTwo of the part, rather than forcing you to go to the Compliance tab > Specifications table. Another advantage is that, as a Pg2 attribute, the specification-specific Result Compliance is available (for viewing, exporting) on Items > BOM tab, Items > Manufacturers tab, and Changes > Affected Items tab.

Let us say that the compliance manager creates a Specification called "China RoHS." Then, for Parts class, the administrator maps the China RoHS spec to an attribute also called "China RoHS" (it could be an existing attribute or one that the administrator creates). The mapping means that for any object created from any subclass of the Parts class, the value of the China RoHS attribute on PageTwo is copied from the Result Compliance attribute (on Specifications table) upon rollup.

The Result Compliance (RC) value of the specification is copied to the mapped PageTwo field if any one of the following events occurs:

- a rollup is done on the Latest Released rev (LRR) of a part or document;
- a rollup is done on a manufacturer part;
- a rollup is done on a BOM: if a child is the LRR, its RC value is copied to the child’s PageTwo field; or,
- a rollup is done on an item that is associated with a manufacturer part: the RC value of the mfr. part is copied to the mfr. part’s PageTwo field.

The copying of Result Compliance to a Part’s Pg2 happens only for the LRR of the part, since Pg2 is always applicable to LRR. So, if the rollup changes the RC of a previously Released rev (or a Pending rev), that value is not copied to the mapped Pg2 field. Similarly, if that Pg2 field is enabled in the item BOM tab, it only displays the value corresponding to the LRR of the item.

The copy of the Result Compliance value to the mapped Pg2 attribute only occurs during rollup. If
the part (that is, LRR of item, or mfr. part) has multiple specs, and each spec has a mapped **Pg2** attribute, the values of all the mapped attributes are copied from the RC value of the corresponding spec during the rollup.

If the admin changes a mapping to another attribute, the system removes the previous mapped attribute and also "erases" the old values from the **Pg2** field. If you remove the specification from the Latest Released rev of the part, or from a mfr. part, the value of the mapped **Pg2** attribute is also erased.

If you do a SaveAs from an item/mfr. part that already had a rollup, and already received the copied RC value, the new object will show the associated specification from the original object; however, because the new object has not undergone a rollup yet, it has no RC value and does not show the copied value on **PageTwo**.

The following lists administrator or end-user actions involving specification mapping, with their consequent effects:

- Specification is mapped with a list > Result Compliance value is copied during future rollup;
- The spec mapping is changed > Previous value is erased, new value is copied during future rollup;
- Spec is mapped to blank field > Previous mapped value is erased;
- Spec is removed from a part > If an item (Latest Released rev or Pending) or mfr. part and has a mapped value, the value is erased;
- Spec is deleted from the system > The mapping is cleaned up (on administrator's Specification Mapping node);
- Now deleted spec is "undeleted" > Administrator can define new mapping for the spec;
- Composition is archived > Nothing happens (once a composition is Inactive, it is not rolled up again);
- Compliance Rollup Task runs > All rolled up parts with mapped specs have new Result Compliance values copied to **PageTwo**.

### Compliance Tab

This tab is central to PG&C compliance data–gathering. The **Compliance** tab holds a **Specifications** table, listing the specifications that are associated with the part or part group, and a **Compositions** table, listing the compositions on the part or part group. The **Compliance** tab reflects changes to the composition of the part or part group. Changes to this data are generally collected using declarations; you can also manually import composition and substance data into items and manufacturer parts (but not part groups) – see Importing Compositions into Items and Manufacturer Parts (on page 71). There is also a View Substances link.

**Note**

Previous releases of PG&C used icons on tabs to indicate the presence of business objects; these are replaced by gray and red dots. On the **Compliance** tab:

- Grey dot = All compositions are Compliant or Exempt or Waived;
- Red dot = One or more compositions are Non-compliant or Missing information.
Compliance Tab > Specifications Table

The Compliance tab has a Specifications table. You can add specifications to or remove them from the Specifications table on the Compliance tab.

When you add a specification to a part or part group and a compliance rollup (manual or scheduled) is run on the part, the specification is also added to the other part/PG on the BOM. This is how the system automatically evaluates compliance of assemblies, even if the specification is not formally added to all the parts in the assembly. (Release 9.2.2.1 adds the Bulk Specification Removal feature.)

- **Exemption** – This field can be set by the user (roles and privileges permitting) if you determine that the part is exempt for this specification. Remember that Exemptions is a field on a specification’s General Info page (see General Info page 37): when a specification is created, exempted substances are selected as a subset from a drop-down list that represents all substances of concern (this master list was created by the administrator). So, for a part, when you set a substance to Exempt, the values you see for Exemption on a part group's Specifications table are really coming from the associated specification. For this reason, Declared Compliance is valid only if there is an associated specification in the declaration. Only when there is a specification, and the spec has exemptions associated (found in the spec’s General Info), can you set Declared Compliance to Exempt: when you do, you are then prompted to select an exemption from the list.

- **Need Compliance Check** – this field is set to No when no new data has come in since the last rollup; it switches to Yes when the system receives new data, indicating that a rollup could produce a new Result Compliance. When a new rollup is run (scheduled or manual), this field reverts to No. This field is not visible to the user on items. It is visible on manufacturer parts and part groups (Compliance tab > Specifications table). Whether or not the field is visible to you, the system still recognizes it and reacts to it in items.

  **Note** In Rel. 9.2.2.2, both the archiving (inactivating) and (re-)activating process reset the Need Compliance Check field to Yes. While that change is visible in manufacturer parts, the field is not visible in items. The best practice is to check compliance on a part (or related assemblies) whenever you change a composition's Inactive or Active status.

- **Declared Compliance**, **Calculated Compliance**, and **Result Compliance** are described below. These three fields are available at all levels, that is, at the substance level, material level, subpart level, composition level, and at specification level. Also, Calculated Compliance at a level will be Result Compliance of the level below.

  Note that the Calculated Compliance at any level can be overwritten with Declared Compliance.

  Compliance rollups are documented in Chapter 10.

**Bulk Specification Removal**

The new “Bulk Spec Removal” feature (BSR) allows removing specs across the BOM in a single operation. Note that BSR applies only to Items and Manufacturer Parts; Part Groups are not capable of Bulk Spec Removal, that is, removing a spec from a part group does not remove the spec from associated parts.
Here is the use case: PG&C’s compliance feature can verify whether a product is compliant with a new (or planned, or upcoming) specification. By adding the spec to the top-level assembly (TLA), or indeed to any part/PG in the assembly, and running a compliance rollup, you learn that your product may or may not have problems with compliance to that spec. When compliance rollup is run on an assembly, the specifications on that assembly are automatically added to all parts and mfr parts that belong to that assembly. Then, in this use case, and for a variety of other reasons, the user may not want to keep the propagated spec in the BOM.

In the case of removing a specification from an item that is not an assembly or contains no associated mfr.parts, you are prompted whether you want to continue, then the spec is removed with no further actions. Now, when you decide to remove a specification from an assembly or an item with associated manufacturer part, you will see the same prompt, then a Warning that asks you to choose "This Item" or "All," depending whether or not you want the spec removed from all items and mfr.parts on the BOM; this is the Bulk Spec Removal.

When you check All, This Item is automatically checked, and when you click OK on the Warning, the spec is removed from all levels of this BOM.

More specifically, the spec is always removed from the current level of the BOM, that is, the level from which you start the BSR operation. Removal from the other levels is subject to these business rules:

- Since specifications are Rev-specific on items, BSR on items only applies to the particular revision that is presented in the BOM.
- If there is a value in Declared Compliance of the item or mfr.part, the spec is not removed from that object. Therefore, BSR will remove all specs from all associated parts except those items/mfr.parts that have a value in its Declared Compliance field.
- When removing a spec, if the item is Latest Released rev or it is a mfr.part, the system erases the value of the mapped attribute for that spec. If the item is not LRR, the mapped value is not erased.

As a result of bulk spec removal, throughout the BOM, the Summary Compliance value is updated based on the overall compliance state from other associated specifications.

Compliance Tab > Compositions Table

The Compliance tab also has a Compositions table, which lists specification–supplier combinations that are associated with the part or part group. The Composition table has a View Substances link, which brings up a pop-up window with all the substances that correspond to a composition. The View Substances Link appears only if the user has Read privilege for the Composition Type attribute.

- Mass Disclosure – the field that states whether the composition is Fully Disclosed, Partially Disclosed, or Undisclosed; see Mass Disclosure (on page 27).
- Composition Type – the use of this attribute is detailed in Role of Composition Type Field (on page 19).
- Source – this field indicates the source of the composition; see Sources of Compositions (on page 75).
- Declared Compliance – this field allows an information supplier to simply declare the compliance state of the substance. A Declared Compliance value always “trumps” a Calculated Compliance value. That is, the Result Compliance value field always take the state found in the Declared Compliance field. If the Declared Compliance field is blank, the value in Calculated Compliance is copied to the Result Compliance field during rollup.
• **Calculated Compliance** – This Read-only value is derived from the system’s logic: the Calculated Compliance of one level in a BOS or BOM will most likely be the same value as the Result Compliance of the next lower level – unless there is a different value in the Declared Compliance field that is parallel to Calculated Compliance. Also, Calculated Compliance at a level will be Result Compliance of the level below.

Note that the Calculated Compliance at any level can be overwritten with Declared Compliance.

• **Result Compliance** – this field simply reflects the “winner” for that level of the BOS or BOM. If there is a Declared Compliance value on that level, that becomes the Result Compliance value. If there is no Declared Compliance value, the Calculated Compliance value on that level becomes the Result Compliance. Finally, the Result Compliance of a level of BOS or BOM becomes the Calculated Compliance of the next higher level.

Note When importing compositions and composition substances into items or manufacturer parts, at the end of import, the system performs a composition rollup. When the mass on the composition is blank (during import), the system uses the Cover Page Mass to do a composition rollup at the end of the import.

Compliance tab > Compositions table > View Substances link > Substances table

For each part and part group, the Substances tables list their associated substance composition, providing the part or part group has been associated with substances. You can filter the Substances table to isolate substances for a particular part or part group.

• **Reporting** – A read-only field, the value comes from the Reporting field on the associated specification Substance table for the same substance. The rollup only looks for substances that are marked as Mandatory in the spec.

• **Mass** (or Declared Mass) – can be used by the supplier to declare the Mass values at each level of the BOS.

• **PPM** (or Declared PPM) – if enabled, can be used by the supplier to enter the PPM values directly. It supersedes the Calculated PPM in the rest of the rollups.

• **Threshold Mass PPM** – A read-only field, its value comes from the Threshold Mass PPM field on the associated specification’s Substances table for the same substance. The “threshold mass PPM” describes the maximum quantity in parts-per-million of a substance allowed in order to be within compliance.

• **Calculated PPM** – the PPM as the result of the division of the mass of two levels.

• **Calculated Mass** – If Part Mass and Declared PPM of the substance is available, the calculated mass equals to part mass multiplied by declared PPM of the substance

• **Result PPM** – if there is a Declared PPM value for the substance, that becomes the Result PPM value. If there is no Declared PPM value, the Calculated PPM value for the substance becomes the Result PPM value.

• **Result Mass** – if there is a Declared Mass value for the substance, that becomes the Result Mass value. If there is no Declared Mass value, the Calculated Mass value for the substance becomes the Result Mass value.

• **Intentionally Added** and Spec Intentionally Added are discussed in Intentional and Non-intentional Substances and Related Attributes (on page 29).

• **User-entered CAS Number** – A value can be entered by the information supplier on a declaration
or by a regular user on a part or part group. These are used by the compliance manager to ascertain precisely what substance is being referred to by the supplier.

Note Values are calculated for all appropriate fields whether or not those fields are visible to you (enabled by the administrator). In PG&C, the administrator can choose to make some things not-visible, but in rollups the system is “indifferent” to that factor, that is, it always takes non-visible fields into account. If you think there is information that is not visible that you need to see, see your administrator.

Scale Property in Calculated PPM and Result PPM

As an example of these fields in use, let us say the Scale property for Calculated PPM and Result PPM is set to 2 in Administrator, which permits two decimal places. In this case, you could see a value of 333.33 in these fields on declaration <Parts/PGs> BOS tree for a substance, and even if Threshold PPM is equal to 333.33, the system could identify it as Not Compliant because the value (that it perceives in the database) for Calculated PPM and Result PPM could be 333.333333333, which is slightly higher than Threshold PPM at 333.33.

If you run into this situation, you must advise the administrator to set the scale property with a higher value for Calculated PPM and Result PPM on the Substances tables.

Also, if the Threshold PPM is set to 100 and the Calculated PPM and Result PPM are calculated to be 100.0001999, the system still makes the substance Non-Compliant because the calculated PPM is higher than the Threshold PPM, however small the discrepancy. Again, in this case, if the scale on Calculated PPM is set to 2, you would see 100.00 in the field, whereas the value in the database is slightly but inescapably higher.

For more information about compliance rollups, see Rolling Up Compliance Data (on page 81).

Modifying the Compositions Table

To add compositions to the part/PG Compliance tab > Compositions table, you can follow the original RFI process, that is, (1) create and send a declaration to a supplier, (2) receive and verify the completed declaration, and (3) publish (release) it. You can also manually import composition and substance data into items and manufacturer parts (but not part groups) – see Importing Compositions into Items and Manufacturer Parts (on page 71).

Suppliers Tab

The Suppliers tab lists the suppliers who carry this part or part group. The Suppliers tab enables you to add, edit, or remove suppliers on a part or part group. Parts can be tracked with regard to their approved suppliers.

Known Issue: After adding the supplier to a document (object in Documents class), the dot icon does not appear on the Supplier tab.

If there are suppliers associated with a part or part group, when creating a declaration from a part or part group Actions menu, the suppliers from Suppliers tab of the part or part group will be displayed in a drop-down list for convenience. You may select any one of these suppliers or search for and select another supplier in the system.

Part Groups > Parts Tab

A part group’s Parts tab lists all parts and manufacturer parts that have been associated with the part group. This association between part groups and parts is important because some properties
of the part group will be carried over to the associated parts.

Whenever something changes on a part group’s composition through the declaration process, all parts and manufacturer parts on the Parts tab of the part group are also impacted.

You cannot add substances to a part group’s Parts tab, you can add only parts and manufacturer parts. (If your company is set up for “Commodity-only” objects, you can import only items, not manufacturer parts. “Commodity-only” objects can have only parts on the Parts tab. These and other business rules are detailed in Make Available As Attribute and the "Force/Identical" SmartRule (on page 45).)

Conversion Factor – The items and manufacturer parts belonging to a part group have a conversion factor that is used to convert data such as Mass and Substances Content from the part group to its member parts.

To describe how the conversion factor works, let a part group describe a series of cable, made of the same materials and available from supplier(s) in a variety of lengths. The part group contains the data that defines the “unit” length of cable to be 2 feet long. The part group object then lists cables of 2 ft, 6 ft, and 10 ft in length. So, the 2-ft cable has a conversion factor of 1 in terms of its mass and hazardous substances content, the 6-ft cable has a conversion factor of 3, while the 10-ft cable has a conversion factor of 5.

Note Conversion Factor in part groups is a different idea than Conversion Factor in substance groups. See Substance Groups and Conversion Factor (on page 24).

Creating Part Groups in PG&C

Part Groups let users categorize parts for compliance and sourcing processes, and collect information on restricted substances for part groups.

Part Groups can be associated with items – parts and documents – and manufacturer parts. A part group is a way of grouping similar types of parts. By associating each part with a part group, your users can distribute Requests For Information (RFIs) to suppliers based on the part groups they offer.

As with the other PG&C objects, part groups are created and modified in Web Client. You can search for part groups in Java Client, but not create them.

Part Groups can be active or inactive (Lifecycle Phase). Part Groups are not routable, so they do not have workflows (the only routable PG&C object is the Declaration). They are simply used to categorize groups of parts.

To create a part group:


2. In the Type field, select Part Group. (Other types of part group subclasses may also be available.) If conditions discussed above obtain, the Make Available As field may appear, pre-populated according to administrator’s choices.

3. In the Number field, enter the part group name. (The field will change to Name.) The name is not case-sensitive. Click Continue.

   If you click the Continue Creation in Wizard checkbox, you will be able to Continue through all aspects of a part group. If you leave this checkbox blank, you will Finish the object creation.
process, and then you can add to the object by modifying it.

4. Enter General Information about the part group – Description, Mass and unit of measure, Lifecycle Phase, Overall Compliance, and any other **Page Two** information that may be required. Click Next. The Add Content page appears.

5. Click the **Add** button, the Add Content wizard appears. This wizard is used to search for parts and manufacturer parts to associate with your part group. From the returned rows, select and move a part or multiple parts that you want to add to the **Selected** list.

   Click **OK**, then click **Save**. The selected parts are added to the part group.

   You can run more searches to add more parts as appropriate. When you are done adding parts, click Next. The Add Specifications page appears.

6. Use the same set of steps to search for and associate specifications to the part group. When you are done adding specifications, click **Next**. The Add Suppliers page appears.

7. Use the same set of steps to search for and associate suppliers to the part group. When you are done adding suppliers, click **Next**. The Add Attachments page appears.

8. If you want to add attachments, choose from the **Add** menu Files, URLs, or By Search, and navigate to the desired file or URL. When you are finished adding attachments, click **Finish**.

9. When your part group is complete, click **Finish**. The new part group appears with the **General Info** tab selected.

---

**Working with Part Groups**

Below are some tasks involving parts on the **Parts** tab and supplier on the **Suppliers** tab. Also, the mapping feature in **Page Two** and **Page Three** of parts and part groups is discussed.

**Working with the Parts Tab**

**To add a part to a part group:**

1. Open the part group you want to work with, and click the **Parts** tab.
2. Click **Add**. The Add Contents wizard opens in a separate window. From the returned rows, select and move a part or multiple parts that you want to add to the **Selected** list.
3. Click **OK**, then click **Save**. The selected parts are added to the part group.

**To edit a part (item or manufacturer part) on a part group:**

1. Open the part group you want to work with, and click the **Parts** tab.
2. Select the part that you want to edit, then click the **Edit** button.
3. Make the desired changes to the part, then click **Save**.

**To remove a part from a part group:**

1. Open the part group you want to work with, and click the **Parts** tab.
2. Select the part or manufacturer part you want to remove, then click the **Remove** button.
3. Click **OK** on the prompt to complete the removal or **Cancel** to cancel the removal.
Note: When a part is removed from part group Parts table, only the association itself is removed. The mass, specifications, compositions, and corresponding substances that were copied from the part group remain in the part. (Of course, future changes to the part group are not propagated.)

Working with the Suppliers Tab

To add a supplier to a part or part group:
1. Open a part or part group, click the Suppliers tab.
2. Click the Add button. The Add Suppliers wizard opens in a separate window. From the returned rows, select and move a supplier or multiple suppliers that you want to add to the Selected list.
3. Click OK, then click Save. The selected suppliers are added to the part group.

To edit a supplier on a part or part group:
1. Open a part or part group, click the Suppliers tab.
2. Select the suppliers you want to edit, then click the Edit button.
3. Make the desired changes to the suppliers, then click Save.

To remove a supplier from a part or part group:
1. Open a part or part group, click the Suppliers tab.
2. Select the suppliers you want to remove, then click the Remove button.
3. Click OK on the prompt to complete the removal or Cancel to cancel the removal.

Mapping Feature in Parts and Part Groups

The mapping feature is available for use in to Page Two (class-level) and Page Three (subclass level) tabs in items, manufacturer parts, and part groups.

Mapping of attributes is useful for some Page Two/Page Three attributes in parts and part groups. Mapping lets you see some values from the Compliance tab > Compositions table attributes, that is, it distributes changed values on published declarations that are associated with those parts. The administrator may have mapped fields within parts. For example, the administrator has enabled and mapped

```
Declaration > Items > Part (link) > PageTwo > Date05
```
to

```
Part > Compliance tab > Composition > Date02,
```
when you edit this attribute, the new value is published back to

```
Part > Page Two > Date05.
```
Now let us say the supplier alters the \textbf{Date02} field while completing the declaration. When the declaration is returned, released, and the data is published to the system, this new value automatically carries over to

Part > Page Two > Date05.

Note that the mapping works two ways: when adding this item to the declaration, the system pulls the value from the item’s \texttt{Page Two / Page Three} into the declaration’s \texttt{<Parts/PF>} table onto the mapped attribute.

When multiple declarations regarding the same part are sent to different suppliers, the rule in Agile is "Latest Released Wins." This means that the value of a mapped attribute can change if later declarations dictate it.
Chapter 8
Declarations

This chapter includes the following:

- Declaration Workflow and the RFI Process ................................................................. 57
- More About the Declarations Classes ........................................................................... 57
- Tabs and Attributes in Declarations ............................................................................... 59
- Creating Declarations .................................................................................................... 62
- Working with Declarations ............................................................................................ 65
- Routing Declarations ..................................................................................................... 67
- Completing the RFI Process ........................................................................................... 68

Some important aspects of the Declarations classes were introduced in Declarations (on page 57).

A Request For Information (RFI) consists of a material declaration, which lists the parts in a product assembly and shows the substances and materials contained in those parts. It is linked to specifications, which may restrict how much of a particular substance the product assembly may contain. A declaration request can contain multiple combinations of parts and part groups and specifications (or compositions).

Declaration Workflow and the RFI Process

There are seven default classes of declarations, and they all use the default Declarations workflow, which is the vehicle to send Requests For Information (RFIs) to your suppliers. As a routable object, the user’s actions (on either the buyer or supplier side) result in the declaration moving into another status where the next user will act on it.

The user assigned as the “change analyst” of the compliance workflow is called the compliance manager. The compliance manager creates and sends a declaration request to an information supplier. The supplier completes the declaration by providing data statement for each combination of specification and part – the composition.

You may wish to refer to RFI Process in Brief (on page 9). In this sequence of tasks, you have already identified parts/part groups, for which you must seek compliance information, and people, internal and external to your company, who will gather and provide that information.

More About the Declarations Classes

These are additional facts and rules of business logic for the out-of-box Declarations classes.

Supplier Declarations of Conformance

This class of declarations requests statements from suppliers at a supplier level. It is basically a supplier survey. Your company wants to send out a questionnaire and receive a declaration from
the supplier to assess compliance with specifications from customers and government agencies. Typical questions could be: Do you have a RoHS compliance initiative going on? When do you anticipate to have 100% compliant product? Which ISO certifications do you possess. No fields are pre-populated in this declaration. The SDOC does not require association with any items, manufacturer parts, part groups, or even specifications in order to be effective. Adding specifications to this type of class is allowed for reference purposes.

**Japanese Green Procurement Declarations**

This class of declarations is used against the template for the Japanese Green Procurement format. Agile supports only JGPSSI version 2.02. Your company wants suppliers to provide a declaration in the JGPSSI format using the JGPSSI supported entities. No substances from specifications are pre-populated in this declaration.

*Note* Agile has released a Japanese-language template for use in JGPSSI Declarations. See your administrator.

**Part Declarations**

This class of declarations is used to ask questions related to parts or part groups. Your company wants to send out a questionnaire to assess part compliance with specifications from customers and government agencies. Typical questions could be: What is the maximum re-flow temperature of this part? What type of plating is on this part? Is this part in compliance with a certain specification? No fields are pre-populated in this declaration.

An issue has been resolved where it is possible to add any kind of specification to a part declaration, regardless of the Validation Type set for the specification – Part Level or Homogeneous Material Level.

**Substance Declarations**

This class of declarations allows a supplier to respond at a substance-group level and at a substance level without being able to add to the BOS. It could be a material compliance declaration in which your company wants suppliers to declare compliance with specifications at the substance level; or, it could be a partial material disclosure declaration in which your company wants suppliers to disclose the weight and/or concentration of selected (or all) substances that are contained within the components and subassemblies it sources from this supplier.

A substance declaration supports pre-population of substances and substance groups from associated specifications.

**Homogeneous Material Declarations**

This class of declarations allows a supplier to build a BOS consisting of four levels: subpart, homogeneous material, substance groups, and substances. It could be a material compliance declaration at the homogeneous material level, or it could be a partial material disclosure declaration to discover the weight and concentration of substances that are contained within the homogeneous materials. This can be effected through an outside application or spreadsheet. No fields are pre-populated in this declaration.

**IPC 1752-1 and IPC 1752-2 Declarations**

These Declarations classes support compliance work using the IPC forms for substance
declarations (IPC 1752-1) and homogeneous materials declarations (IPC 1752-2). These forms are in Adobe PDF format. Adobe Acrobat 7.0 is the minimal requirement. The website for Adobe Software is www.adobe.com.

IPC Format Version 1.02 Supported in this Release

Agile PLM Release 9.2.2 supports released Version 1.02 of the IPC format. The website for the IPC forms and information about the "1752" standards is www.ipc.org/IPC-175x.

Guidelines for Parts and Specifications on IPC Declarations

It is recommended that each IPC declaration carry just one specification and just one part/part group.

There is no restriction to the number of specifications that can be added to IPC declarations. However, if a declaration carries multiple items, manufacturer parts, or part groups and multiple specifications, Export IPC XML will only export one composition from the declaration’s <Parts/PGs> tables.

Similarly, Import IPC XML will update only one composition, that of the part that was exported. The system identifies this by the part number, rev, and the first specification in the declaration’s Specifications table, which is sorted alphabetically.

<table>
<thead>
<tr>
<th>Note</th>
<th>The XML file generated by Export Data function in the IPC form (PDF) does not include the values from Version and Manufacturing Sites fields.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note</td>
<td>If you create one of the “1752” declarations and name a part/part group whose Name or Number includes square brackets (&quot;[&quot; and &quot;]”), the IPC transformation (through the Excel integration) treats it as a manufacturer part and then it sends an error message that the manufacturer part does not exist in the declaration. You must remove the brackets from the part, manufacturer part, or part group’s Name or Number.</td>
</tr>
<tr>
<td>Note</td>
<td>If an IPC form has an invalid substance with an asterisk in its name, the imported substance’s name is truncated from the asterisk to the end (left-to-right).</td>
</tr>
</tbody>
</table>

Tabs and Attributes in Declarations

Declarations are the “workhorses” of the PG&C solution, carrying many kinds of data and giving that data dynamic qualities as they are published into the product record. This section reviews the basic tabs in declarations and what kinds of information each tab carries.

Many attributes in PG&C appear in several or all of the PG&C business objects, as well as items and manufacturer parts. Because any given attribute may be defined only once in this manual but may not be defined in this chapter, simply search the PDF for the attribute you want to see.

Cover Page

The Cover Page tab provides general information about this object. The declaration’s name, description, supplier, date sent to supplier, and due date are entered when creating the declaration. The Cover Page carries information about the compliance manager and the supplier, including contact users. After the declaration has been created, you can edit this information by choosing the
Edit button in the Cover Page tab.

<table>
<thead>
<tr>
<th>Note</th>
<th>As soon as a part or part group is added to a declaration, the associated supplier cannot be changed.</th>
</tr>
</thead>
</table>

- **Has Invalid Substance** – “No” indicates that there is an invalid substance present. It must be corrected before the declaration can be released.

- **Need Rollup** – A flag indicates if the declaration has been modified since the last time of declaration rollup. So, after an invalid substance(s) is corrected, or Mass (on Parts table) changes, Need Rollup attribute automatically changes to Yes. It is simply an “advisory” field. When the declaration rollup is run, the field reverts to No.

  Note that the Need Rollup field does not change to Yes if a Substance Declaration changes directly from Pending to Released statuses.

- **Supplier** – Unless the administrator has made the Supplier field for the type of declaration you are creating 'Not Required', an Active supplier must be named. The supplier can be a Web Supplier (that is, in Supplier object, Web Supplier field = Yes) or a “non-Web Supplier” (Web Supplier field = No): but a Web Supplier must have at least one associated Contact User, while a non-Web Supplier may be named in the declaration with no associated contact users. It is recommended that declarations name a Web Supplier, as PG&C carries and publishes the most complete information when a Web Supplier with contact users is associated.

  Note If the Supplier field has been made Not Required (by the administrator, for a given class or classes of declaration), you can still add a supplier to the new declaration. However, with Supplier field Not Required, if you create a declaration from a part/PG’s Actions menu, you are not allowed to add a supplier, since from the part’s Actions menu the declaration is created with the part already added (and, as noted above, once a part is added to a declaration, in effect the Supplier field cannot be changed).

**Affected Parts Tabs**

The following chart shows the hierarchy of data about parts and part groups that are contained in most declarations (except, for example, Supplier Declarations of Conformance). Each “affected parts tab” in a declaration has a table listing the Items, Manufacturer Parts, or Part Groups, and a table listing the substances associated with each part (for example, **Substances for Item ABC**):

<table>
<thead>
<tr>
<th>Items tab</th>
<th>Manufacturer Parts tab</th>
<th>Part Groups tab</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items table lists parts and documents on the declaration</td>
<td>Mfr Parts table lists manufacturer parts on the declaration</td>
<td>Part Groups table lists part groups on the declaration</td>
</tr>
<tr>
<td>Substances for Item [listed] table lists substances for each item and its associated specification on the declaration</td>
<td>Substances for Mfr Part [listed] table lists substances for each manufacturer part and its associated specification on the declaration</td>
<td>Substances for Part Group [listed] table lists substances for each part group and its associated specification on the declaration</td>
</tr>
</tbody>
</table>
Parts Tabs Attributes

Many attributes that you see in declarations appear also in parts/part groups. See Tabs and Attributes in Parts and Part Groups (on page 44) for definitions of attributes (or simply search the PDF for a particular attribute name).

- Exemption – There is an Exemption field on a declaration’s <Parts/PGs> tabs. Exemptions are set in a specification’s General Info page (see General Info) (see "General Info Tab" on page 37); the values you see for Exemption on a declaration’s Parts tab are really coming from the associated specification.

Substances for Parts Table

Note that Part Declarations do not have a Substances table.

For each part and part group, the Substances tables list their associated substance composition, providing the part or part group has been associated with substances. You can filter the Substances table to isolate substances for a particular part or part group.

See Tabs and Attributes in Parts and Part Groups (on page 44) for definitions of attributes, such as Threshold Mass PPM, Calculated Mass, Intentionally Added, and so forth.

For more information about compliance rollups, see Rolling Up Compliance Data (on page 81).

Specifications Tab

When adding specifications to a declaration, for every part in the declaration, the system creates “part+spec” combinations, or compositions.

The compliance manager may inform the supplier that the buyer is going to validate the supplier's substances based on the specifications on the Specifications tab. If there are one or more specifications associated with this substance declaration (this type only), the system automatically prepopulates the substances from those specifications for all the items, manufacturer parts, or part groups in this declaration. If there is no specification associated with this declaration, no substance is prepopulated, even for the substance declaration.

The Specifications table of a declaration lists specifications related to the items, manufacturer parts, and part groups contained in the declaration. The purpose of a declaration is to ensure that suppliers comply with any restrictions stated in the specifications. Also see the discussion of Exemptions field in Affected Parts Tabs (on page 60).

The specifications may concern many substances, including those not used by the parts contained in the declaration. When a substance declaration is opened to the supplier, any substances from the specifications are automatically added to the Substances for <Part/PG> tables. This ensures that you are properly tracking any restricted substances contained in parts listed in the substance declaration.

Rules for Synchronizing Declaration Parts Tables and Specifications Table

The notes for the “import” case below are given here (Importing is covered fully in the next chapter) in parallel with working in the object, that is, in Web Client’s user interface.

From the Object in Web Client

- When adding a part: the system creates one compositions for each spec in the declaration for
that part.

- When adding a spec: the system creates one composition for each part in the declaration for that spec.
  - Example: given two compositions, (Item1+Spec1) and (Item1+Spec2), if you remove the second composition, when you add Spec3, the system will create a third composition, namely (Item1+Spec3), and it does not re-create the second composition; therefore, there is no "synch-up" in this case.

From the Import Utility

- When importing a part: if you name a specification along with part, the system creates a composition only for that part+spec combination, and it does not create one composition for each spec in declaration or each spec in the Import file; therefore, there is no "synch-up" in this case.
  - Example: given an Import file with (Item1+Spec1) and (Item2 + no specification), if there are two specifications (Spec1 and Spec2) in the Import file or in the declaration, the system creates the following compositions: (Item1+Spec1), (Item2+Spec1), and (Item2+Spec2).
- When importing a specification: the system creates one composition for that spec for each part in the declaration.

### Workflow Tab

The default Declarations Workflow is used in the RFI processes. The **Workflow** tab of a declaration shows all the statuses the declaration has passed through, and which statuses remain to be completed. It also shows all the approvals and rejections made during each approval cycle. See [Routing Declarations](on page 67).

For more information about using the **Workflow** tab, see the chapter on *Items in Product Collaboration User Guide*. There is also a chapter on workflows in *Getting Started with Agile PLM*.

### Creating Declarations

Compliance managers (an Agile user who has been assigned the Compliance Manager role) can create declarations. (More specifically, a user with a role that has the Create Declaration privilege can create a declaration; Compliance Manager is the out-of-box role with this privilege.) You can create a declaration either through the Create function, or by choosing **Actions > Create Declaration** from within an item or manufacturer part or part group.

By default, the name field uses an Autonumber format with the prefix "MD" (for "Material Declaration"). Although the Autonumber format isn't required, it makes sense to use the same prefix for all declarations to make it easier to search for them. In any case, the name must be unique and it must be upper case (unless the administrator has changed the character set for declaration names and allows mixed case).

When you create a declaration, you must specify a unique declaration name. The requirement that a declaration have a supplier has been removed; but the administrator must have made the field 'not required'. Supplier users with the (Restricted) Material Provider role (and who are not restricted to the Basic supplier interface) can also create declarations: in this case, only the Name attribute is required to create the object (because it is a "Restricted" role); the Supplier attribute is filled in automatically with that user's supplier organization.
Note that some values for contact user fields come from the supplier object while some values come from the supplier user object (the contact users).

Selecting Specifications in the Create Declaration Wizard

Specifications are associated with declarations to provide the basis by which compliance information is specifically requested and, upon completion by the supplier, evaluated by the compliance manager. The declaration’s Compliance tab lists associated specifications.

The create wizard prompts for the selection of specifications to add to the declaration, but the type of specifications that are presented and appropriate to select depend on the type of declaration that is under creation. See the table in Introduction to Declarations (on page 15) for information about which type of specification you can add to each type of declaration.

If no specification is added to the declaration, it should still function. The declaration is then merely a part survey for weight and perhaps PPM information and no longer a request for a compliance statement. Obviously selecting a value in a compliance field has no meaning at that point but the system should still function.

Since there is a limitation between the class of the declaration and the type of specification attached to the declaration, there is no way the user will be able to change the class of a declaration.

Using the Create Wizard

This task steps through the Create wizard to configure a declaration.

To create a declaration:

1. Choose Create > Declarations and select one of the declarations classes. The wizard opens, with Type already specified (unless other types of declaration subclasses for the class that you selected have been created by the administrator, there is only one child subclass for each class of declarations).

2. In the Number field, a Declaration number is automatically generated. Accept or modify this identification.

3. Click to find and select a supplier. You are allowed to select only one supplier per declaration.

Note that when creating a declaration from part or part group Actions menu, if there are suppliers in the part or part group Suppliers tab, those suppliers appear in the dialog; you can either select one of them or search for a different supplier to add to the declaration. When a supplier is added to a declaration, details pertaining to the supplier are added to Cover Page and Page Two fields, provided it is a Web supplier with at least one associated contact user (see following Note).

Note: The requirement that a declaration have a supplier has been removed; but the administrator must have made the field ‘not required’.

Note: PLM also allows declarations to name either kind of supplier: a Web Supplier (Supplier object > General Info tab > Web Supplier field set to Yes) must have at least one associated Contact User; a non-Web Supplier (Supplier object > General Info tab > Web Supplier field set to No) may be named in the declaration with no associated contact users. However, it is still recommended that a declaration name a Web Supplier: PG&C carries and publishes the most useful information if a Web Supplier with associated Contact Users is named; for example, those contact users receive notifications.
If you click the Continue Creation in Wizard checkbox, you will be able to Continue through all aspects of a specification object. If you leave this checkbox blank, you will Finish the object creation process, and then you can add to the object by modifying it.

Click Continue.

4. Enter the general information (Description, Declaration Type, Compliance Manager, Workflow, and Due Date).

It is recommended to always assign a compliance manager. If you do not, when the supplier returns declaration, all compliance managers in the system will be notified. Note that when you select a compliance manager, the values on these attributes are added immediately: Title, Phone, Email, and Fax.

5. You may click Finish at this point, and the declaration will be created. Later you can add parts, manufacturer parts, part groups, and specifications to the declaration.

If you want to add any of these objects during the create process, click Next.

6. On the Add Specifications page, click the Add button, and select By Search or Type in Known Number.

If you select By Search, the Add Specifications wizard appears. This wizard is used to search for specifications to associate with your declaration. From the returned rows, select and move a specification that you want to add to the Selected list.

**Note** There is some restriction on what type of specifications can be added to a declaration. The validation level is displayed in the Add Specification search wizard, and you must select an appropriate specification based on the validation level – Part level or Homogeneous Material level.

Click OK, then click Save. The selected specification is added to the declaration.

You can run more searches to add more specifications as appropriate. Depending on how many specs are added, that many records or entries will be created for each part or part group that is added to the declaration.

When you are done adding specifications, click Next. The Add Items page appears.

7. Use the same set of steps to search for and associate items (Agile parts or documents) to the declaration. When you are done adding parts, click Next. The Add Manufacturer Parts page appears.

8. Use the same set of steps to search for and associate manufacturer parts, and then part groups, to the declaration. When you are done adding manufacturer parts and part groups, click Next. The Add Attachments page appears.

9. If you want to add attachments, choose from the Add menu Files, URLs, or By Search, and navigate to the desired file or URL. When you are finished adding attachments, click Finish.

10. When your declaration is complete, click Finish. The new declaration appears with the Cover Page tab selected.

**Note** If you have added m number of specifications and n number of parts, you will create \((m \times n)\) compositions in the declaration Parts table, and each of these compositions has its own set of substances that are governed by the threshold defined in specification for that composition.

Pre-population of substances occurs only when there is a specification present and only for Substance declarations. If you do not associate any specification to a Substance declaration,
no substances are pre-populated to the declaration.

Working with Declarations

The chapter on Substances introduced the elements of substance validation and correction – such things as the Alias field, Mass Disclosure, and the effect of the Mass Tolerance Percentage setting (set in Administrator). Here are a few points about how substance validation impacts declarations.

Invalid Substances in the Declaration

When suppliers respond with substances for a part, they probably do not know anything about how substances are declared in the customer's system. Use of the Alias field in substances in the buyer's system allows any substance to be introduced into the declaration and the compliance manager does the “clean-up”; the supplier can submit their information faster, which encourages completion of declarations.

Restriction about Invalid Substances in Declarations

When the declaration contains substances or substance groups that do not exist in the system (invalid substances that are not “aliased”), you cannot perform a rollup from the declaration’s Actions menu, nor does the system automatically perform a rollup on change status of the declaration. User has to clean up all the invalid substances in order to be able to perform rollup.

If there are invalid substances or substance groups, the system does allow you to manually change status except to the Released status. If there is even one invalid substance, the system will not allow the declaration to advance to Release; there is a message on the declaration to indicate this.

---

**Note** Materials and Subparts that do not exist in the buyer’s system can come into a declaration, and it can still be released: so, to distinguish, we refer to these as "local substances." But Substances and Substance Groups (that are not aliased or do not exist in the buyer’s system) can block the declaration from being Released, so the uncorrected substances/substance groups are particularly called "invalid substances."

Action > Verify Substances

Verify Substances is enabled on a declaration’s Actions menu when there is an invalid substance present, often the result of a naming problem. (Also, it is enabled only when the user (including supplier user) has the privilege to change the status of the declaration.) Clicking Actions > Verify Substances brings up a popup with these fields:

- User-entered Substance or Substance Group
- User-entered CAS number
- A drop-down list of matching substances/substance groups that match the CAS number; the system does not attempt to match a user-entered substance name
- Icons for Creating a substance object and for Searching for an existing substance.

Working with the Part Tables

The various part and part group tabs in a declaration work similarly to add, edit, and remove parts.
For information about importing substances or compositions into parts, see [Importing Compositions into Items and Manufacturer Parts](on page 71).

These are two general methods to add substances to parts and part groups:

1. When a declaration is released, the specifications and substances from the declaration are published to its parts.
2. When a part is associated with a part group, then any specifications, compositions, and substances from the part group are copied to the parts (with the conversion factor that was provided).

Remember that when adding `<parts/PGs>` to a declaration, if the declaration already contains specifications, PG&C will create part+spec combinations – compositions – for each specification in the declaration.

**To add a part or part group to a declaration:**

1. Open the declaration, click the specific `<Part/PG>` tab for the type of part/PG you want to add.
2. On the `<Part/PG>` table, click the `Add` button, the “Add `<Part/PG>`” wizard appears. This wizard is used to search for parts to associate with your declaration. From the returned rows, select and move a part or multiple parts that you want to add to the `Selected` list.
   
   Click OK, then click Save. The selected parts are added to the declaration.

   You can run more searches to add more parts as appropriate.
3. When you are done adding parts, click Finish.

**To edit a part or part group on a declaration:**

1. Open the declaration, click the specific `<Part/PG>` tab for the type of part/PG you want to edit.
2. On the `<Part/PG>` table, select the row of the part you want to edit, then click `Edit`.
3. Make the desired changes to the part, then click Save.

**To remove a part or part group from a declaration:**

1. Open the declaration, click the specific `<Part/PG>` tab for the type of part/PG you want to remove.
2. On the `<Part/PG>` table, select the parts you want to remove, then click `Remove`.
3. Click OK complete the removal or Cancel to cancel the removal.

**Working with the Part Substances Tables**

The `Substances for <Part/PG>` tables on the `<Part/PG>` tabs of declarations are Read Only from the user interface. The only way to add substances to the `Substances for <Part/PG>` tables is by Process Extensions, by implementing the Excel integration or, for IPC declarations, by using XML-based integration; see [Importing and Exporting Declaration Data](on page 77).

**Add/Update with Import**

In a declaration `Substances` table, if Add/Update mode is being used, when there is something wrong in the data being imported, the system only deletes compositions that have issues. Previously, if there was a problem in the Import file, the system would delete all substances for all items in the
declaration, even previously imported substances. Substances that have already been imported successfully are not deleted.

Routing Declarations

The Default Declarations workflow follows a straightforward process flow, as detailed in the following table.

Release 9.2.2 now permits customized workflows to be sent to suppliers. See your Agile administrator.

<table>
<thead>
<tr>
<th>Status</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pending</td>
<td>Compliance manager (an Agile user who has been assigned the Compliance Manager role) creates a new declaration, or modifies an existing declaration by adding new items, manufacturer parts, or commodities. Specifications are added to the declaration, and also an information supplier; there is always only one supplier per declaration.</td>
</tr>
<tr>
<td>Open to Supplier</td>
<td>The declaration requests the supplier (an Agile user who has been assigned the Material Provider role) to confirm whether parts comply with specifications. For more information about creating and managing suppliers, see Managing Your Suppliers (on page 97).</td>
</tr>
<tr>
<td>Submit to Manager</td>
<td>Supplier confirms or denies that the parts that they supply comply with regulations. The supplier electronically “signs” and submits the declaration back to the compliance manager.</td>
</tr>
<tr>
<td>Review</td>
<td>The compliance manager and other reviewers verify and approve the contents of the declaration.</td>
</tr>
<tr>
<td>Released</td>
<td>The compliance manager releases the declaration, thereby publishing the new data about the substances and materials into the product record. Once published, the materials are visible on the Compliance tab of the part or part group, as appropriate. The “buyer” company can now examine the quantities of all materials in a given top-level assembly and find out if the assembly is compliant with a set of specifications.</td>
</tr>
<tr>
<td>Implemented</td>
<td>Once the parts are manufactured and disseminated in the field, the compliance manager implements the declaration, thereby completing the workflow.</td>
</tr>
</tbody>
</table>

For more information about workflows and customizing workflows (including how to add and remove approvers and observers), see Routing Objects with Workflows section of Getting Started with Agile PLM.

Once a declaration is opened to a supplier, only the supplier’s contact users can edit it (that is, Agile users assigned the Material Provider role). For other users, including the compliance manager, the declaration becomes read-only until it is returned by the supplier (unless, as always, the behavior of the workflow has been modified by the administrator).

Note A released declaration is not set back to Pending status if one of the approvers rejected it and the workflow has a rule that says “If rejected, set to Pending.”

Notifications when Declarations Advance to and from Supplier

This set of default behaviors regards automatic notifications, not user-designated Approvers and Observers.
- **Declaration Buyer to Supplier** – The notification is automatically sent to the “default recipient” on the RFx Routing tab of the Supplier. Although this notification is sent only to the default recipient, other users in the supplier company with Material Provider role can respond to the declarations as well.

- **Declaration Supplier to Buyer** – The compliance manager is automatically added to the notification list. If no compliance manager was selected, the system add everyone on the Compliance Managers notification list.

- **Declaration Supplier to Buyer** – If there are no compliance managers in the system, the originator is added to the notification list.

**Information Supplier Fills Out a Declaration**

This manual has more information about suppliers in Chapter 11, “Managing Your Suppliers.” The PG&C Supplier Guide is written to suppliers and documents the supplier experience in the PG&C solution.

When a declaration request is opened to an information supplier, the supplier is responsible for completing the declaration and disclosing if any restricted substances are contained in the components and subassemblies it provides and whether those substances comply with specifications.

To complete and sign off on declarations, one or more contact users for the information supplier must be assigned the (Restricted) Material Provider role. If you have questions about who in your supply chain has been assigned this role, see your administrator.

The information supplier–user should do the following to complete a declaration:

- For each part, manufacturer part, and part group, fill in the Mass, Mass PPM, and Compliance fields, particularly for substances that are restricted by specifications
- Add or remove substances from the Substances tables (under the Items, Manufacturer Parts, and Part Groups tabs) on the declaration as necessary; to do this, they must use process extensions (Export AXML and Import AXML) or the Microsoft Excel-based Client
- Complete other flex fields on the <parts/PG> tables as well as the <parts/PG> Substances tables.

For detailed tasks about adding, removing, and editing data on declarations, see Tabs and Attributes in Declarations (on page 59).

When the material provider changes the status of the declaration from Open to Supplier to Submit to Manager, he must “sign off” the declaration.

**Completing the RFI Process**

Once the compliance manager has received, reviewed, and approved the content of the declaration, he advances the workflow to the Released status, and the new data about substances and materials are automatically published to Agile PLM. Once published, the materials are visible on the Compliance tab of the part or part group, as appropriate.

The “buyer” company can now examine the quantities of all materials in a given top-level assembly and find out if the assembly is compliant with a set of specifications by running compliance rollups.
See Rolling Up Compliance Data (on page 81).

Notes on Excel-based Declaration Submissions

When the supplier has used the Microsoft Excel-based Client to submit the declaration, it is possible that data may not be successfully imported to the buyer side. There are two stages in which their data is processed. The data is uploaded to the server; upon successful upload, the supplier receives the message that “Your data has been submitted for processing.” The data is then be processed on the server and imported into the system.

If there was a problem with the upload, the supplier is notified immediately; but if the problem occurs at processing or importing on the server side, the system sends an email with the error log as an attachment to the supplier. This means that the declaration remains in Open to Supplier status, and this does not change until the supplier reviews the log in the email notification, makes appropriate changes, and re-submits.

Even if the import on the server side is successful, depending on the size of the declaration, it will take some time for the declaration to move from Open to Supplier to Submitted to Compliance Manager. So if the user checked the declaration immediately after submitting from Excel, they may not see the changes for awhile.

These “under the hood” behaviors are detailed so that you can instruct your suppliers.

Reviewing and Publishing a Declaration

Once a declaration is released, it is automatically published. When a new declaration is published, it overwrites substances from previously published declarations.

If the substance data on an item’s or manufacturer part’s Compliance tab is from a declaration, you cannot modify it except through another declaration.

When a declaration is released for an part or part group:

- The composition appears in the Active Declarations table in the part’s Compliance tab.
- If a matching active composition exists (same supplier + same spec), then the previous composition is moved to Historical Compositions table and the new one becomes active.
Chapter 9

Importing and Exporting Data in PG&C

This chapter includes the following:

- Importing Compositions into Items and Manufacturer Parts................................................................. 71
- Importing Specifications to Specific Revisions of Items................................................................................... 75
- Importing and Exporting Declaration Data....................................................................................................... 77

Importing Compositions into Items and Manufacturer Parts

You can import compositions and substances directly into items and manufacturer parts without having to go through the RFI process (that is, data added via released declarations). For items, the import is “Change Number–specific,” that is, associated with the Change Number of the part or document. Compositions are generally imported via: Item > Compliance tab > Compositions table, or Manufacturer Part > Compliance tab > Compositions table.

You may need to quickly gather compliance information for manufacturer parts; you may already have the data in spreadsheet form; or, the data could be available on the website of an information supplier or other third party. Your company could use Agile Product Interchange to retrieve substance data from external sources, such as Part Miner or Total Parts Plus.

Importing compositions and substances requires the ability to create aXML files. You must create aXML-format files with composition and composition substances, then use Agile Import to import the compositions and composition substances into the system.

These Agile documents (available on the Agile Documentation website) will guide you with Product Interchange or Import/Export, so you can perform the necessary tasks for importing compositions to items or manufacturer parts:

- Using the Import and Export tools: Agile Import & Export Guide

In the case of integrations with Part Miner or Total Parts Plus, Agile Product Interchange can be used to pull data from these content providers and create the aXML file and then import it into the PLM system.

Note While Product Interchange supports direct import of compositions into manufacturer parts, it does not support direct import of compositions into items in this release. All content providers have data only for legal manufacturer parts. Since items are “custom parts” that are most likely known only to the company that created them, content providers will not have compliance information about those items.

Substances are also imported into a declaration when it is submitted from a supplier using the Microsoft Excel-based Client, and when the declaration is published, the substance is published to the item or manufacturer part.
Note When importing a composition or multiple substances, if there is a problem with the composition or Bill of Substances, the entire composition is rejected. When importing multiple compositions, if there is a problem with one of the compositions, only that composition and corresponding BOS are rejected; the rest are accepted.

Change-based Revisions on the Item

These statements refer to two subclasses in the Changes base class: Engineering Change Orders (ECOs) and Manufacturer Change Orders (MCOs). An “ECO-based revision on the item” simply means the revision of the item was created by a change order being approved and released.

PG&C supports only ECO-based and MCO-based revisions on the item. For example:
- You can add specifications only on ECO- or MCO-based revisions of the item;
- You can import of compositions only on ECO- or MCO-based revisions of the item;
- When adding items to a declaration, only the Introductory rev or an ECO-/MCO-based revision of the item can be added;
  - Furthermore, when adding or importing an item without rev information, the latest ECO- or MCO-based change of the Latest Released rev of the item is added to the declaration;
  - Also, if the rev is provided, the Latest Released ECO- or MCO-based change of that rev of the item is added to the declaration.
- When creating a change on an item other than an ECO or MCO, the system does not copy over the specifications and active compositions from Latest Released rev;
- You cannot access Actions > Create Declaration from an item rev that was not created by an ECO or MCO.

Importing Compositions to Items

All necessary attributes in the Item > Composition and Item > Substances tables can be modified through Agile Import, not the user interface:
- Through Tools > Import;
- Only aXML format is supported for importing, not CSV, Excel, Template or PDX formats;
- The same aXML file can have multiple items and each item can have multiple compositions.

Change Number in an Item

Importing compositions to items (new in Rel. 9.2.2) is quite similar to importing composition to manufacturer parts (introduced in Rel. 9.2.1). The only difference is that the item-import uses the internal Change Number, which is contained in the aXML file with the <Change Number> tag and is how the system recognizes the revision. The Change Number identifies the Pending, Previously Released, or Latest Released revs of the item. The revision number <ItemRev> tag in the Import file is ignored when importing compositions, specifications, and suppliers into items. If the change number is not given, the system uses the latest ECO- or MCO-based change on the Latest Released rev of the item.
Note: You must use “Introductory” when attempting to import compositions, suppliers and specifications into the Introductory rev of the item.

Also note that adding items to declaration does not work based on change number. (See Importing and Exporting Declaration Data (on page 77).) Adding items to a declaration is still based on its revision, not on its change number. That means when adding items into declaration, the Import file (in aXML) still needs to have the <ItemRev> tag. Based on the revision number, the system determines the Latest Released ECO- or MCO-based change for that rev of the item and adds it to the declaration.

Rules when Importing Compositions into Items

You must specify the Change Number for the item in the Import source file. The Change Number is only in an MCO or ECO.

If you do not have a <ChangeNumber> tag for the item in the source file, or leave the <ChangeNumber> tag blank, it will import to the Change Number of the Latest Released rev (again the Change Number can be an MCO number or an ECO number). If there is no Released change for this item, the composition is imported to the Introductory rev of the item.

In the Import wizard, you are not allowed to select both BOM/AML/Attachment and Composition/Spec/ASL checkboxes.

Import Preferences “Business Rule Options” should be set to “Authoring” when importing Composition/Spec/ASL to items.

Import Preferences “Multi-Row Update Mode” (Add/Update or Complete Replace) does not mean anything for importing compositions to items or mfr. parts.

Change Number selected in Import Preferences does not affect importing Composition/Spec/ASL to items, since Import will use the Change Number specified in the source file.

Change order selection on the Import wizard’s Mapping step has been removed for importing Composition/Spec/ASL to items, since Import will use the Change Number specified in the source file.

The Add/Update mode is not valid when importing compositions and substances, but it is valid when importing specifications and ASL.

Rules when Importing a Composition into Items or Manufacturer Parts

If you import multiple compositions (with substances) for a single part in a single Import file, any error with one composition (or one of its substance) will cause the rejection of that particular composition (and its substances); however, the system continues to import other compositions to that part.

If you import multiple compositions (with substances) for multiple parts in a single Import file, any error with one composition (or one of its substances) will cause the rejection of that particular composition (and its substances); however, the system continues to import other compositions to that part (that did not receive the composition with the error) as well as the other parts.

The above-mentioned error could be any error – either an invalid substance or an invalid entry in one of the list fields – all of them are treated the same.
Notes and Special Cases of Importing Compositions

A specification name in a composition is optional. If a specification is provided in the Import file, it is added to the manufacturer part’s Compliance tab > Specification table.

After importing a composition into an item or manufacturer part, the system sets the specification’s Need Compliance Check field in the Specifications table to Yes. Also note that, due to the introduction of Fully Disclosed compositions in Rel. 9.2.2, when importing a composition with or without specification, Need Compliance Check on all the specifications on that item or manufacturer part is set to Yes.

If a manufacturer part is associated with a part group, you cannot import compositions into the manufacturer part. You would have to create a declaration for the part group and bring substances to the manufacturer part via a released declaration.

When importing compositions into an item or mfr. part, if you didn’t provide mass at the composition level, the system copies the mass information from PageOne to the composition, and then uses it for composition rollup.

When importing compositions into an item or mfr. part or when importing the BOS into a declaration, all types of errors are treated the same; previously the system continued to import partial data on certain types of import errors.

When importing compositions directly into a mfr. part, the system does not accept partial data. If there is any type of error, the system rejects the composition along with the BOS.

When importing the BOS into a declaration for parts and part groups, where there is any type of error, the system rejects the complete BOS for that part. (It used to be that, for certain type of errors, the system ignored and accepted a partial BOS, which was not correct).

When importing compositions directly into an item or mfr. part, the Mass from PageOne is used if the Mass on the composition is blank. Moreover, the Mass from PageOne is copied to the composition if it was blank during import.

When importing compositions directly into an item or mfr. part., you cannot import a BOS with substances and substance groups that do not exist in the system.

Importing a composition directly into an item or mfr. part is considered equivalent to publishing the composition to the product record by releasing a completed declaration. Therefore, the system does not allow importing substances and substance groups that do not exist; first there must be substance correction (of name, or creating a new substance in the system) or substance aliasing. (The concept of invalid substances and substance groups only supported in declaration.) When directly importing compositions into item or mfr. part and using a substance alias, the system automatically converts that alias to the corresponding substance / substance group name.

Importing substances and substance groups that do not exist in the system is allowed in the declaration; you must map these invalid substances and substance groups with an Alias to an existing substance or substance group or create a new substance or substance group, otherwise, the system will not allow you to release that declaration. In short, compositions with invalid substances cannot be published to the product record.

These ideas are stated somewhat differently in Invalid Substances in the Declaration (on page 65).
Sources of Compositions

There are now several sources of compositions. To identify the source, an item, manufacturer part, and part group’s Compliance tab > Compositions table has a field called Source. The following table gives an overview of sources of compositions and possible values for various fields of the Compositions table.

<table>
<thead>
<tr>
<th>Composition source</th>
<th>Value in Source field of Composition table</th>
<th>Value in Supplier field of Composition table</th>
<th>Value in Composition field of Composition table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publication of a declaration</td>
<td>String “Declaration” (class name in metadata)</td>
<td>Name of the supplier (link to supplier object)</td>
<td>Identifier of the declaration (link to declaration object)</td>
</tr>
<tr>
<td>Publication from a part group</td>
<td>String “Part Group” (class name in metadata) concatenated with identifier of the specific part group, for example, “Part Group XYZ”. This value does not change if name is changed.</td>
<td>Name of the supplier on the part group declaration (link to supplier object)</td>
<td>Identifier of the part group declaration (link to declaration object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Blank if the composition on the part group did not come from a declaration but, for example, from an import procedure.</td>
<td>Blank if the composition on the part group did not come from a declaration but, for example, from an import procedure.</td>
</tr>
<tr>
<td>Revision change</td>
<td>String “Rev” concatenated with the identifier of the previous revision. Once the Source field is set, a change to the rev number does not change this value.</td>
<td>Name of the supplier on the declaration (link to supplier object)</td>
<td>Identifier of the declaration (link to declaration object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Blank if the composition on the previous rev did not come from a declaration but, for example, from an import procedure.</td>
<td>Blank if the composition on the previous rev did not come from a declaration but, for example, from an import procedure.</td>
</tr>
<tr>
<td>Import of a composition</td>
<td>The value is set in the Import file, or is “Import” if the field is blank.</td>
<td>The value is set in the Import file or Blank (link to supplier object)</td>
<td>Blank</td>
</tr>
</tbody>
</table>

**Note**  
When doing a SaveAs on a part or part group, the system copies the specifications, but not compositions.

Importing Specifications to Specific Revisions of Items

Agile PG&C supports the integrity of item revisions when importing (associating) a specification to the item.

- When you import a specification, supplier, or composition (with BOS), the import is based on the Change Number and it can be imported to any rev of the item when the ChangeNumber is provided in the Import file.
When you remove a spec from an item, it is only removed from the specific rev.

When the compliance manager publishes a declaration, at that time the system not only copies the composition from the declaration to all associated items, it also takes the specs in the declaration and adds them to the Specifications table on the items. Previously, when the declaration was released, specifications would be added to all revisions of the item; now, it is added only to the rev of the item that was named in the declaration. (See A Difference with Part Groups below.)

A Difference with Part Groups

There is a difference in behavior between part groups and items: when you add an item to a part group, the system adds the specifications and active composition in the PG to all Pending revs and Latest Released rev of the item. In distinction, when you publish a declaration, PG&C publishes only to the rev of the item that was added; so, if you added Rev A of an item to a declaration and then released that rev, the spec and composition will only go to Rev. A. Even if you have created Revisions C, D, and E, the system does not copy composition to these revs.

The reason for this distinction is because the work objectives of Change Managers and Compliance Managers may differ. The Change Mgr. may continue to create new changes for revisions to parts; whereas, if the Compliance Mgr. gets Rev. A and sends it to an information supplier in a declaration, when it comes back from the supplier and is released, it makes sense that the composition only applies to Rev. A, because that is what the supplier declared to.

So this is something to be known about part groups: when a declaration is released, the composition goes to the particular rev of the item that was added, whereas if you add an item to a part group, at that time the system copies the compositions and the spec from the PG into all Pending and Latest Released revs of the item. This behavior applies to part groups but not items or manufacturer parts.

Changes when doing a CSV/Excel Import of a Specification to an Item

Prior to Rel. 9.2.2, specifications were independent of item revs, but some attributes (say, Declared Compliance) that pertained to the item’s Specifications table were specific to the revision. So, if you imported a specification called SP-1 as Compliant to Rev B of an item, SP-1 would be added to Revs Preliminary, A, and B. However, in this case the spec is compliant only for Rev B and not for other revisions. In 9.2.2, the system behaves in this way:

- When you add a specification to a rev manually (through the object), that specification is specific to that rev. The specification is not be added to other revs (Previously Released or Preliminary or Pending). So, only that rev would be flagged as Need Rollup.

- When you creates a new change (ECO or MCO), the system copies over the specifications from the previous rev to the new Pending rev. This is similar to the way the system copies the composition. Note that the system will copy over the specifications only when a new change order is created from a previous rev. If the change already exists and if a previously released rev gets a new specification, that spec is not copied to the next rev.

- When a declaration is published, the specification shall be published only to the rev that is associated with the specification in the item.

- When an item is added to a part group with specifications, the specs from the part group are copied only to the Latest Released rev and all Pending revs of the item.
Importing and Exporting Declaration Data

Generally, exporting and importing data from declarations is handled by process extensions, which appear in the Actions drop-down menus.

Declarations Actions (Process Extensions)

Assuming the administrator has assigned out-of-box process extensions (PXs) to PG&C declarations, they contain these class-specific actions:

<table>
<thead>
<tr>
<th>Additional Actions</th>
<th>Found in objects from these classes</th>
<th>Result of this action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open in Excel</td>
<td>JGPSSI Declarations class</td>
<td>Open in Excel – This action activates the Microsoft Excel-based Client and opens the JGPSSI template in Excel</td>
</tr>
<tr>
<td>Export JGPSSI</td>
<td></td>
<td>Export JGPSSI – This action exports data to a text file in JGP Block format for integration with the JGPSSI Excel template</td>
</tr>
<tr>
<td>Import JGPSSI</td>
<td></td>
<td>Import JGPSSI – This action imports data from a text file in JGP Block format for integration with the JGPSSI Excel template</td>
</tr>
<tr>
<td>Import AXML</td>
<td>Homogeneous Materials Declarations class</td>
<td>Export AXML – “AXML” is Agile XML, an XML representation of Agile’s business schema that contains all product content managed in Agile. You or a supplier use it to export the declaration information in aXML format. The declaration can be completed and re-imported into PLM.</td>
</tr>
<tr>
<td>Export AXML</td>
<td>Part Declarations class</td>
<td>Import AXML – A declaration that was exported using the aXML format and then completed can be imported back into PLM using this action.</td>
</tr>
<tr>
<td></td>
<td>Substance Declarations class</td>
<td></td>
</tr>
<tr>
<td>Import IPC XML</td>
<td>IPC 1751-1 Declarations class</td>
<td>Import IPC XML – Imports XML data that is used to complete IPC forms</td>
</tr>
<tr>
<td>Export IPC XML</td>
<td>IPC 1752-2 Declarations class</td>
<td>Export IPC XML – Exports XML data that is used to complete IPC forms</td>
</tr>
</tbody>
</table>

**Note**
Files older than two days (48 hours) are purged from the directory (the AgileEITemp folder on the server) every time these Actions are executed: Import AXML, Import JGPSSI, Import IPC XML, or Submit from Excel through the Microsoft Excel-based Client; this is not configurable.

**Note**
If you export a declaration, let’s say, MD-1 using Export JGPSSI, and you open MD-2 using Open in Excel, the JGP file that was exported for MD-1 can be imported to a JGPSSI Excel document (which was opened for MD-2) and submitted. The data will be updated in MD-1, which will move to the next status in the workflow.
Importing and Exporting IPC Declarations

This task outlines how you could send an IPC declaration that you have created in Agile, while the supplier completes the declaration working in the IPC pdf format.

A typical RFI sequence with an IPC declaration:

1. You create an IPC declaration in Agile PLM.
2. The default workflow for the declaration is moved to the Open to Supplier status.
3. The contact user for the information supplier opens Web Client (Basic) and sees the declaration. The supplier could simply open the declaration in Agile. Your administrator’s setup of PG&C also presents an alternative, via the process extension Export IPC XML; this appears as a link in the declaration row that the supplier can click directly (or, if the supplier clicks the declaration name, all the process extensions are displayed as links on the left navigation pane of Web Client (Basic mode). An XML file is saved.
4. The IPC form is found on the machine – the supplier user will have IPC pdf forms downloaded from IPC web site (www.ipc.org/IPC-175x) – in an IPC folder. The supplier user opens the form in Adobe Acrobat and clicks Import Data (or File > Form Data > Import Data to Form), then specifies the location of the XML file. The XML data is imported to the PDF form.
5. The supplier user enters or modifies values in the declaration.
6. When completed, the data is exported using Export Data (or File > Form Data > Export Data from Form). The existing XML file is overwritten.
7. The supplier returns to Web Client and uses the Import IPC XML process extension to import the modified XML data. Then he submits the declaration to the buyer firm.
8. At the buyer site, you can open the completed declaration in Agile to review for possible release.

Note For the out-of-the-box IPC integration (which supports only one part / one spec per declaration):

Regardless of what type of part (item, manufacturer part, or part group) is used in the declaration, Export IPC XML exports the value to the Item Number field in the IPC form (PDF). If you want to change this behavior, please work with your Agile Solution Delivery representative.

If your company is creating declarations only for (compliance information about) manufacturer parts, we recommend hiding the Items and Part Groups tabs in the IPC declarations (that is, set the Visible property to No), making it easier for suppliers to be clear on the fields they need to complete.

This sequence is an outline. Agile PLM Import & Export Guide fully documents the use of the Import/Export tool.

Correcting Invalid Substances

Click the Verify Substances global action under Declarations to verify the invalid substance, check the pop-up user interface, including columns, and icons.

Or, verify substance by clicking Search icon, Create icon, or the drop-down list of matching substances/groups with exact CAS number.
For more information, see Invalid Substances in the Declaration (on page 65) and Unreported Substances in Partially Disclosed Compositions (on page 30).
Rolling Up Compliance Data

This chapter includes the following:

- Overview to Compliance Validation
- Compliance States
- Bill Of Substances (Composition) Rollup
- Bill Of Materials (Compliance) Rollup
- Substances and Weights Rollups using Excel Integration

Overview to Compliance Validation

When compliance data has been gathered for items, manufacturer parts, and part groups, the compliance manager reviews the completed declarations; he needs a way to determine if they are ready for publication into the product record. And, after declarations are published, with their data written through to parts and part groups on BOMs, compliance managers need to examine and test BOMs to ensure that the assemblies and products are compliant.

This general process is called compliance validation, and the mechanics of compliance validation are fulfilled through compliance rollups. Rollups are built into the system, and they are a powerful feature of the PG&C solution.

Rollups are easy to execute and rollup results are seen in the user interface; understanding rollups and interpreting rollup results is the subject of this chapter. The business logic of rollups that is programmed "under the hood" is extensive; details of the logic and some use cases are found in Appendix A, "Internal Logic of Compliance Rollups."

Current rollup information is always available from the BOM Compliance report. For more information about setting up this report, see BOM Compliance Report (on page 107).

Use Cases

The term "compliance rollup" can be used in a general sense to refer to compliance validation, but Agile PG&C offers several specific rollups named by their use cases: the BOS or Composition rollup, the BOM or Compliance rollup, and the Substances and Weights rollup:

- **BOS or Composition rollup** – Produces the compliance of a composition against a given specification on a declaration. BOS rollups occur automatically when the declaration workflow’s status changes, except when moving from Pending to a non-Released status. Also, when a composition is imported into an item or manufacturer part, a rollup is triggered. BOS rollups are discussed in Bill Of Substances (Composition) Rollup (see "Bill Of Materials (Compliance) Rollup" on page 89) on and further detailed in Internal Logic of BOS/Composition Rollups (on page 113).

- **BOM or Compliance rollup** – Produces the compliance of a part or part group or assembly against a given specification. BOM rollups can be enacted at any time via manual rollups; the
information is also refreshed throughout the system via scheduled rollups set by the administrator. (Settings in Administrator also govern the overall strictness of BOM rollups.)

BOM rollups are discussed in Bill Of Materials (Compliance) Rollup (on page 89) and further detailed in Internal Logic of BOM/Compliance Rollups (on page 116).

- **Substances and Weights rollup** – Offers a special focus of “worst-case” compilation of weights of all substances in a top-level assembly for a given specification.

While the BOS and BOM rollups take place “within” the Agile system, the Substances and Weights rollup is activated by the Rollup in Excel process extension. This Action takes the user to a template in the Microsoft Excel-based Client, which must be set up by the administrator in order to access.

Substances and Weights rollups are discussed in Substances and Weights Rollups using Excel Integration (on page 93) and further detailed in Internal Logic of Substances and Weights Rollups (on page 117).

### Declaration Classes in Rollups

Let us review the Declarations classes from the point of view of compliance rollups. Remember that a rollup is possible only when a specification is associated in a declaration; compliance states are always calculated in the context of a specification; so we say “rollups are by spec.”

<table>
<thead>
<tr>
<th>Declaration class</th>
<th>Kind of specification</th>
<th>Kind of substance held</th>
<th>Kind of composition produced by declaration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Part Declarations</td>
<td>Any</td>
<td>N/A</td>
<td>Part composition</td>
</tr>
<tr>
<td>Substance Declarations</td>
<td>Part-level specifications</td>
<td>Substance groups and substances</td>
<td>Substance composition</td>
</tr>
<tr>
<td>JGPSSI Declarations</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IPC 1752-1 Declarations</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Homogeneous Material Declarations</td>
<td>Homogeneous-material–level specifications</td>
<td>Subparts, materials, substance groups, and substances</td>
<td>Homogeneous material composition</td>
</tr>
<tr>
<td>IPC 1752-2 Declarations</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Supplier Declarations of Conformance</td>
<td>Because SDOCs do not hold parts or substances, no rollups are necessary.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### When and Why Rollups are Run

Rollups may be able to be started automatically or manually. Automatic rollups are scheduled by settings by the administrator, apply to all parts and part groups that qualify (see next section), and they are triggered to start per the information in the scheduler. Manual rollups are started by a user within a single declaration or part.
## Use case

<table>
<thead>
<tr>
<th>Use case</th>
<th>How rollup is started</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOM/Compliance rollups</td>
<td>Automatically</td>
<td>Per the schedule set by the administrator.</td>
</tr>
<tr>
<td></td>
<td>Manually</td>
<td>In parts and part groups on the Compliance tab, Calculate Compliance button is enabled when compliance data is present (assuming the corresponding Specifications table is not empty).</td>
</tr>
<tr>
<td>BOS/Composition rollups</td>
<td>Automatically</td>
<td>Within declarations whenever the declaration changes status (except from Pending to non-Released status). Also, at the end of importing compositions into items or manufacturer parts, system starts the rollup.</td>
</tr>
<tr>
<td></td>
<td>Manually</td>
<td>Declaration's Actions menu includes Calculate Compliance.</td>
</tr>
<tr>
<td>Substances and Weights rollups</td>
<td>Manually</td>
<td>Part's Actions menu includes Rollup in Excel. The rollup is fulfilled by the Agile &gt; Run Scenario command in the integrated Excel spreadsheet. Note that Rollup in Excel may appear in the menu but the system goes to Excel only when compliance data is present in the part.</td>
</tr>
</tbody>
</table>

Scheduled rollups are important because of the possibility of changes to compliance objects by other actions and events across the product record.

For example, the system does not flag an assembly with the Need Rollup flag every time there is a Product Collaboration–related changes (such as adding a new item or manufacturer part to the BOM, removing an item or manufacturer part from the BOM, and so forth): this is really not feasible as that would force the system – every time the slightest change took place in the product record – to find all TLAs and set Need Rollup to Yes, even if the change was not compliance-related.

It is far more efficient to have the Scheduled Rollups regularly refreshing compliance states on assemblies that are marked (as Shippable Items) to account for pertinent, compliance-specific changes to the products. In summary, regardless of any changes to parts and assemblies, the system goes ahead and calculates compliance based on administrator-set Compliance Rollup Scheduling rules.

### Parts Qualifying for Scheduled Compliance Rollups

For scheduled rollups, there are several factors that “qualify” parts and part groups to be rolled up, that is, examined by the system for compliance. This can be thought of as occurring in two stages:

#### Stage 1 – Perform Compliance Rollup on Shippable Items:

1. All parts with Shippable Item flag set to Yes – this includes top-level assemblies (TLA), subassemblies, and leaf items (the last part of a branch in the BOM). Although we recommend setting the TLA for the assemblies, it is possible to set at the level of subassemblies or leaf items. The rollup is performed on the Latest Released revision and all Pending revs of the shippable items. If it is a TLA, the system performs the rollup for the entire BOM for the specifications in the TLA; if it is a subassembly, the system performs the rollup for the entire BOM for the specifications in the subassembly.

Note: The specification(s) on any Shippable Item is propagated (added) to all parts that belong to the Shippable Item, if the specs are not already associated with those parts. (This applies to manual rollups: when Calculate Compliance button is clicked on a part or assembly, the system propagates the specs on that part or assembly to all parts/mfr.parts that belong to that assembly, if they are not there already.)
2. All Pending revisions of all Shippable Items. Note that the system does not perform rollups on previously released revisions of Shippable Items.

**Stage 2 – Perform Compliance Rollup on Parts/PGs that are Flagged**

1. Regardless of the setting of Shippable Item or the status of a revision, the system looks for all "flagged" parts/part groups, that is, those parts/part groups (with associated specifications) whose Need Compliance Check attribute has changed from No to Yes (on `<part/PG>` Compliance Specifications table). When Need Compliance Check field changes to Yes, the system is indicating that it is advisable to perform a rollup on that part.

   **Note** On items (Specifications table), the Need Compliance Check attribute is not visible.

Several events cause Need Compliance Check to switch from No (meaning nothing has changed since the part was rolled up, it is still “up to date”) to Yes (meaning something changed and the part is no longer “up to date”):

- A new specification is added to an item, manufacturer part, or part group
- A specification’s declared compliance is changed on an item, manufacturer part, or part group
- A declaration/composition is released for an item or manufacturer part
- A declaration/composition is released for a part group that is associated with items or manufacturer parts
- A composition is manually imported to a manufacturer part
- A composition is archived (from an item, manufacturer part, or part group)
- An item or manufacturer part is associated to a part group that has a new specification (that is, not already on the item or manufacturer part).

**Expected Time Required to Complete Systemwide Rollup**

How long the systemwide (automatic) rollup task takes depends on the number PLM objects described by “Stage 1” and “Stage 2” above. If the number of shippable items is relatively stable from day to day (or other chosen period), the time required by the system to perform Stage 1 will be the same. A large volume of parts, say, numbering in the tens-of-thousands, leads to a greater volume of shippable items, causing Stage 1 to consistently run “long.”

For a company’s first run of the rollup task, Stage 2 might be expected to encounter many flagged parts in the system; for a large number of parts, Stage 2 might take a significant amount of time. On the other hand, from the second run going forward, many of those parts are now “cleaned up” – the factors listed above will not change from day to day for the bulk of parts – and do not require processing time in the system. With fewer changed parts in the system, Stage 2 will likely run faster each time. This may or may not make a noticeable difference in time, again depending on the overall volume of compliance-specific objects in the system.

**Note** There are many events that change the database information about parts and manufacturer parts (that is, through the work in other Agile solutions such as Product Collaboration) that may impact the compliance result of the part, even though these events are not PG&C-specific (and do not change the Need Compliance Check flag). A partial list of such events include:

- Adding a part or manufacturer part to OR removing it from an item (manually or through an
ECO/MCO)

- Adding an item to OR removing it from an assembly (manually or through an ECO)
- Creating a new revision of an item
- BOM resolution change-based on pending revisions.

When Rollup was Last Run

After any kind of rollup (that includes a part) is run, near the top of the part you will see a Compliance Calculated at ____ time stamp, which gives the details of the last time the rollup ran and elapsed time since that point.

Because some companies have very large numbers of shippable items, the Item History logging during rollup has been removed; you can use the Compliance Calculated at ____ field to know the time of the part’s most recent rollup.

Compliance States

There are five default compliance states within declarations and on parts and part groups. Compliance rollups use compliance states of compositions stored on parts/part groups to calculate the compliance state of larger assemblies. Only one of the compliance states is actually Compliant; four compliance states describe types of non-compliance.

<table>
<thead>
<tr>
<th>Compliance State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Non-Compliant</td>
<td>This state takes highest priority in the worst-case bias</td>
</tr>
<tr>
<td>Missing Info</td>
<td>The state of “missing information” takes the second highest priority</td>
</tr>
<tr>
<td>Waived</td>
<td>The third highest priority state informs that a “waiver is in place”</td>
</tr>
<tr>
<td>Exempt</td>
<td>This is the lowest of the four non-compliant states (but see Treat Exempt as Compliant in BOM Rollup Rule (on page 86) below)</td>
</tr>
<tr>
<td>Compliant</td>
<td>In worst-case scenarios, Compliant is the lowest-priority compliance state.</td>
</tr>
</tbody>
</table>

Note: The administrator can change the names of compliance states to fit the requirements of your company. However, because compliance states do not change their essential meaning, the new names should be readily associated with the default names listed above. Compliance states cannot be added or removed.

Agile PG&C defaults to the reporting of “worst-case” scenarios.

Worst-Case Priority of Compliance States

The priority of the compliance states when the system is set to a “worst-case” bias is:

1. Non-Compliant – this state takes highest priority in the worst-case bias
2. Missing Info – the state of “missing information” takes the second highest priority
3. Waived – the third highest priority state informs that a “waiver is in place”
4. Exempt – this is the lowest of the four non-compliant states (but see Treat Exempt as Compliant in BOM Rollup Rule (on page 86) below)
5. Compliant – in worst-case scenarios, Compliant is the lowest-priority compliance state.

Note: Although you have access to all of the compliance states, your information suppliers can only declare Compliant or Non-compliant. They can also declare Exempt if exemptions are available, that is, if the specification has any listed exemptions.
How Compliance States are Ranked

The rule that governs the priorities of compliance states is this:

   From any level in a BOS or BOM, the calculated compliance state of any higher level cannot be
   lower than the calculated compliance state of the current level.

So, if “level 7” of the BOM has a result compliance of Missing Info, none of the higher levels (top
level of BOM, or level 1 through level 6) can be any worse than Missing Info; this makes sense,
because level 7 has already taken all of the lower levels (level 8 through end of BOM) into account.

This means that if a part or assembly shows a Compliant state (5 in the list), you can conclude none
of the part’s subassemblies have any of the non-compliant states (1–4) blocking the part from being
in compliance.

That is the strength of the worst-case bias, that although you are always seeing the “bad news”
about the compliance state of a BOM or BOS, the more you drill down and resolve problems, and
the lower levels achieve the Compliant state, the “good news” begins to move up the BOM/BOS
until an entire assembly can demonstrate integrated compliance up and down the bill of materials or
bill of substances.

Treat Exempt as Compliant in BOM Rollup Rule

The administrator has an optional setting that permits BOM rollups to “overlook” the presence of
Exempt states in arriving at the final compliance state of the top-level assembly in the Bill of
Materials. Because Exempt is one of the ‘non-compliant’ compliance states, a part that is declared
Exempt can render the entire assembly Exempt. By setting this rule to Yes, once a part is Exempt,
the rule prevents “Exempt” from rolling all the way to the top of the assembly.

Of course, other parts in the assembly may have more serious non-compliance problems, so this
setting does not bypass those states being rolled up.

Also note that the ability of the administrator to change the names of default compliance states
makes it possible to change Compliant to, for example, “Compliant with possible Exemption.”

Additional Note on Exempt and Exemptions

The Exempt compliance state and Exemptions are pertinent to Specifications. If there is a Fully
Disclosed composition with Declared Compliance set to Exempt (at the Composition or at BOS
level), it will only be used for rollup against the specification used on that declaration; for all other
specifications, the rollup is based on the PPM values. For a rollup based on Fully Disclosed
compositions for any specifications with no “matching spec” compositions, the result can be
Compliant or Non-Compliant, but it will never be Exempt.

With this background information, the rest of this chapter examines the three kinds of rollup in
PG&C.

Bill Of Substances (Composition) Rollup

The top level of a Bill of Substances is the composition, or aggregate of part+rev for a given
supplier for a named specification. The terms “BOS rollup” and “composition rollup” refer to the same process. Compositions are gathered or collected by declarations, or by direct import into manufacturer parts.

Changes to how substances are treated and evaluated by the system were introduced in Chapter 4. Refer to the following sections to understand how Composition Rollups may be different in Rel. 9.2.2: Mass Disclosure, Mass Tolerance, Intentionally Added, and Unreported Substances in Partially Disclosed Compositions.

Kinds of Composition

- Pending Composition – a composition on an unreleased declaration
- Active Composition – a composition on a released declaration, or that has been manually import to the part
- Inactive or Historical Composition – the old composition when it has been updated by a new declaration, or by a newly imported composition directly to the part.

BOS Hierarchy

Remember that the hierarchy of the Bill of Substance is:

- First or top level: Composition of a part or part group
- Second level: Subpart (note that a subpart may have child subparts)
- Third level: Material (homogeneous material)
- Fourth level: Substance Group
- Fifth level: Substance

Most Bills Of Substance will be a subset of these levels, for example, you may simply have a part with a few regulated substances. The hierarchy is important for understanding how the system structures its BOS analyses.

Compliance Validation for BOS Tree

We speak of part-level validation and homogeneous material–level validation, based on the setting of Validation Type field on the General Info tab of the associated specification (see General Info Tab (on page 37)). These are the varieties of BOS rollups, from “lowest” to “highest”:

- Substance to substance group
- Substance or substance group to material, subpart, or part
- Material to subpart or part
- Subpart to part
- At Part level

When Composition Rollups Occur

Validations within a declaration is the process of calculating compliance of the Bill of Substances within a composition and assigning a compliance state to the composition based on this analysis. This ensures that all contained data is kept up to date during the course of the RFI process.
Composition rollups can occur in these ways:

1. Within a declaration, a BOS rollup takes place automatically every time the declaration workflow advances one status, except from Pending to a non-Released status; so, change from Pending to Released, and all other advances from non-Pending status to another triggers the composition rollup.
2. In a declaration, when you manually click **Actions > Calculate Compliance**.
3. When you complete importing a composition to an item or manufacturer part, a BOS rollup is automatically triggered.

**Two Part Sequence in Rollups**

In Rel. 9.2.2, rollups have a two-step sequence, depending on the presence of specifications in the declaration.

The first step is: when a declaration changes status, or at the end of direct import of compositions into an item or mfr. part, the system calculates the PPM for all substances regardless of whether any specification is present. Also, the Mass Disclosure type is identified. If the composition is identified as Partially Disclosure, the system adds the “Unreported (System)” substance wherever necessary in the BOS tree.

The second step is: if there is a specification in the composition, the system proceeds to the second part of the rollup, where it evaluates and updates the calculated compliance at each level. For more details about the logic that the system follows for different types of substances, see [Internal Logic of BOS/Composition Rollups](on page 113).

**Further Change in Rollups**

Previous to Rel. 9.2.2, even if the sum of the substances’ masses added up to the part’s mass, if any of substances-of-concern list in the specification were missing in the composition, the rollup would result in “Missing Info.” However, in 9.2.2:

- On Substance Compositions, if the sum of the substances’ masses add up to the part’s mass (Fully Disclosed), even if the substances in the specification are missing in the composition, those substances are Compliant. If the composition is Partially Disclosed, the system tries to access compliance of all the missing substances against the Unreported substance, and the worst case is used for the rollup. If there is an Unreported substance, the result can be either Compliant or Missing Info.

- On Homogeneous Material Compositions, the same logic is used when calculating the compliance of parent of the substance (material or subpart) for Fully Disclosed compositions only. As soon as the system identifies the composition as Partially Disclosed, it follows the established rules for rollup. If there is an Unreported substance in the composition, the system tries to assess compliance of all the missing substances against the Unreported substance, and the worst case is used for the rollup.

Note that when an Unreported substance is present, the Declared Compliance, Calculated Compliance or Result Compliance fields are not used. Again, in this case, we need to manually calculate the values and make sure that the system is doing the rollup against Unreported substance appropriately.

**Use Case**

In 9.2.2, you can add an Unreported substance to the specification. In addition to the above rules, if the Unreported substance exists in the spec, the system also calculates its compliance (similarly to
regular substances in the spec). The Calculated Compliance of the Unreported substance is the worst case. This spec lists three substances:

Spec1:
- Sub01 500 PPM
- Sub02 2000 PPM
- Unreported (System) 1000 PPM

If the system adds an Unreported substance to the composition, with Sub01 and Sub02 already present, the system calculates the Unreported substance’s compliance as if it were a regular substance.

However, if the system adds an Unreported substance to the composition, and one of the substances – Sub01 – in the specification is not present in the composition, the system compares the Calculated PPM of the Unreported substance with the Threshold PPM of Sub01, the missing substance, and its own Threshold PPM, and picks the worse case as the result.

In this example, if the Calculated PPM of the Unreported substance is less than or equal to 500 PPM, the Unreported substance is Compliant. If it is 900 PPM, comparing with the Threshold PPM of Sub01, it is Non-compliant; while comparing with its own Threshold PPM, the Unreported substance is Compliant; so, the Calculate Compliance of the Unreported substance is the worse case, Non-compliant.

**Substance Declarations and Need Rollup Flag**

A known issue has been fixed: a BOS rollup on a Substance Declaration would not occur if changing status directly from Pending to Released. However, there is still an issue where the declaration changes status (which causes a rollup to be run automatically) but the Need Rollup flag seems to remain “Yes.” What is really taking place is that, after the workflow changes status, the system is pre-populating the substances from the specs.

So, you will see this issue if all of the following are true:
- The declaration is a Substance Declaration;
- The declaration has one or more specifications;
- The status is changed from Pending to Released (or Implemented) directly.

The workaround is simply to roll up the declaration once more, manually.

**Bill Of Materials (Compliance) Rollup**

Once the compliance at the composition level is known, the compliance within a part or manufacturer part on a BOM can be calculated. We know that a composition has a declared and a calculated compliance. With these settings, the compliance rollup can calculate the compliance within a part or part group. The terms “BOM rollup” and “compliance rollup” refer to the same process.

The cases to consider are subunits of the BOM rollup:
- Part-level Compliance validation: Composition level to its parent (part or part group).
  This is governed by the setting in Administrator for “Composition Rollup” set to Strict (default)
or Relaxed.

- AML Compliance validation: AML to IPN (manufacturer parts to parts).
  This is governed by the setting in Administrator for “AML Rollup” set to Strict (default) or Relaxed.

- Item to Assembly-level validation
  This is governed by the Administrator setting for Treat Exempt as Compliant (see “Treat Exempt as Compliant in BOM Rollup Rule” on page 86).

Some Rollup Fields

Many fields used to interpret compliance rollups were defined in Tabs and Attributes in Parts and Part Groups (on page 44). In fact, the fields below were defined earlier, but are presented here as a reminder.

- Overall Compliance/Summary Compliance – indicates the compliance state of the part using the worst-case scenario and matched across all specifications associated with the part. This attribute is found on these objects:
  - Items > Title Block tab > Overall Compliance
  - Manufacturer Parts and Part Groups > General Info tab > Overall Compliance

On items, Overall Compliance is revision-controlled, that is, specific to the item’s rev.

**Note**

In 9.2.2, the Overall Compliance attribute also reads through to the objects below, although in these cases it is named “Summary Compliance”:

- Items base class (Parts and Documents) > BOM tab and Manufacturers tab > Summary Compliance
- Changes base class (ECOs, MCOs, etc.) > Affected Items tab > Summary Compliance

On items, Summary Compliance is always derived from the Latest Released Rev of the item; if there is no released rev, it is from the Introductory rev.

On parts and part groups, the Overall Compliance field is the worst-case compliance of all associated specifications. For example, if there are five specifications and four of them are compliant but one of them is not compliant on the part’s Specifications table, then the overall compliance is Not Compliant.

- Shippable Item – On items only, when the Shippable Item field is Yes, a flag is set that the system recognizes that a top-level assembly is ready for market and will be included in any scheduled rollup. During scheduled rollups, the system first looks for Shippable Items, on the second round it looks for all parts/part groups with one or more specifications that the Need Compliance Check field is Yes.

- Exclude From Rollup – On the other hand, when the Exclude From Rollup field is Yes, it sets a flag that prevents the system from considering the compliance of the item (which it determines anyway) when determining the compliance of its parent. The default for the Documents class objects is Yes. The default for the Parts class objects is No, but of course it can be set to Yes for any part of an assembly whose compliance state does not concern you. Again, this attribute applies only to items, that is, parts and documents.
Note:  Exclude From Rollup flag on item is supported by Compliance Rollup as well as Substances and Weights Rollup features.

**BOM Rollup Evaluating Compliance States**

For parts, part groups, or assemblies, the Composition Rollup rule and AML Rollup rule (set in Administrator) are generally set to Strict, which gives your BOM rollup results the ‘worst-case’ orientation. The setting of the rollup rule “Treat Exempt as Compliant” adds its influence to BOM rollup results. The effects of these rules are noted below.

If you detect your compliance rollups yielding unexpected (or undesired) results, see your administrator about the systemwide settings of the compliance rules.

A general case with emphasis on the two ‘strict/relaxed’ rules: let there be an assembly with multiple subassemblies. Assume one of the subassemblies has a compliance state of Exempt, another subassembly’s state is Missing Info, and all the other subassemblies are in the Compliant state. Can you predict the compliance state of the assembly?

If you refer to the list of compliance states (page 10-4), you see that the subassemblies that are Compliant will at some point contribute to the overall compliance of the assembly, but right now they are not going to “win” or influence anything. The Exempt subassembly is weighted, but the Missing Info subassembly is more weighted. At this point, the compliance state of the assembly is Missing Info. As soon as non-compliance is found in a lower level, all levels above it also become non-compliant.

Things *could* be altered if Treat Exempt as Compliant rule is set to Yes (its default is No); however, note that in this particular use case, the compliance state of the top-level assembly would still be Missing Info.

**Part-Level Validation – Rollup from Compositions to the Part or Part Group**

This is governed by the Composition Rollup rule in Administrator. For each part or part group, this rollup evaluates all active compositions for the part across all suppliers for the particular specification being rolled up at the time.

The resulting compliance state is stored in the Calculated Compliance field (and Result Compliance field) of the Specifications table of the part or part group for that specification.

The Specifications table also has a Declared Compliance field for each specification. This field allows a user to overrule the Calculated Compliance up to this point. This is used in the case where a company has put a waiver in place or has an application-based exemption for, say, medical devices.

This validation does not happen automatically but depends on scheduled rollups or on the user launching a compliance calculation of the part or one of the part’s higher-level BOM parents.

**Rules for Selecting Compositions for Rollup on Part/Part Group**

1. For a given spec, the system looks for matching spec composition (the composition that has the same spec as the given specification).

2. If not found, it looks for Fully Disclosed composition – the latest active one for each supplier, regardless of the spec on the composition. As soon as there is a Fully Disclosed composition, they are used to calculate compliance. This means that all existing Partially Disclosed or
Undisclosed All-Spec compositions that match the composition type of the Fully Disclosed composition are ignored.

3. But if a Fully Disclosed composition is not found, the system looks for “All Spec” compositions with the same validation level as that specification’s validation level for that part or part group. The All Spec composition is a composition without any specification attached. (See "All Spec" Use Case (on page 41).)

AML Validation – Rollup from AML to Item

This is governed by the AML Rollup rule in Administrator. Strict setting, or worst case, means that as long as one of the manufacturer parts on the AML of the part is different than Compliant, then the part cannot be compliant. Relaxed setting, or best case, means that as soon as one of the manufacturer parts on the AML of the part is compliant, then the part is compliant, effectively reversing the compliance state priority list.

The resulting compliance state of the item across its AML is stored in the Calculated Compliance field (and Result Compliance field) of the Specifications table on the item for that specification.

The Specifications table for that item also has a Declared Compliance field that allows a user to overrule the Calculated Compliance up to this point.

This validation does not happen automatically but depends on scheduled rollups or on the user launching a compliance calculation for the parent of the compositions or one of the parent’s higher-level BOM parents.

Here are a few use cases illustrating how the rollup rules work.

Case 1 – AML Rollup rule is set to Strict and Treat Exempt as Compliant rule is set to Yes or No.

   Item 1 – Not Compliant
       Mfr.Part 1 – Exempt
       Mfr.Part 2 – Not Compliant

Case 2 – AML Rollup rule is set to Relaxed and Treat Exempt as Compliant rule is set to No.

   Item 1 – Exempt
       Mfr.Part 1 – Exempt
       Mfr.Part 2 – Not Compliant

Case 3 – AML Rollup rule is set to Relaxed and Treat Exempt as Compliant rule is set to Yes.

   Item 1 – Compliant
       Mfr.Part 1 – Exempt
       Mfr.Part 2 – Not Compliant

So, if the mfr. part has a compliance state of Exempt and the ‘Exempt’ rule is set to Yes, the item is compliant.

Validation Rollup from Item to Assembly

This is governed by the Treat Exempt as Compliant rule in Administrator. The resulting compliance
state is stored in the Calculated Compliance field (and Result Compliance field) of the Specifications table on the item for that specification.

The Specifications table for that specification also has a Declared Compliance field that allows a user to overrule the Calculated Compliance up to this point.

This validation does not happen automatically but depends on scheduled rollups or on the user launching a compliance calculation for the parent of the compositions or one of the parent’s higher-level BOM parents.

Please see Internal Logic of BOM/Compliance Rollups (on page 116) for more information.

Rules for Calculating Compliance for Specifications on Parts

For specifications with matching compositions, the Result Compliance from the composition is used. The system does not perform the composition rollup, since the rollup already happened in a declaration or during Import and its result can be re-used.

For all other non-matching compositions, the rollup compares the substance in the spec with the substances in the composition based on their Result PPM. The Declared, Calculated and Result Compliance fields at all levels in the composition will not be used.

Note that the system does not update any fields on the Composition table or composition Substances table, so it can be difficult to verify. When doing a rollup from an assembly, use the BOM Compliance Report to ensure that the system-calculated compliance at the specification level is correct for all the children in the assembly.

Substances and Weights Rollups using Excel Integration

A Design for Environment (DfE) use case requires hazardous substances and weights analysis. In Agile PG&C, a predefined Substances and Weights Rollup spreadsheet is opened in Microsoft Excel. You are asking, “On this top-level assembly (TLA), I want to do weights rollups on all substances per this specification.” Or, “Find me the worst case for each substance in terms of its weight.”

Note

There is now a fully supported Japanese version of the Rollup in Excel template. Also, localized versions of the Rollup in Excel template are supported in Chinese, French, and German.

You perform substances and weights rollups after declarations have produced new data about the substances of your concern. The substances & weights rollup is run only on parts, that is, your company’s assemblies (not manufacturer parts). You can run it on the BOM + BOS tree of the entire assembly, including its Substances. Once the BOM+BOS data is exported to Excel, the rollup occurs there; you can change weights and do different “what if” analyses; however, this Excel spreadsheet is not connected back to Agile PG&C.

Be sure to understand the use of the Conversion Factor with substances (see Substance Groups and Conversion Factor (on page 24)). Also see Internal Logic of Substances and Weights Rollups (on page 117) for more information.

Details of the Substances and Weights Use Case

As a background to the implementation of the Substances and Weights Rollup through the
Microsoft Excel-based Client, you already know that the PG&C solution has built in the Compliance (BOM) Rollup, which automatically calculates whether parts are compliant, not compliant, missing information, and so forth. But a Weights rollup was not built into the system, and it was decided that the “Rollup in Excel” process extension was the best way to include a weights-based rollup feature in PG&C.

So, for a given assembly, when we choose from, for instance, an item’s Actions menu to Rollup in Excel, the system exports the entire assembly along with its Bill of Substances for each part/part group in that assembly. In the Microsoft Excel-based client, Run Scenario performs a worst-case rollup, adds up all the substances, and derives a unique list of substances that exist in the assembly; at completion it reports, “This assembly in worst-case has this much lead, this much cadmium,” and so forth. It will also tell you, “These are the contents of substances, when you compare any substance against a specification,” it looks at the substance value, look at the specification’s stated PPM allowance for that substance, informing you are this part is compliant or not compliant for that substance.

In a compliance rollup, this comparison takes place at the individual substance level for each item, whereas in the Substances and Weights rollup, it takes place at the assembly level with the rolled-up value of the same substance but from all the child items in the assembly.

When the system does a BOM rollup or a Substances and Weights rollup, the substance group and the base substance are treated the same. For instance, a spec could list a substance group called “Lead & Lead Compounds” but the system might be ‘confused’ between the base substance “Lead” and related substance “Lead Compounds.” In this case, the system could determine the substance Lead is “Compliant” even though it has not fully discerned the presence of all instances of the base substance Lead in the part.

- If none of the substances from specification exist in the composition (that is, there is not an exact match), then the system does not select either Compliant or Non-compliant. This is not a perfect situation, but the user at least knows that some information is missing in the system’s ‘understanding’ and can troubleshoot from there.

- If there is at least one substance or substance group that has PPM above the threshold, we have to select “This Part does contain substances listed in the referenced specification above the reporting limits as detailed below.”

- If there are multiple compositions for a part for the same Spec, the server will return all active compositions for a part, and the rollup logic follows the PWC rule (pessimistic worst case) among those active compositions (previously it only returned the Latest Released composition).

Running a Substances and Weights Rollup

To run a substances and weights rollup:

1. In an item, using the Actions menu, choose Rollup in Excel.

2. You are prompted to select a specification against which the rollup will be performed. Once you are in Excel, you see the Reference Specification field is populated with the specification you selected.

   Of the radio buttons for Scenario, only “Pessimistic Worst Case” is available now, so that box is already checked.

   The Flags radio buttons are not checked (by the system) until the rollup is run.

3. Microsoft Excel opens with the data of the part (Object in Assembly) displayed in the table (which
can be altered according to your company’s needs).

You are prompted by a SaveAs dialog: you can accept the default name (Assembly Number/Name) or enter a new filename; and, you can accept the default location – Excel copies the files to a Agile Spreadsheet Files folder on the desktop – or enter a new location.

Saving the file enables you to re-open those files in another session.

4. Choose Agile > Run Scenario. The rollup is run.

5. When the scenario is run, one of the Flags radio buttons is checked, giving information about the part, either that the part does not contain substances listed in the Reference Specification, or that it does contain substances in the Ref.Spec. including which ones are above the reporting limits of the specification.
Managing Your Suppliers

This chapter includes the following:

- Attributes in Suppliers ................................................................. 97
- Creating Compliance Suppliers ......................................................... 98
- Creating and Adding Contact Users ................................................ 100
- Adding and Modifying Suppliers on a Part or Part Group ................... 101

Suppliers were introduced in Suppliers.

In creating the Supplier business object and associating contact users, it is important to follow the documentation so certain pitfalls are avoided. For example, the supplier setting for Web Supplier and Lifecycle Phase, and the user setting for Response Edit Mode, need to be understood.

Attributes in Suppliers

As with other Agile objects, information about the supplier is displayed on a series of tabs. Each tab contains information about, or related to, that supplier.

**Note** Some tabs may not be enabled by your administrator.

By default, the General Info tab contains the fields listed in the following table. Agile administrators can add custom class and subclass fields to the General Info tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the supplier</td>
</tr>
<tr>
<td>Supplier Type</td>
<td>Indicates the supplier subclass; configurable by the administrator.</td>
</tr>
<tr>
<td>Lifecycle Phase</td>
<td>Supplier is Active or Inactive</td>
</tr>
<tr>
<td>Number</td>
<td>Supplier number assigned to the supplier when you create it</td>
</tr>
<tr>
<td>DUNs</td>
<td>Industry-standard Data Universal Numbering System (DUNS) number</td>
</tr>
<tr>
<td>Display Name</td>
<td>Display name</td>
</tr>
<tr>
<td>Description</td>
<td>Text that describes the supplier; maximum length is set by Agile administrator</td>
</tr>
</tbody>
</table>
### Web Supplier
Indicates if this supplier logs in to Web Client (Yes, which is then called “Web Supplier,” or No, which is then called “non-Web Supplier”). PLM now allows declarations to name either kind of supplier: a Web Supplier must have at least one associated Contact User (see next section); a non-Web Supplier may be named in the declaration with no associated contact users. However, it is still recommended that a declaration name a Web Supplier: PG&C carries and publishes the most useful information if a Web Supplier with associated Contact Users is named; for example, those contact users receive notifications.

**Note:** The requirement that a declaration must have a supplier has been removed; but the administrator must have made the field ‘not required’.

### Corporate Currency
Default currency for this corporation

### Address
Address

### City
City

### Postal/Zip Code
Postal or ZIP code

### Phone
Phone number

### Fax
Fax number

### URL
URL for supplier Web site

### Maximum number of Contact Users
Maximum number of contact users that can be created for this supplier

### Maximum Number of Licensed Contact Users
Maximum number of supplier users that can be assigned a concurrent user license

### Maximum Number of Power Contact Users
Maximum number of supplier users that can be assigned a power user license

---

### Buttons on the General Info tab

The **General Info** tab contains the following buttons:

- **Edit** — appears when the **General Info** tab is not in edit mode. To edit the **General Info** tab, click **Edit**.

- **Save** — appears when the **General Info** tab is in edit mode. To save the changes that you made to the tab while it was in edit mode, click **Save**.

- **Cancel** — appears when the **General Info** tab is in edit mode. To undo the changes that you made to the tab while it was in edit mode, click **Cancel**.

The following sections describe the additional tabs.

### Creating Compliance Suppliers

Even if your administrator has created suppliers and contact users, you may have to create more.
Supplier Types

There are several “out-of-the-box” supplier types in Agile PLM, but these were tailored for RFQs and the sourcing process. Your administrator may have created another Supplier subclass for your company’s PG&C work, or may have reconfigured and renamed one of the existing supplier types. If you will be creating suppliers to provide compliance information in support of your company’s manufacturing process, there should be at least one predefined “compliance-oriented” subclass that you and other compliance managers can select.

Note  “Web Supplier” is an attribute on General Information tab of a supplier, not a supplier type (subclass). See the Description of Web Supplier in the table in Attributes in Suppliers (on page 97).

Supplier Lifecycle Phases

The lifecycle phase of the supplier can be either Active or Inactive.

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>The supplier is currently active and able to receive declaration requests/RFIs.</td>
</tr>
<tr>
<td>Inactive</td>
<td>The supplier is currently not active, and cannot be included in new RFIs.</td>
</tr>
</tbody>
</table>

Creating a Compliance Supplier

Use the Supplier Creation wizard to create a supplier organization.

To create a supplier:

1. Choose Create > Suppliers from the global menu bar. The Create Suppliers wizard appears.
2. From the Supplier Type drop-down list, select an appropriate supplier type. The default types are: Broker, Component Manufacturer, Contract Manufacturer, Distributor, and Manufacturer Representative.

Remember, the out-of-box names may have been changed by your administrator, and other supplier types may have been created for compliance-specific work.
3. There are several required fields. Specify a unique supplier Number and Name.

Select appropriate settings for Lifecycle Phase (Active, Inactive), Web Supplier (Yes, No), and Corporate Currency (choose from list).

Notes  If a supplier is not active (that is, if Lifecycle Phase is set to Inactive), this supplier cannot be added to a declaration.

“Web Supplier” nominally indicates if a supplier logs in to Web Client to provide compliance information. See the Description of Web Supplier in Table 11-1 on page 11-1.

Also enter a value for Maximum Number of Contact Users. This number should be known to you in conjunction with the number of licenses purchased by your company that can be distributed over all your Supplier users.

If you click the Continue Creation in Wizard checkbox, you will be able to Continue through all
aspects of a supplier object. If you leave this checkbox blank, you will Finish the object creation process, and then you can add to the object by modifying it.

Click Continue.

4. Enter general information, including flex field details. Table 11-1 describes the fields that appear on the next pages of the wizard.

On any page of the wizard, you can click Finish to complete this operation. You can view the newly created supplier on the General Info tab.

5. Click Next to add contact users.

6. Click the other tabs to add additional information about the supplier. However, note that the default tabs – PSRs, RFx Routing, Manufacturers, and Commodities – have more to do with the PCM solution (unless the administrator has renamed and reconfigured these tabs).

7. On the Attachments tab, you can attach files and URLs to the supplier that you are creating. To attach a file, click Add > File. To attach a URL, click Add > URL. To find attachments by searching, click Add > By Search.

8. When you are finished adding attachments, click Finish.

To edit fields of a supplier, click the Edit button. You may not be able to edit the contents of some fields.

Creating and Adding Contact Users

The Contact Users tab defines which users can log in to Agile PLM to represent a compliance supplier. Supplier users have restricted privileges to the Agile PLM system that allow them to respond to RFIs.

An important setting for any contact user is the Response Edit Mode user preference. This field controls which user interface in Web Client that the contact user sees. When creating a new supplier user, the default setting for Response Edit Mode is Basic; this means the supplier user will see the “Basic Supplier Interface” when they log in to Web Client. (See the PG&C Supplier Guide.)

If a supplier’s contact user were to change the setting of Response Edit Mode from Basic to Advanced mode (specifically Advanced Table Edit or Advanced Wizard Edit), he is prompted to log out and log back in; when he logs in to Web Client, he will see the normal user interface, constrained by his assigned privileges.

The PG&C Supplier Guide urges supplier users to let the setting to Response Edit Mode remain as it was set by you (or the administrator). If the supplier user in the above situation does log in to Web Client (Advanced mode), he will have to click the My User Profile link and change Response Edit Mode field back to Basic, followed by logging out and logging back in to Web Client (Basic mode).

Contact users who work frequently with your compliance requests may be required to create declarations, and you may want your administrator to assign additional roles and privileges to enable them to work more effectively in Web Client (Advanced mode).

To add an existing supplier user or create a new supplier user that is associated with a supplier:

1. Open a supplier and click the Contact Users tab.

2. If the supplier user(s) for this supplier have been created, click Add Users. Use the Find and Select User dialog to search and add them to the supplier.
Note  Power Users can be added to the Contact Users tab only if the Maximum Number of Contact Power Users field has been set to other than 0 (or blank) on the General Info tab of the supplier. Otherwise, only users with a Restricted user license can be assigned to a supplier.

If the supplier user(s) for this supplier have not been created, click Create User. The Create User dialog appears, open to the Select Subclass, Identify Name page.

3. Enter the username. Type the login password, and retype it. Fill in all the required fields. Click Next.

Note  If your work to create a new user is blocked by the system at any point, it is likely your roles and privileges are insufficient to complete the task. See your administrator.

4. Enter user details. The user’s first name, last name, and email are required fields. Make sure the Status field is set to Active. Here are other fields you should consider changing:
   - Role — The user’s role assignments. This property determines a user’s access to the objects in Agile PLM from the point of discovery forward. The standard role for a supplier is Material Provider, but your administrator can work with you to assign greater privileges to specific supplier users.
   - User Category — Agile PLM has three types of user licenses: Power, Concurrent, and Restricted. Restricted users are people outside your company (such as suppliers) who are given limited access to the Agile PLM system. Power users are not subject to concurrency counts and can therefore log in at any time. Both Restricted and Power users can respond to RFIs, but only Power users can generate and view reports.
   - Sites and Default Site — Sites are not supported by PG&C.
   - Authorized Ship-To and Home Ship-To — These settings are not utilized by PG&C.
   
   When you finish setting user details, click Next. The Define Preferences page appears.

5. Specify system, format, and display preferences. Click Finish to create the contact user.

The user appears on the Contact Users tab of the supplier.

Adding and Modifying Suppliers on a Part or Part Group

The Suppliers tab on parts and part groups enables you to add, edit, or remove suppliers on a commodity.

To add a supplier to a part or part group:
1. Open a commodity, click the Suppliers tab.
2. Click the Add button. The Add Suppliers wizard opens. From the returned rows, select and move a supplier that you want to add to the Selected list.
3. Click OK, then click Save. The selected suppliers are added to the part group.

To edit a supplier on a part or part group:
1. Open a part or part group, click the Suppliers tab.
2. Select the suppliers you want to edit, then click the Edit button.
3. Make the desired changes to the suppliers, then click Save.
To remove a supplier from a part or part group:
1. Open a commodity, click the Suppliers tab.
2. Select the suppliers you want to remove, then click the Remove button.
3. Click OK to complete the removal or Cancel to cancel the removal.
Chapter 12

Reports and Searches

This chapter includes the following:

- Using Searches in PG&C ................................................................. 103
- Using PG&C Reports ................................................................. 105

Using Searches in PG&C

Searches are used to identify parts that require compliance data from suppliers, and also to find existing business objects in the Agile database — substances, specifications, declarations, and so forth. Below are the predefined searches for PG&C, and a review of how to use search options when building new objects with associations to existing objects.

Accessing PG&C Saved Searches

To access PG&C saved searches, in the navigation pane, click Searches folder and expand Compliance Searches. These are the predefined searches available for PG&C.

- Custom Parts without Composition in a Top-Level Assembly (TLA)
  - Shows all items that don’t have an AML and that do not have an active composition. If there is a part with a pending composition, this search does not show that part.

- Manufacturer Parts without Composition in a Top-Level Assembly
  - Shows all manufacturer parts that do not have an active composition. If there is a part with a pending composition, this search does not show that part.

- Manufacturer Parts for an Item
  - Shows all manufacturer parts for a given item. So, it is similar to viewing the item’s Manufacturers tab.

Using the Search Options in Add Operations

In various “create” or “add” operations that are detailed in this manual, when you click the Add button, the dialog that opens may have a Search button. This is the procedure to decide what route to take to identify objects in the database that you can select in your “add” operation.

Agile quick searches, advanced searches, and parametric searches are documented in Getting Started with Agile PLM.

- Search (button and menu choice) opens a dialog with three Search tabs:
  - Search tab lets you run a simple search by entering a value in the field and clicking the Search button.
  - Click the Advanced Search link to set up an advanced search.
Click the **Search Attachment Contents** checkbox to include attachment files in your search.

When the results of your search are returned, you can select and move objects from the **Results** table to the **Selected** table.

Then click **OK**, and you are returned to the Create wizard, and the objects you selected have been added where appropriate.

- **Saved Searches** tab opens to your navigation pane where you can browse in search folders, select a search, and run it. Again, returned results may be moved to the **Selected Items** table, and click **OK**.
- **Shortcuts** tab opens to your navigation pane where you can select objects from **My Bookmarks** or **Recently Visited**. The system displays shortcuts to only those objects that are appropriate to the operation you are performing.

Generally you can run multiple searches before completing the wizard step. Also, after the object is created, you can still run multiple searches.

### Searchable Attributes for PG&C

PLM Release 9.2.2 introduces parametric searches. Many attributes that are new for PG&C in 9.2.2 are searchable.

- **Searchable new attributes for PG&C (Advanced Search and Parametric Search):**
  - All classes > **Page One** (*Title Block, Cover Page, or General Info*), **Page Two** and **Page Three** > all attributes > **Enable for Search Criteria** property = Yes/No

  Note that some attributes are available for parametric search by default.

- **Searchable new attributes in Substances:**
  - Alias – available for substance and substance groups

- **Searchable new attributes in Declarations:**
  - Has Invalid Substance – on **Cover Page** of all declarations classes except Supplier Declarations of Conformance and Part Declarations
  - Need Rollup – on **Cover Page** of all declarations classes except Supplier Declarations of Conformance
  - Mass Disclosure – on **<Parts/PGs>** tables of all declarations classes except Supplier Declarations of Conformance

- **Searchable new attributes in Parts/Part Groups:**
  - Mass Disclosure – on **Composition** table

- **Searchable new attributes in Specifications:**
  - Disallow Intentionally Adding – on **Substances** table

- **Searchable new attributes on Substances tables (Declarations <Parts/PGs> tabs; & Part/Part Group Composition tabs):**
  - User-entered CAS Number
  - Intentionally Added
  - Calculated Mass
• Result Mass
• Result PPM
• Spec Intentionally Added

- Searchable Summary Compliance attribute:
  - Items > BOM tab > Summary Compliance
  - Changes > Affected Items tab > Summary Compliance

<table>
<thead>
<tr>
<th>PGC New Attributes</th>
<th>Enable For Search Criteria</th>
<th>Out Of Box Enabled</th>
</tr>
</thead>
<tbody>
<tr>
<td>Substance.General Info.Alias</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Substance.General Info.CAS Number</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Substance.General Info.Is Internal</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>MDO.Cover Page.Need Rollup</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>MDO.Cover Page.Has Invalid Substance</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>MDO.Parts/mfrparts/Part Group--Mass Disclosure</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>MDO.Part/Mfr Part/Part Group.Substances.User Entered CAS Number, User Intentionally Added, Calculated Mass, Result Mass, Result PPM, Spec Intentionally Added</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Specification.Substances.Disallow Intentionally adding</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Part/Mfr parts/Part group Composition.Mass Disclosure</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Part /Mfr Part/Part Group.Substances.User Entered CAS Number, User Intentionally Added, Calculated Mass, Result Mass, Result PPM, Spec Intentionally Added</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

**Note** When the Mass attribute is included in the search result, the system displays the value from the “normalized” field and the UOM is not displayed. So, you may see different values in the search results compare to what you see on the [PageOne](#). The search results display the Mass of an part/part group in “normalized” value, while the [PageOne](#) of those objects display what a user has entered.

For example, if the standard UOM is kg and you enter a value of 1000 g (in, say, Item > Title Block > Mass attribute), the Title Block displays it as 1000 g; however, when you do an advanced search to include the same attribute in the display page, the search gives the mass of that item with a value of 1 (kg).

**Using PG&C Reports**

This section assumes you have read Chapter 6, “Working with Agile Reports,” in *Getting Started with Agile PLM*. That chapter describes report layouts, working inside and outside the wizards, how roles and privileges affect reports, and the report output window.

Agile reports provide you with the information you commonly need to analyze your business
processes. You select predefined criteria and specify the results you want. These out-of-box reports are applicable in most situations. You can run them as they are, modify the default layouts, or create your own layouts. As in all solutions, Agile reports are run from Web Client.

Note If your company has upgraded from an earlier version of PG&C, the report output fields (in the layout) may not include all the necessary attributes. Review the layout for each report to ensure that appropriate attributes are included in the report result.

To access PG&C standard reports, in the navigation pane, click Reports and Analytics (and expand it if necessary) > expand Standard Reports > expand Compliance Reports. This folder includes the following predefined reports:

- BOM Compliance Report
- Declaration Workflow Metrics Report
- Missing Substances Report
- Part Compliance Report
- Part Groups Compliance Report
- Parts with Compliance Issues Report
- Parts with Substance over PPM Report
- Parts with Substances Report
- Supplier Compliance Report

To use the Report wizard, you must have the Report privilege. If you are having difficulty, see your administrator.

All the Discovery privileges that are set up for your Agile content will be observed when you run a report with that content, including all rules about warnings set by the administrator.

If you do not have the Discovery privilege for an Agile object, you cannot include that object in a report. Parts for which you do not have the Discovery privilege are displayed in the same way they are displayed on BOMs, that is, you may see the object’s ID as a placeholder, but it is not a live link. Again, if you believe you should be able to see and open either a particular object in the system, or a class of objects, consult your Agile administrator.

Creating the Standard Layout

This is the standard task for starting a wizard in one of the PG&C reports. Until you have run enough reports to decide how to customize the default layouts, it is generally better to create, name, and save specific reports from the default layouts using the wizards.

To create a specific report layout from a default layout:

1. In the navigation pane, open Reports and Analytics > Standard Reports > Compliance Reports.
2. Click the icon next to the default report you want to use as the basis for your personal report. The Create Report Layout wizard appears. Follow the wizard. When you click Finish, the report will run.

   You can also double-click the Report Name to open the object, click the Layout tab, and then
click **Create**. This rest of this task follows that sequence.

3. Type a name for the specific report.

4. In the **Access** list, select the location for the layout. Your report layout can be Global—available to all—or Personal—available only to you.

5. Using the drop-down lists, select the **Paper Size** and **Orientation**.

   **Note** If there is a **Layout Type** list, choose a layout type from the list. For example, the Compliance Issues by Supplier report allows you to create layouts for Items or Manufacturer Parts.

   **Note** The **Layout Type** list appears on only a few specific report layouts. If you do not see a **Layout Type** list, ignore this step.

6. Select the fields you want in the report.

   - To add values to the **Selected Values** list, select them in the **Available Values** list, and double-click (or click the right arrow button).
   - To remove values from the **Selected Values** list, select them and double-click (or click the left arrow button).
   - To change the order of fields, select a field and use the up arrow or down arrow button to move it.

7. If there are multiple headers in the **Available Values** and **Selected Values** lists, select the appropriate values under each header and arrange them in the order you want.

   **Note** Multiple headers do not appear on all standard report layouts. If you see only one header (for example, Main Header Attributes) in the **Selected Values** list, ignore this step.

8. When you are finished, click **Save**.

After creating and saving your report, it can be run at any time.

**To view or edit an existing report:**

1. In the navigation pane, open **Reports and Analytics > Standard Reports > Compliance Reports**. Double-click the Report Name of the default report you want to use as the basis for your personal report. The report object opens.

2. Click a tab to view. If a tab, such as **Layout** tab, offers multiple reports (default or saved personal reports), you can double-click to view that layout. Or, select the row and click **Edit** to modify that report’s layout.

**Specifics to Compliance Report Layouts**

Use the information below for each PG&C report to populate certain fields when you create your reports.

**Note** Any report that displays substances on a declaration’s **Part/PG** tab > **Substances** table will also display the Unreported(System) substance, assuming it is used in the composition.

**BOM Compliance Report**

This report — the most important in PG&C — gives the user a complete view of compliance
throughout a BOM for the given specifications. The report displays the AML of items (that have an AML) as well. The report is launched by the BOM Compliance Report button on the Compliance tab of an item (not a manufacturer part or part group).

For more information on compliance rollups, see Rolling Up Compliance Data (on page 81).

After you collect compliance data on custom parts and manufacturer parts, running this report on an assembly helps you identify any items that are not compliant, as well as which manufacturer parts are causing the item to be not compliant. You can run this report on a top-level assembly (TLA), on subassemblies, or on “leaf items” (the last part of a branch in the BOM), against one or more specifications.

**Note** The BOM Compliance report displays items and manufacturer parts that do not have a specification associated. This ensures that any late-added parts (that is, a part added through a change but not yet associated with a specification because not subjected to a rollup) are at least named in the report.

When running the BOM Compliance report from an item, the item and all specifications in its Specifications table are selected to the report automatically. You can optionally choose to run a compliance rollup before generating the report output to get the latest compliance data.

**To generate the BOM Compliance report:**

1. Select one or more items: this requires the user to select one or more items for the report as well as a rev per item. The system should allow a user to select the same item with different revisions.
   
   Items whose Exclude from Rollup attribute is set to Yes, the item and its BOM are not included in the report; however, for those items (same setting), the BOM Compliance report does display the compliance state values. You can prevent compliance state values from being visible by setting Display Excluded Items to No in the report wizard.

2. Select one or more specifications.

3. Select appropriate values for report input parameters:
   
   • **Depth**: for BOM levels, select a numerical depth (0–99) from the drop-down list or accept the default All Levels.
   
   • **Display Excluded Items**: choose No – allows you to omit any items that do not play a role in compliance – or Yes.
   
   • **Run Compliance Rollup**: choose Yes – allows you to request a calculation of compliance prior to generating the report – or No.

4. Click Save. Run the report at any time.

In the BOM Compliance report result, clicking on the link under Item Number takes you to the Title Block of the corresponding rev of the item. Clicking on the link under Calculated Compliance value takes you to the Compliance tab of the item.

**Note** If you have exported Excel files from the BOM Compliance report, links (in the Excel file) to items always load the latest released revision of the item, instead of the corresponding revision of the item. The same issue exists with links on compliance attributes. This issue will be addressed in a future release.

If a selected specification does not exist in the Specifications table of a selected item, the system returns the message “There is no data to display.” In the report result, the warning message about the selected specification not existing in the selected item is displayed.
Declaration Workflow Metrics Report

This report returns metrics for declaration workflows, that is, how long it took for the declaration to advance from one specified status to another.

To generate the Declaration Workflow report:
1. Select Workflow Name for the report.
2. Select one or more suppliers for the report.
3. Select one Starting status and one Ending status for the report.
4. Click Save. Run the report at any time.

For example, the Declarations workflow has these two consecutive statuses: Open to Supplier and Submitted to Manager. To find out how long a supplier took to reply to a declaration request, you would select a Starting status of Open to Supplier and an Ending status of Submitted to Manager.

This report also supports the “non-Web Supplier” as well as previously supported Web Supplier (see Managing Your Suppliers (on page 97)).

Missing Substances Report

This report returns active compositions for selected parts for which specified substances are missing. This can be from a single supplier or from multiple suppliers. The report shows a page for each supplier with Missing Substances information. Note that substances with blank values for Result Compliance, Result Mass, or Result PPM attributes from selected specification are considered “missing” – even if the substance exists in the active compositions.

This report also supports the “non-Web Supplier” as well as previously supported Web Supplier (see Managing Your Suppliers (on page 97)).

To generate the Missing Substances report:
1. Select one or more items or manufacturer parts. See the list of refinements just below this task.
2. Select one or more suppliers for the report. If you do not select a supplier, this report runs against all suppliers. (This includes ASL suppliers and non-ASL suppliers that are associated to the active compositions for a selected specification.)
3. Select one specification.
4. Click Save. Run the report at any time.

Refinements to Missing Substances Report

This report looks at the following factors for an item or assembly:

- If the item or assembly has matching compositions (same supplier and same specification), the report runs against these compositions following these two rules: (1) if the composition is Fully Declared, the part is not reported; (2) if the composition is Partially Disclosed or Undisclosed, the system checks if the composition has the substance, and if so, the part is not reported.

- If the item or assembly have no matching compositions (same supplier and same specification), the system checks all active compositions supplied by the same supplier but with a different specification, following the same two rules (stated in first condition above).
If there are no compositions with "same supplier and same spec" or "same supplier but different spec," the system returns the part with all the substances from the specification as missing and for the supplier.

If a supplier is not specified at report setup, the system checks all compositions from all suppliers, without considering the specification: all Fully Disclosed compositions are not returned, Partially Disclosed and Undisclosed compositions are considered. "No supplier" is included when looking for all suppliers.

The Alias attribute is displayed in the Missing Substances report. If a specification has a substance group, and the substance group has an Alias, the Missing Substances report returns only the base substance of the substance group, as well as the base substance's Alias.

Part Compliance Report

This report returns a Result Compliance per specification for selected items or manufacturer parts, based on which layout is used for the report. You can run a compliance rollup before running the report.

To generate the Part Compliance report:
1. Layout Type: choose For Item or For Mfr Part.
2. Select one or more items or manufacturer parts.
3. Click Save. Run the report at any time.

Part Groups Compliance Report

This report returns a Result Compliance per specification for selected part groups. You can run a compliance rollup before running the report.

To generate the Part Groups Compliance report:
1. Select one or more part groups for the report.
2. Click Save. Run the report at any time.

Parts with Compliance Issues Report

This report returns all active compositions (part–specification–supplier) with compliance state (Result Compliance) set to Blank, Not Compliant, or Missing Info. There are layouts available for items and for manufacturer parts.

To generate the Parts with Compliance Issues report:
1. Layout Type: choose For Item or For Mfr Part.
2. Click Save. Run the report at any time.

Parts with Substance over PPM Report

This report returns all parts that contain selected substances above a given PPM value, by part or material. The report takes the value from Result PPM field.

If an active composition contains a selected substance – or Unreported (System) substance – with
a Result PPM value that is higher than the given PPM value, the part associated to the composition is returned.

If an active composition contains a selected substance with the Result PPM field blank, and Calculated PPM is higher than the given PPM value, the part associated to the composition is returned.

For a part-level specification, in order to get the calculated PPM value of the substance, the Mass value of the part and substance must be present. For a material-level specification, in order to get the calculated PPM value of the substance, the Mass value of the material and substance must be present.

Note

The \textit{Parts with Substance over PPM} report recognizes Unreported(System) substance.

Note

Also, this report treats a given substance group and its base substance as the same. If a part has SG-1 and you name SG-1’s base substance in report setup, the report returns the part. Similarly, if a part has SG-1’s base substance and you name SG-1 in report setup, the report returns the part.

If the selected substance (other than the base substance) exists on the \textit{Substances} tab of a substance group, and (only) when the active composition contains the substance, the part associated to the composition is returned.

To generate the \textit{Parts with Substance over PPM} report:

1. Layout Type: choose \textit{For Item} or \textit{For Mfr Part}.
2. Select a substance or substance group – you can select only one substance/substance group for this report.
3. Select PPM threshold for the report.
4. Click \textit{Save}. Run the report at any time.

\textit{Parts with Substances Report}

This report returns all parts that contain the selected substances in the active compositions, for items or manufacturer parts, that satisfy at least one of these conditions:

- Result Mass does not equal 0
- Result PPM does not equal 0
- Result Compliance is not blank.

Note

The \textit{Parts with Substances} report recognizes Unreported(System) substance.

Also, this report treats a given substance group and its base substance as the same. If a part has SG-1 and you name SG-1’s base substance in report setup, the report returns the part. Similarly, if a part has SG-1’s base substance and you name SG-1 in report setup, the report returns the part.

To generate the \textit{Parts with Substances} report:

1. Layout Type: choose \textit{For Item} or \textit{For Mfr Part}.
2. Select one or more substances.
3. Click \textit{Save}. Run the report at any time.
Note: The Specification attribute may not be displayed in a part's Compliance tab > Substances table, but if it is enabled, it can result in two identical records in the Parts with Substances report.

Supplier Compliance Report

This report returns all compositions (part–specification–supplier) with compliance state (Result Compliance) for selected suppliers. You can select multiple suppliers for this report. Inactive suppliers cannot be selected. You can run the report, for items or manufacturer parts, against released declarations or non-released declarations. For released declarations, the report looks only at active compositions.

This report also supports the “non-Web Supplier” as well as previously supported Web Supplier (see Managing Your Suppliers (on page 97)).

Note: The Compliance Issues by Supplier report in Rel. 9.2 was removed from Rel. 9.2.1, and its functionality is now included in the Supplier Compliance Report.

To generate the Supplier Compliance report:

1. Select Layout Type from the drop-down list: choose Default Layout For Item or Default Layout For Mfr Part.
2. Select Type: click the radio button for Against Released Declarations or Against Non-Released Declarations.
3. Select one or more suppliers for the report. If you do not select a supplier, this report runs against all suppliers.
4. Click Save. Run the report at any time.
Chapter 13

Internal Logic of Compliance Rollups

This chapter includes the following:

- Internal Logic of BOS/Composition Rollups ................................................................. 113
- Internal Logic of BOM/Compliance Rollups ................................................................. 116
- Internal Logic of Substances and Weights Rollups ...................................................... 117

The internal business logic described below is provided for those compliance managers who want to analyze precisely how the system arrived at calculated or result compliance states.

Internal Logic of BOS/Composition Rollups

Be sure you have read Bill Of Substances (Composition) Rollup; the following information is supplemental to that section. This summarizes how the rollup works for BOS tree with various substance objects.

Rollup Logic for Substances

If there is a value in the Declared Compliance attribute, the rollup uses this value. If there is no value in the Declared Compliance, the system looks for Declared PPM and uses it for the rollup. If there is no value in Declared PPM attribute, the system looks for substance mass and part mass. If both values are available, the system calculates the PPM, compares it with threshold PPM, and sets the proper value in the Calculated Compliance attribute.

In a Fully Disclosed composition, if the substances or substance groups in the spec are missing in the composition, they become compliant automatically.

In a Partially Disclosed composition, the system checks compliance against the Unreported substance for all the spec substances or substance groups that are missing in the composition. Only when all the specifications’ substances or substance groups that are missing in the composition are compliant against the Unreported substance, the composition is considered as compliant for that spec.

If the “Unreported (System)” substance PPM is higher than on the specifications’ substances or substance groups that are missing in the composition, then the calculated compliance for that composition or parent of the substances will be Missing Info because the missing substance could be that substance or substance group from the spec, so the system cannot determine the compliance.

Rollup Logic for Substance Groups

If there is a value in the Declared Compliance attribute at the substance group level, the rollup uses this value. If there is no value in the Declared Compliance attribute at the substance group level, it looks for Declared PPM or Declared Mass at the substance group level and uses it for the rollup. If
there is no value in the Declared PPM or Declared Mass at the substance group level, it looks for substance mass and conversion factor for all the substances in the substance group (the system does not calculate the compliance for substances within substance group, even if user provided Declared Compliance attribute value, it is ignored), then it calculates the base substance mass for each of the substances (substance mass multiplied by conversion factor), and it updates the calculated mass at the substance group level. If user provided the mass for immediate parent of substance group (it could be part or part group, subpart or material), the system calculates the PPM, compares it with threshold PPM for the substance group (it reads the threshold PPM from spec), and sets the appropriate value in the Calculated Compliance attribute.

**Rollup Logic for Materials**

If there is a value in the Declared Compliance attribute at the material level, the rollup uses this value. If there is no value in the Declared Compliance attribute, it looks at the children of the BOS tree under the material (it ignores the value in the declared PPM at the material level). If the BOS tree contains a substance group or substances, it uses the logic above to calculate the compliance. If there are multiple substance groups, the material is compliant, providing all the substance groups are compliant. If any one of the substance groups is missing info or not compliant, it affects the Calculated Compliance of the material.

**Rollup Logic for Subparts**

If there is a value in the Declared Compliance attribute at the subpart level, the rollup uses this value. If there is no value in the Declared Compliance attribute, it looks at the children of the BOS tree of the subpart (it ignores the value in the declared PPM at the subpart level). If the BOS tree contains materials, substance groups or substances, it uses the logic above to calculate the compliance. If there are multiple materials, the subpart is compliant, providing all the materials are compliant. If any one of the materials is missing info or not compliant, it affects the Calculated Compliance at the subpart level.

**Rollup Logic for Parts and Part Groups**

If there is a Declared Compliance, the rollup uses this value. If there is no value in the Declared Compliance attribute, it looks at the BOS tree for that part. If the BOS tree contains subparts, materials, substance groups and substances, it uses the logic above to calculate the compliance. If there are multiple subparts, the part is compliant, providing all the subparts are compliant. If any one of the subparts is missing info or not compliant, it affects the Calculated Compliance at the part level.

**Special Cases that can Result in Missing Info Compliance State**

Let there be five substances in a substance group; two of them do not have a conversion factor. The system calculates the substance group mass based on the other three substances, calculates the PPM, and compares it with the threshold PPM from the specification. [Yao (3/07): This is only true if the substance has mass, but no conversion factor. If the substance doesn't have mass, the system just ignore it.] If it is not compliant, it sets the Calculated Compliance to Not Compliant. If it is compliant, then it sets the Calculated Compliance to Missing Info, because the other two substances don't have a conversion factor.

Here are some other potential use cases where Missing Info can be returned as Calculated Compliance.
The parent mass is not provided to calculate Calculated PPM, so the rollup has nothing to compare with Threshold PPM from the specification, so it results in Missing Info.

If some of the mandatory substances from the specification are missing in the declaration, even if all the existing substances are compliant, the parent – either material or subpart or part – is marked as Missing Info.

As of Rel. 9.2.2, this depends on the Mass Disclosure Type. The initial statement is true for Undisclosed compositions. For Partially Disclosed compositions, the system attempts to access compliance of missing substances against the “Unreported (System)” substance added by the system. For Fully Disclosed compositions, the missing substances are automatically Compliant.

If the Conversion Factor for a substance under a substance group is missing, but the substance has value in the Mass field, the system flags Missing Info at the substance group level.

In 9.2.2, if the same substance exists in the substance group during import, the system attempts to copy over the Conversion Factor from the substance group.

If the specification does not have any substances (or only “optional” substances), Calculated Compliance is Missing Info.

**Additional Information**

Declared PPM values at the material level and subpart level are not considered by the rollup.

The Calculated PPM is set at the leaf substance and substance group level only (the Calculated PPM for substances within substance group are not calculated).

Declared Compliance values for substances within substance group are not considered by the rollup.

The Calculated Compliance and Result Compliance for substances within substance group and for all Optional substances (either Reporting set to Optional in the spec or substances do not even exist in the spec) are not calculated. In 9.2.2, the system calculates compliance for Optional substances as well, but these results are ignored when calculating the compliance of the parent of substances.

In cases where the system uses the value in Declared Compliance field, it still updates the Calculated Compliance, but the Result Compliance is set to the value in Declared Compliance field.

In cases where the system uses declared PPM, it still calculates the calculated PPM if all the values (mass and parent mass) are available.

**Corner Case**

If the user provided declared PPM for substances within a substance group, the system calculates the substance mass based on the PPM and mass of the parent of the substance group (material, subpart or part), then it uses the same logic for substance group to calculate the compliance. If the parent mass is missing, then it uses the declared mass (if its available) to calculate the mass at substance group level.
Internal Logic of BOM/Compliance Rollups

Be sure you have read Bill Of Materials (Compliance) Rollup (on page 89); the information below is supplemental to that section.

Compliance Calculation

Compliance Validation is a very taxing operation within Agile PLM. It is currently impossible for the system to catch up in a split second (like Excel) with all changes a user makes in the system that might impact compliance, although this is clearly the goal. The problem is clearly exponential. A compliance change to a manufacturer part will impact all items that have this manufacturer part in their AML. This in turn will impact all top level assemblies and all intermediary assembly levels that have that item in their BOM. In the worst of cases, a small change may require the calculation of the whole system.

Excel has the same problem when spreadsheets get too big. Therefore Excel has introduced the ability to turn automatic calculation off and to use a manual calculation.

PG&C has the same type of a user launched manual calculation option. On top of that PG&C has a timer-based automatic calculation that recalculates the compliance state of everything in the system based on some rules.

Automatic Calculation

The system performs a compliance rollup automatically in these cases:

- Per the schedule set by the administrator using Compliance Rollup rules;
- For all items flagged as Shippable Items, all Latest released revs and Pending revs (previously released revs of shippable items are not rolled up again);
- Every part which has Need Compliance Check to Yes for at least one spec.

Manual Calculation

Manual calculations always run in the foreground. The calculation happens for the currently selected rev of the item. The User can use the manual calculation to recalculate a back rev if needed.

Calculation and Publishing of Compositions

Compliance calculation does not happen automatically for an item or manufacturer part upon publishing data from a declaration to the part. When a composition is published, all the specifications for that part are flagged with Need Compliance Check, because the new composition could be Fully Disclosed and it may influence the compliance of existing specs that don't have matching spec compositions; it is set on the corresponding part’s Compliance tab > Specifications table (again, it is not visible on items, but it is present and the system responds to it). Its compliance is evaluated either when the user launches the calculation or the next time the automatic compliance validation runs.

When there are changes in an assembly (that is, an ECO changes a BOM or an MCO changes a
manufacturer part), there is no trigger to recalculate the compliance. If the item is marked as Shippable Item, the scheduled rollup recalculates the compliance; otherwise, you have to manually run the rollup to calculate compliance.

When importing specifications directly into an item or manufacturer part, after the Import procedure is completed, the system does a composition rollup and updates the Calculated Compliance and Result Compliance on the Composition table; however, it does not recalculate the compliance of all the specifications in the item or manufacturer part. It adds the specifications from the compositions being imported to the item or manufacturer part’s Specifications table and sets the Need Compliance Check to Yes.

Note that if the composition being imported does not have a specification, the system does not do a composition rollup after the import. However, as of 9.2.2, it still calculates the PPM for substances and substance groups in the composition, identifies the Mass Disclosure type, and sets Need Compliance Check on all existing specs to Yes.

Internal Logic of Substances and Weights Rollups

Be sure you have read Substances and Weights Rollups using Excel Integration (on page 93); the information below is supplemental to that section.

These calculations describe how to roll up information from the lowest level of substances to the highest top-level assembly (TLA). The following levels can be identified within this “extended BOM,” that is, a BOM of parts combined with its constituent Bill of Substances (BOS). All the parts come first – the TLA, subassemblies, internal parts, and manufacturer parts. Then comes the composition for any given part – again, this is not an Agile object but an idea combining the part, a specification, and an information provider. Finally, the composition is the top level of the BOS, which comprises any subparts, homogeneous materials, substance groups, and base substances.

Not all extended BOMs have all the different levels. Of course the structure will further have one or more instances at every level within as dictated by the BOM structure and the numbers of part manufacturers for each manufactured part in the BOM.

Hierarchy of BOM and BOS

Top-level assembly (top level of the BOM) >
    Subassembly>
    Part>
    Manufacturer part>
    Active Composition (top level of the BOS: part + spec + supplier-specific)>
    Subpart>
    Material>
    Substance Group>
    Substance

Aggregate Rule

The “Aggregate” rule refers to the distinction between “aggregated substances” and “directly
assigned substances.” Aggregated substances are substances that are implicitly assigned to a level through the rollups. If the substance is directly assigned at the level under observation, it is a directly assigned substance. But if a substance is assigned lower in the hierarchy – and through the rollups it becomes part of this particular level – then this substance is an aggregated substance.

In addition to the basic structure of an extended BOM, different types of rollups can be performed that make use of multiple manufacturers of the manufactured parts when calculations are made. The Pessimistic Worst Case (PWC) is the absolute worst of the worst that could ever be found in a BOM in terms of hazardous material content. In this scenario the BOM/BOS tree is the amalgamation of compositions of all available suppliers of each part in the BOM.

For example, if Mfr part A is available from three sources, the PWC of the BOM/BOS tree includes the amount of lead from the composition with the most lead of the three. As you can see, no such actual assembly is ever built. However, if the PWC case is compliant versus the threshold values that will be set by a given specification, then any configuration of the BOM in terms of the AML will be compliant. The pessimistic worst case trades realism for ease of use. It requires no user determination in terms of AML management to identify the worst mfr. part in an AML and to calculate this case.

Substance to Substance Group-level Rollup

For each substance in the group, there is a conversion factor that converts (by weight) the weight of the substance to a weight of the base substance (see column Conversion Factor to metal mass). In the end, the base substance gets the sum of all the converted weights assigned as its weight. The base substance is the same as the aggregated substance.

The system does not allow you to add two substance groups with the same base substance to the same specification.

When the system performs rollup from substance to substance group level, it calculates the weight of the base substance by examining all substances that belong to the substance group, taking the weight of each substance multiplied by its conversion factor, adding all substances together, and assigning it at the substance group level.

If a substance group has declared weight, that has precedence over the weight of the substances under that substance group. Excel Rollup takes the weight of the substance group.

Example:

Lead and lead compound:Declared weight: 1 g
   –Lead      Declared weight: 1 g Conversion factor = 1
   –Lead Oxide Declared weight: 2 g Conversion factor = 0.866

- Substance group’s calculated weight = (1 x 1) + (2 x 0.866) = 1 + 1.732 = 2.732 g
- If substance group has declared weight, then its calculated weight is its declared weight = 1 g

Substance Group to Composition

When rolling up from substance group to composition, first the system does the rollup from substance to substance group. If there are multiple substance group and/or substances in a composition, it adds up all the substances weight and substance group weight and assign the sum
to the calculated weight of the composition.

If a composition has declared weight, that has precedence over the summed weight of the substances and substance group. Excel Rollup takes the declared weight of the composition.

*Example:*

Composition Declared weight: 5 g

–Al Declared weight: 3 g Conversion factor = 1

–Lead and lead compound:
  –Lead Declared weight: 1 g Conversion factor = 1
  –Lead Oxide Declared weight: 2 g Conversion factor = 0.866

–Cadmium and cadmium compound: Declared weight: 2 g
  –Cadmium Declared weight: 1 g Conversion factor = 1

- Composition’s calculated weight = \(3 \times 1 + (1 \times 1) + (2 \times 0.866) + 2\) = 7.732 g
- If the composition has declared weight, then its calculated weight is its declared weight = 5 g

**Substance Group/Substance to Material-level Rollup**

1. The system first creates a unique list of substances across the aggregated and directly assigned substances. In case the same substance appears both as a directly assigned as well as an aggregated substance, the system adds up the weights of both of those instances into one aggregated substance.

2. The system adds up all the weights of all the substances and assign this weight as the calculated weight of the material.

3. The system calculates the PPMs for each of the substances and populate the aggregated substances’ calculated PPMs field with these values.

Note that the material might have a user-entered weight as well. In cases where the user makes such manual entries, the system uses the entered weight of the material instead of the calculated weight of the material. Also, declared weights take precedence over calculated weights.

**Material to Subpart-level Rollup**

The system first creates a unique list of substances and materials across the aggregated and directly assigned substances and materials. In case the same substance/material appears both as a directly assigned as well as an aggregated substance/material, the system adds up the weights of both of those instances into one aggregated substance/material.
1. The system adds up all the weights of all the substances/materials and assign this weight as the calculated weight of the subpart.

2. The system calculates the PPMs for each of the substances/materials and populate the aggregated substances/materials’ calculated PPMs field with these values. Note that the subpart might have a user-entered weight as well. In cases where the user makes such manual entries, the system uses the entered weight of the subpart instead of the calculated weight of the subpart. Also, declared weights take precedence over calculated weights.

Subpart to Composition-level Rollup

The system first creates a unique list of substances and materials across the aggregated and directly assigned substances and materials. In case the same substance/material appears both as a directly assigned as well as an aggregated substance/material, the system adds up the weights of both of those instances into one aggregated substance/material.

1. The system adds up all the weights of all the substances/materials and assign this weight as the calculated weight of the composition.

2. The system calculates the PPMs for each of the substances/materials and populate the aggregated substances/materials’ calculated PPMs field with these values.

Note that the composition might have a user-entered weight as well. In cases where the user makes such manual entries, the system uses the entered weight of the composition instead of the calculated weight of the composition. Also, declared weights take precedence over calculated weights.

Composition to Part-level Rollup

In the Pessimistic Worst Case rollup:

1. The system creates a unique list of substances and aggregated substances for each of the compositions within the mfr. part/part by adding up the weights of like substances. For example, a composition can have lead directly assigned to it but lead could also be coming from lower levels of the BOS as an aggregated substance. In this case, the weight of lead is added to lead as an aggregated substance to have only one entry for lead.

2. The system makes a unique list of all the substances across all the compositions of the mfr. part, both the ones that are directly added as well as the aggregated substances that are the result from lower-level rollups assigned to the part and assign the highest weight of the substances found across the compositions to that substance.

The system assigns the lowest weight of all the compositions in the AML to the calculated weight of the mfr. part/part.

Composition to Manufacturer Part

When rolling up from composition to manufacturer part, follow the PWC rule. If a mfr. part has multiple compositions, get the lowest “composition weight” from among all the compositions and assign it to the mfr. part’s weight. Then, get a consolidated list of all substances from all compositions, and get the highest substance weight for each kind of substance at mfr. part level.

If a mfr. part has declared weight, that has precedence over the weight of the compositions under that mfr. part. Excel Rollup takes the declared weight of the mfr. part.
Example:

Manufacturer part Declared weight: 4 g

- Composition_1: Calculated weight = (3 x 1) + (1 x 1) + (2 x 0.866) = 5.732 g
  - Al Declared weight: 3 g Conversion factor = 1
  - Lead and lead compound:
    - Lead Declared weight: 1 g Conversion factor = 1
    - Lead Oxide Declared weight: 2 g Conversion factor = 0.866

- Composition_2: Calculated weight = (4 x 1) + 2 = 6 g
  - Al Declared weight: 4 g Conversion factor = 1

- Cadmium and cadmium compound: Declared weight: 2 g
  - Cadmium Declared weight: 1 g Conversion factor = 1

- Manufacturer part’s calculated weight = 5.732 g, which is the lowest
- If manufacturer part has declared weight, then its calculated weight is its declared weight = 4 g

Manufacturer Part to Part-level Rollup

To go from the manufacturer part to the part level, the following logic applies:

In the Pessimistic Worst Case rollup:

1. The system creates a unique list of substances and aggregated substances for each of the manufacturer parts within the AML by adding up the weights of like substances. For example, a mfr. part can have lead directly assigned to it but lead could also be coming from lower levels of the BOS as an aggregated substance. In this case the weight of lead is added to lead as an aggregated substance to have only one entry for lead.

2. The system makes a unique list of all the substances across all the manufacturer parts of the AML, both the ones that are directly added as well as the aggregated substances that are the result from lower-level rollups assigned to the part and assign the highest weight of the substances found in the entire AML to that substance.

3. The system assigns the lowest weight of all the mfr. parts in the AML to the calculated weight of the part.

4. The system recalculates the weights of the substances in order to get the PPM values in sync with the assigned weight of the part.

When rolling up from manufacturer part to part, follow the PWC rule. If an item has multiple mfr. parts, get the lowest mfr. part weight from all the mfr. parts and assign it as the part weight. Then, get the consolidated list of all substances from all mfr. parts, and get the highest substance weight
for each kind of substance at part level.

If part has declared weight, that is only for reference. Excel Rollup takes the calculated weight of the part.

Example:

Part  Declared weight: 1 g

–Manufacturer part_1 Calculated weight = 2.732 g
  –Composition Calculated weight = (1 x 1) + (2 x 0.866) = 2.732 g
    –Lead and lead compound
      –Lead Declared weight: 1 g  Conversion factor = 1
      –Lead Oxide Declared weight: 2 g  Conversion factor = 0.866

–Manufacturer part_2 Calculated weight = 2.866 g
  –Composition Calculated weight = (2 x 1) + (1 x 0.866) = 2.866 g
    –Lead and lead compound
      –Lead Declared weight: 2 g  Conversion factor = 1
      –Lead Oxide Declared weight: 1 g  Conversion factor = 0.866

- Part’s calculated weight = 2.732 g, which is the lowest
- Lead and lead compound’s calculated weight = 2.866 g, which is the highest

More on How Mfr Part to Part Works

If part has its direct composition and composition from manufacturer parts, treat the direct composition as manufacturer part, and apply PWC rule.

Example:

Part

–Composition Calculated weight = (1 x 1) + (1 x 0.866) = 1.866 g
  –Lead and lead compound
    –Lead Declared weight: 1 g  Conversion factor = 1
    –Lead Oxide Declared weight: 1 g  Conversion factor = 0.866
Chapter 13

–Manufacturer part_1 Calculated weight = 2.732 g
  –Composition Calculated weight = (1 x 1) + (2 x 0.866) = 2.732 g
  –Lead and lead compound
    –Lead Declared weight: 1 g Conversion factor = 1
    –Lead Oxide Declared weight: 2 g Conversion factor = 0.866

–Manufacturer part_2 Calculated weight = 2.866 g
  –Composition Calculated weight = (2 x 1) + (1 x 0.866) = 2.866 g
  –Lead and lead compound
    –Lead Declared weight: 2 g Conversion factor = 1
    –Lead Oxide Declared weight: 1 g Conversion factor = 0.866

  Part’s calculated weight = 1.866 g, which is the lowest
  Lead and lead compound’s calculated weight = 2.866 g, which is the highest

Part to Assembly

When rolling up from part to assembly, follow the Aggregate rule. If an assembly has multiple items, sum the weights of all items and assign it to the assembly weight. Likewise, get the consolidated list of all substances from all the items and get their total weight.

If assembly has declared weight, that is only for reference. Excel Rollup takes the calculated weight of assembly.

Example:

Assembly Declared weight: 1 g
  –Part_1 Calculated weight = 2.732 g
    –Composition Calculated weight = (1 x 1) + (2 x 0.866) = 2.732 g
    –Lead and lead compound
      –Lead Declared weight: 1 g Conversion factor = 1
      –Lead Oxide Declared weight: 2 g Conversion factor = 0.866

  –Part_2 Calculated weight = 2.866 g
    –Composition Calculated weight = (2 x 1) + (1 x 0.866) = 2.866 g
    –Lead and lead compound
–Lead Declared weight: 2 g   Conversion factor = 1
–Lead Oxide Declared weight: 1 g   Conversion factor = 0.866

○ Assembly’s calculated weight = $2.732 + 2.866 = 5.598$ g
○ Lead and lead compound’s calculated weight = $2.732 + 2.866 = 5.598$ g

More on How Part to Assembly Works

If an assembly has direct compositions and compositions from BOM, follow the aggregated rule.

Example:

Assembly

–Composition   Calculated weight = 1.866 g
  –Lead and lead compound
    –Lead   Declared weight: 1 g   Conversion factor = 1
    –Lead Oxide Declared weight: 1 g   Conversion factor = 0.866

–Part_1   Calculated weight = 2.732 g
  –Composition   Calculated weight = 2.732 g
    –Lead and lead compound
      –Lead   Declared weight: 1 g   Conversion factor = 1
      –Lead Oxide Declared weight: 2 g   Conversion factor = 0.866

–Part_2   Calculated weight = 2.866 g
  –Composition   Calculated weight = 2.866 g
    –Lead and lead compound
      –Lead   Declared weight: 2 g   Conversion factor = 1
      –Lead Oxide Declared weight: 1 g   Conversion factor = 0.866

○ Assembly’s calculated weight = $1.866 + 2.732 + 2.866 = 7.464$ g
○ Lead and lead compound’s calculated weight = $1.866 + 2.732 + 2.866 = 7.464$ g
Another Example of How Part to Assembly Works

If an assembly has direct compositions, compositions from MPN and also compositions from BOM, follow PWC rule between direct-compositions and MPN-compositions. Between the result and the BOM-compositions, follow the aggregated rule.

In the following example, first the Composition and Mfr Part data is assessed; then this is combined with the two parts’ composition data.

Example:

**Assembly**
- Composition Calculated weight = 1.866 g
  - Lead and lead compound
    - Lead Declared weight: 1 g  Conversion factor = 1
    - Lead Oxide Declared weight: 1 g  Conversion factor = 0.866

- Manufacturer part
  - Composition Calculated weight = 1.5 g
    - Lead and lead compound Declared weight: 1.5 g
      - Lead Declared weight: 1 g  Conversion factor = 1
      - Lead Oxide Declared weight: 1 g  Conversion factor = 0.866

- Part_1
  - Composition Calculated weight = 2.732 g
    - Lead and lead compound
      - Lead Declared weight: 1 g  Conversion factor = 1
      - Lead Oxide Declared weight: 2 g  Conversion factor = 0.866

- Part_2
  - Composition Calculated weight = 2.866 g
    - Lead and lead compound
      - Lead Declared weight: 2 g  Conversion factor = 1
      - Lead Oxide Declared weight: 1 g  Conversion factor = 0.866
First, get the ‘middle’ data from “Manufacturer Part” and “Composition”:
- Mfr. Part Composition weight: 1.5
- Lead and lead compound wt: 1.866

Then, separately add this ‘middle’ data to the composition data for Part 1 and Part 2:
- Assembly’s calculated weight = 1.5 + 2.732 + 2.866 = 7.098 g
- Lead and lead compound’s calculated weight = 1.866 + 2.732 + 2.866 = 7.464 g

Notes

*Multiple composition*

If there are multiple compositions for a part for the same Spec, the server returns all *active* compositions for the part, and the rollup-logic follows the PWC rule among those active compositions.

*Level, Type, Declared PPM, Declared weight, CAS Number*

They are populated from “Data” sheet to “Substance And Weight Rollup” sheet after running scenario. In Rel. 9.2.1.3, it has value after running the scenario, but the value may not be correct.

Rollup Rules

When there is at least one substance OR substance group, that has PPM above the threshold, we have to select the “This part does contain substances listed in the referenced specification above reporting limits as detailed below,” because the moment one substance or substance group is not compliant, the whole part is not compliant. That’s not true the other way, that is, only if all the substances are compliant, the part becomes compliant.

For the UOM, when open the rollup Excel, the mass value is exported and auto converted, using the standard UOM.

If Quantity value is Null or non-numeric in Excel, when do rollup system returns proper message. There is no cell highlighting and Quantity can have a non-numeric (string) value.